D

’ [/
D!

Epi Info™
Community Health Assessment Tutorial

DOCUMENT VERSION 2.0, PUBLISHED OCTOBER 2005

", Department of Healtiv and Human Services

Q&‘;SERV
5 C Centers for Dusease Control and Prevention
S National Center for Public Healtiv Informatics



This page intentionally blank.




Acknowledgements

The Epi Info™ Community Health Assessment Tutorial was produced by the collaborative efforts
of the Centers for Disease Control and Prevention (CDC), the Assessment Initiative (Al), and the
New York State Department of Health (NYSDOH).

The CDC is one of the thirteen major operating components of the U.S. Department of Health and
Human Services. It is at the forefront of public health efforts to prevent and control infectious and
chronic diseases, injuries, workplace hazards, disabilities, and environmental health threats. Today,
CDC is globally recognized for conducting research and investigations, and for its action-oriented
approaches to issues of public health. CDC uses its research and findings to improve people’s daily
lives, and respond to local, national, and international health emergencies.

The Assessment Initiative (AI) comprises a cooperative program between CDC and state health
departments that supports the development of innovative systems and methods to improve the way
data is used to provide information for public health decisions and policy. Through the Al, funded
states work together with local health jurisdictions and communities to improve access to data,
improve skills to accurately interpret and understand data, and use of the data so that assessment
findings ultimately drive public health program and policy decisions.

New York State’s Al has been awarded a new five-year cooperative agreement by the CDC to
strengthen assessment capacity and practice. This is the third round of Al funding offered through
the CDC, and it is the second time that the NYSDOH has been successful in getting the award.

This tutorial for using the Epi Info software program has been created by the CDC Epi Info™
development team at the request of the NYSDOH Assessment Initiative, and has been designed
using asthma data provided to the CDC by the NYSDOH.

Copyright Information
Epi Info is a trademark of CDC. Epi Info™ programs are provided in the public domain to promote

public health. Programs may be freely translated, copied, or distributed. No warranty is made or
implied for use of the software for any particular purpose.




Centers for Disease Control and Prevention (CDC)

Director, Julie L. Gerberding, MD, MPH

Chief Science Officer, Dixie E. Snider, MD, MPH

Associate Director for Science, Tanya Popovic, MD, PhD

Coordinating Center for Health Information and Service (CoCHIS)
(Acting) Directors, Blake Caldwell, MD, MPH and Edward J. Sondik, PhD
National Center for Public Health Informatics (NCPHI)

(Acting) Director, John Loonsk, MD

Division of Public Health Surveillance and Informatics (DPHSI)
(Acting) Director, Ruth Jajosky, DMD, MPH

(Former Acting) Director, Pat Schumacher, MS, RD

(Acting) Information Technology Branch (ITB) Chief, Robert Fagan

Epi Info™ Development Team:

Instructional Design: Shannon Rowlett Jones

Epi Info™ Technical Advisors: Karen DeRosa, Roger Friedman, Andre Swoope
I'TB Adyisors: David Nitschke, Carol Worsham, Marilyn Reynolds

AI Adpisors: Alex Chatleston, Nelson Adekoya

CDC Editor: W. Scott Janes

New York State Department of Health (NYSDOH), Public Health Information Group
AI Adyisor: Priti Irani, MS, Project Director, Assessment Initiative

Technical Review Board: Cate Bohn, MPH, Community Health Information Specialist; Aaron Mair,
MPA, Public Research Specialist I1I; Mike Medvesky, MPH, Director; Trang Neguyen, MD, MPH,
New York State Asthma Epidemiologist; Cheryl Ellemberg, MPH, former Research Specialist I1I

NYSDOH, Bureau of Communicable Diseases

Technical Review Board: Hwa-Gan Chang, PhD, Director Statistical Unit




NYSDOH, Information Systems and Health Statistics Group
Technical Review Board: Linh Le, MD, PhD, Research Scientist IV
University at Albany School of Public Health

Technical Review Board: Mike Zdeb, Assistant Professor

County Workgroup

Content Review Board: E. Oscar Alleyne, MPH, Epidemiologist; Cristina Dyer-Drobnack, MS, Project
Coordinator, NYSACHO; Jan Herrick Director, Environmental Health, Schoharie County
Department of Health; Stephen A. Jennings, Public Health Planner, Jefferson County Public Health
Service; Patricia Many, BS, RN, Public Health Nurse, Oneida County Health Department; Joanne
Ryan, RN, Communicable Disease Nurse, Putnam County Department of Health; Ted Schiele, MS
Planner/Evaluator, Tompkins County Health Department; Christopher M. Szwagiel, MS, MPH,
DrPH, Director Genesee County Department of Health; Karen Tuchman, RN, MPH, Public
Health Nurse, Putnam County Department of Health




This page intentionally blank.




Contents

ACKNOWLEDGEMENTS I

CONTENTS \

INTRODUCTION TO THE TUTORIAL.......... 1

HOW TO USE THIS TUTORIAL ... 1
EPIINFO™ RESOURCES 2
FILE SET-UP vttt 3
FILE DOWNLOAD LIST 4
TUTORIAL PROCESS FLOW ... 5
INTRODUCTION TO THE SCENARIO........6
TO DO LIST FOR LESSONS 1-10......c.c. 7
MAKE VIEW: CREATE A SURVEY........c... 9

GETTING STARTED WITH MAKE VIEW ..11

THE MAKE VIEW WORKSPACE ................. 12
NAVIGATING MAKE VIEW ... 12
CREATE A PROJECT ... 14
THE FIELD DEFINITION BOX.......ccooevunevunees 15
FIELD OR VARIABLE TYPES......ccccconevnenneee 16
CREATE FIELDS PART L...coviirererrerncnnne 19
CREATE A LABEL/TITLE FIELD...........cc....... 19
CREATE A LEGAL VALUE FIELD................ 22
CREATE A DATE FIELD 23
CREATE A NUMERIC FIELD......ccccovvurernnne 23
SET THE TAB ORDER......cocvirtrcreirercnnne 25
NAME THE PAGE 26
CREATE A CODE TABLE ....oooverireireicnnne 27
FORMATTING OPTIONS......ccocverereranen 29
CHANGING THE BACKGROUND COLOR
29
CHANGING THE GRID SETTINGS............. 30
RESIZING FIELDS .....covvuevieereeceecerenereneenns 31
ALIGNING FIELDS 31
COPYING AND PASTING FIELDS.............. 32
CREATE FIELDS PART 2...covrerncrrcrncnnne 33
ADD A NEW PAGE ......coovtirineecineirecins 33
CREATE A CHECKBOX .....ccovveeerernerrrerrennne 33

CREATE A GROUP...ERROR! BOOKMARK
NOT DEFINED.

CREATE A MIRROR FIELD.........ccccoueumriuunee 36
CREATE A YES/NO FIELD ... 37
MAKE VIEW: CHECK CODE.........cccoecoomevuene. 45

GETTING STARTED WITH CHECK CODE47
THE PROGRAM EDITOR WORKSPACE .. 48
NAVIGATING THE PROGRAM EDITOR.. 50

CREATE A SKIP PATTERN......ccovvueerrcrnnnn. 54
USE THE ASSIGN COMMAND................... 57
USE THE DIALOG COMMAND...........c.... 59
ENTER DATA .. oerereererrerrenereneeeeenenenes 63
GETTING STARTED WITH ENTER............. 65
THE ENTER DATA WORKSPACE............... 66
NAVIGATING ENTER DATA.....ccoconvrern 67
ENTER DATA INTO YOUR VIEW............... 68

GETTING STARTED WITH ANALYSIS..... 79

THE ANALYSIS WORKSPACE........cconecunee. 80
READING IN A PROJECT ....covverrreeererennn 81
READ/IMPORT AN EPI INFO™ PROJECTS3
NAVIGATING ANALYSIS.....covenreireinenns 84
COMMANDS IN THIS LESSON.................. 85
USE THE LIST COMMAND.......cocovvurirnnnn. 86
CREATE A WEB FORMAT LIST......ccccconeeene. 87
USE THE SORT COMMAND........ccccovurnennn. 88
CREATE A LIST OF SORTED VARIABLES 89
USE THE SELECT COMMAND..........ccceeceuu. 90
LIST THE SELECTED RECORDS.................. 91
SELECT BASED ON AGE.......ovicrcnnn. 92

ANALYSIS: CREATING STATISTICS.......... 97




EP]I INFO™ TUTORIAL

TEAR OUT Q/A SHEET ...cooviciieiici 99
COMMANDS IN THIS LESSON............... 101
DISPLAY FILES 103
SET OPTIONS 104
MERGE FILES 106
CREATE A FREQUENCY ... 110
STRATIFY A FREQUENCY ......ccomvvrmevrnennes 113
SELECT VARIABLES FOR A FREQUENCY
114

CREATE A MEANS
USE THE MEANS COMMAND WITH A

116

CROSS-TABULATED VARIABLE............... 118
CREATE A STRATIFIED MEANS............... 119
USE SELECT WITH THE MEANS
COMMAND ...ttt 120
CREATE A TABLE 121
CREATE A 2X2 TABLE ... 124
SAVING A PROGRAM....covvuirirnirrcrnennne 127
TEST THE SAVED PROGRAM.........cccceuue. 128
ANALYSIS: EPT GRAPH .....coevieveciecinnes 130
GRAPH TYPES 132
CREATE A BAR GRAPH......covvirircicnnn. 134
CREATE AND CUSTOMIZE A PIE GRAPH
136
EXPORT A GRAPH. ..o 138
CREATE A ROTATED BAR GRAPH.......... 139
PLOT A NEW GRAPH TYPE.......ccooconuuunece. 141
CREATE A STACKED BAR .......cverircnnn. 143
ANALYSIS: EXPORTING FILES................. 148
MANAGING DATA...ccreereerecirenirenirenns 150
COMMANDS IN THIS LESSON................ 151
OUTPUT FILES ..o 153
VIEW OUTPUT FILES 154
USE THE HEADER COMMAND................ 155
USE THE PRINTOUT COMMAND .......... 156
ROUTEOUT DATA TO A NEW FILE........ 158
DEFINE AND RECODE........cccovvemerreererenecn 159
CREATING AND WRITING NEW DATA
TABLES ...oieestecieceecieceeeieeieeies 166
WRITE AND APPEND TABLES ................. 170

WRITE A FILE TO EXCEL .....ovcvveieres 176

ANALYSIS: DATA MANAGEMENT FOR

MAPS .ot sienen 181
GETTING STARTED WITH EPI MAP......183
COMMANDS IN THIS LESSON............... 185
AGGREGATE DATA IN ANALYSIS .......... 186
CREATE A CHOROPLETH MAP FROM
ANALYSIS....ooorecnececiecireciecinecineeiens 188
AGGREGATE DATA FOR A CASE BASED
MAP et sesaenanes 192
EPT MAP ....oeeseneeeeieeeriseaenaeeanes 195
USING EPI MAP ... 198
THE EPI MAP WORKSPACE.........ccconucunee. 199
NAVIGATING EPI MAP ... 201
MAPS TYPES ... 202
CREATE A CHOROPLETH MAP............... 203
CHANGING MAP PROPERTIES............... 208
VIEWING MAP INFORMATION............... 210
MAP TIPS ..ooreeereereerererreneseeeeneenes 210
INFORMATION ICON.....oocmeuriecrrecirecins 210
FIND ICON ....oorvierrerrcriererrenienienenenns 211
SAVING A .MAP FILE ..o 213
CREATE A CASE-BASED MAP. ................. 214
ADD TEXT TO A MAP......rrevrerenns 218
CREATE A POINT MAP ..o 221
EDIT SHAPEFILE POINTS......ccovevrerrernes 226

APPLY STANDARD LABELS TO A MAP 228
APPLY ADVANCED LABELS TO A MAP230

ADD A SHAPE LAYER ... 233
SAVE A MAP AS A BITMAP FILE ............ 234
EPI REPORT .....coevrierierierierierienienienenenes 239

GETTING STARTED WITH EPI REPORT 241

THE EPI REPORT WORKSPACE............... 242
NAVIGATING EPI REPORT......ccccovevureuenecn 243
REPORT DATA.....ierererrerirerirerrererenenenes 245
INSERT A LABEL ....covevvevevecreciecirecines 246
INSERT A LINE ..., 248

vi



INSERT A VARIABLE 250

USING ANALYSIS DATA.....covevmevrrevrnennnn 251
EDITING REPORT ELEMENTS................... 254
CHANGE TABLE FONTS. .....ovvverrecriecrnnee 257
RESIZE TABLES 258
INSERT A NEW PAGE 260
INSERT A TABLE SHELL.......ocoveiean. 261
INSERT AGGREGATE DATA ..o 262
CREATE A LINE LISTING GROUP........... 270
INSERT AN IMAGE 275
INTERMEDIATE ANALYSIS ... 281
SCENARIO 284
TO DO LIST FOR INTERMEDIATE

ANALYSIS LESSON 285
TEAR OUT ANSWER SHEET..........cccocuuuucee 287
ADVANCED STATISTICS ... 290
RELATE COMMAND 291
WHAT IS BRFSS?...eiccserisccies 292
HOW TO GET BRFSS DATA ... 292

READ/IMPORT THE BRFSS DATA........... 293
CREATE AN IF/THEN STATEMENT......... 296
COMPLEX SAMPLE FREQUENCY............ 299

SELECTING SUBGROUPS.........cocenevreranee. 304
COMPLEX SAMPLE TABLES........ccccoucvune.. 306
CREATE A FREQUENCY ... 312
SAMPLING SCHEME 313
IMPORT CENSUS DATA/HTML FORMAT
315

FORMATTING WITH LIST UPDATE......... 317
SELECTING WITH STRING LENGTH.......321
DEFINE AND ASSIGN NEW VARIABLES

............. 322
CREATE A NUMERATOR TABLE.............. 325
CREATE A RELATE ...voiiececiecieciecinenes 328
CREATE A WEIGHT VARIABLE.................. 333
CREATE A PSU VARIABLE..........cccoeconevunee. 335
COMPUTE THE COUNTY CHILD
PREVALENCE 339

MORTALITY RATES....coviierrerecrecrecnnne 344
10 YEAR TRENDS- HOSPITAL DISCHARGE
DATA ettt 349
3 YEAR RATES- HOSPITAL DISCHARGE
DATA e 352
MAPPING RATES.....coviieerrcreerecrecnnne 356
INCOME AND ZIP CODE SCATTER PLOT
............................................................................ 360
RISK RATIO .....ovverrmericrierieerisecrisecseneeens 362
USE THE DIALOG COMMAND................ 371

STATCALC- ESTIMATE SAMPLE SIZE...374

APPENDIX A- CODE SHEET........ccccccne. 379

APPENDIX B- PARENT SCHOOL ASTHMA
PRE-INTERVENTION SURVEY................ 383

APPENDIX C- DATA ENTRY SURVEYS .385

APPENDIX D SKILLS REVIEWS ANSWER

APPENDIX E- LESSON 5 ANSWER KEY 395

APPENDIX F- INTERMEDIATE ANALYSIS
ANSWER KEY ..o 397

APPENDIX G- PREPARING DATA FOR USE

IN THE EPIINFO™ TUTORIAL .......cccnc... 401
APPENDIX H- GLOSSARY ......cocovirirnennne 407
APPENDIX I- DATA SOURCES................ 411
REFERENCES ...t 413

- vii -






Introduction to the Tutonal

Epi Info™ Health Assessment Tutorial

professionals in conducting outbreak investigations, managing databases for public

health surveillance and other tasks, and general database and statistics applications.

With Epi Info™ a user can rapidly develop a questionnaire or form, customize the
data entry process, and enter and analyze data.

E pi Info™ is a series of programs for Microsoft Windows for use by public health

The Epi Info™ program is divided into five core modules: Make View, Enter Data, Analysis,
Epi Map, and Epi Report. Each module has stand-alone capabilities; however, using them for
one project from start to finish adds functionality and efficiency. The Make View module is
the questionnaire or survey designer. You will start your project in Make View, where you will
create a survey and begin setting up your database. Using Enter Data, you will populate your
database with information specific to your survey. The data entered, along with additional
datasets, will be imported into Analysis for detailed study. Data will be plotted in the Epi Map
module. Finally, you will use Epi Report to create a presentation of the findings. This training
does not cover every component of Epi Info™ and is meant for the beginning and
intermediate level user.

How to Use this Tutorial

This tutorial will introduce you to the basic concepts of Epi Info™. Each lesson builds upon
knowledge gained from the previous lesson. It is recommended that you follow the lessons in
the order presented. Finish all the listed steps and practices before progressing to the next
lesson as many of the lessons build upon data gathered from a previous lesson. Data specific
to the course and the scenario will be provided to you as part of the training package. At
various points in the course, you will be asked to access this data to complete the lessons.
Read the Five Goals listed at the start of each lesson to review the core functions you should
understand by the end of each lesson.

Step One

Read the Overview section for each lesson. Each Overview contains a Getting Started
breakdown of the module and information on ways to navigate. The Overview also provides
information on the commands, dialog boxes, or other special features that are unique to each
module as well as information on navigating the module. Epi Info™ uses standard windows
features for navigation such as drop-down boxes and menu navigation, as well as unique
features such as wild card (*) searches. The Overview also provides you with screenshots of
the module and introduces you to the basic concepts used in each lesson.
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Step Two

Complete all the step-by-step instructions to learn the basics. Numbered instructions with
some screenshots are provided for you to learn the core functions of each module.
Numbered lessons and instructions can be followed and applied when using Epi Info™
outside of the classroom.

Step Three

Complete the Practice Lessons and Skills Review Exercises when provided. Practice lessons
build upon skills learned during basic lessons. Practices and reviews are opportunities to try
skills without detailed instruction. Skills Reviews will consist of hands-on activities to further
your understanding or a series of questions meant to reinforce basic knowledge. An
Intermediate Analysis lesson is provided at the end of the course. The Intermediate Analysis
Lesson builds upon the skills from eatlier lessons and includes tasks that are more complex.
Each section in Intermediate Analysis includes real wotld data examples from sources such as
the United States Census Bureau and the Behavioral Risk Factor Surveillance System
(BRESS).

Epi Info™ Resources

Training documentation, technical information, or other resources are available on the Epi
Info™ website at www.cdc.gov/epiinfo.

For questions or problems, contact the Helpline at epiinfo@cdc.gov or call 404.498.6190.

To speak with colleagues around that world about Epi Info™, visit the WebBoard at
http://epiinfo.forum.cde.gov.



http://www.cdc.gov/epiinfo
mailto:epiinfo@cdc.gov
http://epiinfo.forum.cdc.gov/

File Set-Up

You must have the latest version of Epi Info™ installed on your computer. Check the Epi
Info™ website for updates www.cdc.gov/epiinfo.

Once installed, Epi Info™ creates a folder on the C: drive called Epi_Info. Your tutorial
datasets need to be installed inside this folder.

1.

2.

From the desktop, open My Computer.
Open your Local Disk drive, usually named C.
Locate the Epi_Info folder and open it.

If the EIHA Tutorial folder does not already exist, select File>New>Folder from the

navigation menu.

= If you have downloaded the EIHA Tutorial folder to a different location, right click
the folder and copy/paste it to the new location inside the Epi_Info folder on your C:
drive.

Name the folder EIHA Tutorial.

Copy (or download) the tutorial datasets to the EIHA Tutorial folder.



http://www.cdc.gov/epiinfo
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File Download List

You need download the following files to work through all the lessons in the tutorial. Files are
available on the Epi Info™ website on the Tutorials page.

Download List

Tutorial Guide EIHAVer#.DOC (MS Word version)
EIHAVer#.PDF (Adobe Reader version)
You need one of the following: ETHAVer# HTM (HTML Browser vetsion)

Project Files Albany_demogz.MDB

Asthma Survey 2005.MDB
Asthma Final MDB

Asthma Survey 2005 Sample. MDB
HospitalPoints. MDB
SchoolPoints. MDB
SymptomsByAgeSample.mdb

MS Excel Files AsthmaTable. X1.S

HTML Files CensusAge. HTM
Frequencies. HTM
Frequencies. XML

Epi Report Files My Epi Report2. EPT
My Epi Report2. EPX
WMonth Report2. EPT
WMonth Report2. EPX

Graphics WMonthPieGraph2.BMP

Map Files Albany County boundary_region. DBF
Albany County boundary_region.PR]
Albany County boundary_region.SHP
Albany County boundary_region.SHX
ALBZCTA_region.DBF
ALBZCTA_region.PR]
ALBZCTA_region.SHP
ALBZCTA_region.SHX




Tutonial Process Flow

1
Make View
Design survey

Check code

2
Enter Data

Paper surveys
Primary data collection

3

Analysis 4
Read primary data files Epi Map
Geographic
Merge with MS Excel representation of data
datasets
3
Create Statistics
A 4
3 5
Create Graphs and Epi Report
Charts Presentation of data

+




EPI INFO™ TUTORIAL

Introduction to the Scenario

This tutorial is set up to teach Epi Info™ by following a scenario. The tutorial includes a
survey adapted from one used in New York State; however, the survey data used for the
analyses were created for the tutorial. Anonymous data relating to New York State were taken
from different datasets referenced in Appendix I: Data Sources. The survey and datasets
presented here relate to Community Health Assessments, and specifically Asthma; however,
they can be used to teach the Epi Info™ program to any user, and to illustrate how the
program can be used to gather, analyze, and present data.

Scenario

The local health department (LHD) director of County X gets a Request for Proposal (RFP)
from the state health department saying there are funds available for an asthma initiative.
There is a good chance of getting the funding as the LHD has already done some work with
asthma. To apply for the funding, the director meets with the health education
coordinator/planner to identify data that is needed to write a strong proposal. The director
and the planner determine that there are several types of data that would be useful to present
as part of their proposal.

To support the scenario, data has been collected from a variety of current sources. Provided
datasets include aggregate data, map, shape, census, and primary data. In this scenatio
example, you will be using a primary data source (paper survey) to collect information for the
sample population of students from County X. You will use Make View to create the
electronic survey, Enter to add records to your survey, Analysis to import and analyze results,
Epi Map to plot the results, and Epi Report to present your findings. Below is a To-Do list of
the basic steps you will be accomplishing to develop the data needed to apply for funds for
the asthma initiative.




To Do List for Lessons 1-10

Use Make View Create the Electronic Survey

O Create your project MDB- Lesson 1

O Create an electronic version of the survey- Lesson 1

Use the Make View Program Editor to Develop Check Code

O Create Check Code to simplify the data entry process- Lesson 2

Use Enter Data to Add Student Records

O Enter records into your survey and data table- Lesson 3

Use Analysis to Merge Data and Create Statistics

O Open your project MDB in Analysis and view the entered records/data- Lesson 4
O Merge your project MDB with records from an MS Excel file- Lesson 5

O Create Frequencies, Means, and Tables using your data and record the results- Lesson 5
O Create Graphs using your data and record the results- Lesson 6

Use Analysis to Manage and Export Data

O Use the RECODE command to view date information from the survey in a specified
order- Lesson 7

O Export selected data to a new table and create a line graph using the selected records-
Lesson 7

O Use the SUMMARIZE and FREQUENCY commands to create aggregate data sets of
survey information that can be mapped- Lesson 8

Use Epi Map to Develop Maps to Illustrate the Data

O Create a choropleth and case-based map combination in Epi Map to look for
relationships between income and asthma- Lesson 9

O Create Point Maps for the locations of regional hospitals and schools- Lesson 9
O Create a map plotting the count of students with bronchitis per zip code- Lesson 9
Use Epi Report to Develop Report Data

O Use Epi Report to create a report that contains survey data and graphic output from the
first nine lessons- Lesson 10
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Lessonl

Make View: Create a Survey

SUMMARY

This lesson is an introduction to the Make View module of Epi Info™. During this lesson,
you will create your project MDB and create an electronic version of a survey used to collect
data from students in the county.

In order to develop data that can be used to show the need for funds, you must first develop
the survey that will act as your primary data collection instrument. In this example, the survey
has been developed for you and is attached as Appendix B: Parent School Asthma Pre-
Intervention Survey. Lesson 1 guides you through the process of using Make View to create
the survey. At the end of this lesson, you will have experience using the Field Definition
dialog box to make many of the fields needed to collect data from the survey population.

Time to complete: 1.5 hours Beginner
Getting Started with Make View

Overview of basic information to navigate Make View and understand Project creation.
Describes how to use the Field Definition dialog box.

Create Fields, Part 1

Begin using the Field Definition dialog box to create text, date, numeric, and Legal Value
fields. Learn how to set the tab order and name a page inside your Project. Includes a Practice
lesson.

Formatting Options

Learn how to format your workspace by changing erid settings or the background color.
Learn how to format/edit fields in your view by tesizing or aligning fields.

Create Fields, Part 2
Learn how to create a checkbox, group, mitror, and yes/no field. Includes a Practice lesson.
Skills Review

Hands-on series of tasks with fewer instructions and a greater degree of difficulty. Learn how
to create a comment legal field.

BEFORE YOU BEGIN

Install the latest version of Epi Info™ on your computer.
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Complete the File Set-Up section of the tutorial.

WHAT YOU NEED

Appendix A: Code Sheet

Appendix B: Parent School Asthma Pre-Intervention Survey

FIVE GOALS

= Create a project called AsthmaSurvey and a View called PrelnterventionSurvey.
®  Create three pages in a View to hold survey questions.

®  Create a Requited StudentID field/vatiable to track students.

*  Create Date of Birth and Age fields/vatiables to track student ages.

= Set the Tab Order to verify the data entry order the cursor needs to follow.

10



LESSON 1

Getting Started with Make View

Epi Info™ uses the Microsoft Access data format to create Projects, files, or MDBs. Each
Project contains a View and a Data Table. The View contains information about the screen
appearance, or how the survey looks, and how data is entered into the data table. For
example, you will create a View based on the Asthma Pre-Intervention Survey. The View will

be a re-creation of the paper survey along with information about field names, field types, and
Check Code.

The View and the data table live inside your Project or MDB. There can be up to 1,000 views
inside your project. Each view can contain 255 fields. Each field can contain 128 characters.
When you enter data in the Enter module, you will be entering data into your MDB. The data
table contains the actual values associated with your Project or MDB.

The Make View program is used to place prompts and data entry fields on one or many pages
of a View. Since this process also defines the database(s) that are created, MakeView can be
regarded as both the form designer and the database design environment.

Inside each View you will create fields (called variables in Analysis) to hold your data.
Variables can be stored on many pages inside a View. You can use the Program Editor
component of Make View to add Check Code to your variables. Check Code represents a
series of rules applied to your data. One example, used in the tutorial, concerns the calculation
of date fields. You can create Check Code stating that when a date of birth is entered in one
field, the age of an individual is automatically calculated and placed in another field. This
allows you to customize your questionnaire and makes data entry quicker and more accurate.

A Project or MDB
contains all the files that
make up your data table.

TABLE 1 TABLE 2 The Data Tables contain

the fields you create in
Make View and the data

from Enter Data. Tables
VIEW 1 VIEW 2 contain the data used for
Analysis.

PAGE 1 PAGE 3

The View is where you

: will design your survey.
Field5 [ ] There can be up to

i 1,000 Views inside a
Field 6 D Project. Views hoid your
pages and fields.

Pages denote sections
of new information just
as on a paper form.
Views can hold many
pages.

Fields are placed in
pages and become the
variables used for
Analysis after you Enter
your data.

Database Organization Chart

-11-
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The Make View Workspace

-
DU
1. From your desktop, double click the Epi Info™ icon 110

()
)

to open the program.

2. Click Make View or select Programs>Make View (Questionnaire) to open the Make
View module. The Make/Edit View window opens.

3. As you read this Overview, use your mouse to view available tasks from the drop-down
menus.

= Menus will not be active until you create a new project in Lesson 1.

This is an example of the Make View workspace. The workspace settings are set to default;
meaning the background color is grey and the grid will be visible when you open a new file.

B - -10lx]

Fie Edt View [reert Formst Took Help

Choose New or Open to begin

Thizis an example of the Make /Edit View
window. This section iz called roue View. Onee
voucreate or opena file, Tou can begin adding
— information to your View.

Thiz iz the Page Youwill right click inside the View to bring up

MNames panel. Views the Field Definition dislog box and begin

can contain many working.

pages.

From the Page

Names panel, youcan

alzo accesz the

Program Editor

function of

MaksView and set up

vour Check Code:.

The field: created in your view are the same az
thoze in the paper Asthma Survey. When the
data entered in the field: iz imported into
Amalyeis, rouwill soctit by feld namee, also
called Variahles.

Navigating Make View
File Menu

Use the File menu to create a new project, open an existing project, save, COpy a view,
navigate to Enter Data, or exit the Make View program.

Edit Menu

Use the Edit menu to cut, copy, paste, move grid, delete a page, rename a page, select
a page, or change the tab order.

12
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View Menu

Use the View menu to navigate to the check commands screen where you can edit
your Check Code.

Insert Menu
Use the Insert menu to insert a new field, a new page, or create a group.
Format Menu

Use the Format menu to set a default font, align fields, change your background
color, or edit your settings. Setting a default font affects all text created by the Field
Definition dialog box after the selection. It will not affect fields created prior to
selection. Settings made to the default font can be altered by the Font for Prompt
button in the Field Definition dialog box.

Tools Menu

Use the Tools menu to import Epi 6 REC files, import Check Code, make a view
from a data table, create a data table, or delete a data table.

Make View Help Menu

The Help menu contains the help file contents, how to files, a command reference,
and the About Make View file.

-13-
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Create a Project

Now you will create the asthma survey/questionnaire. The information entered here will
populate your database and be used for analyses in a later lesson. Creating the survey requires
some forethought into the types of analyses you may want to run on your data. For example,
later you may want to see the Means of Age. To do this, you will need to have an age variable
in your survey, and the data must be entered into a Number field type. Think about what you
may want to know later and create your survey accordingly.

You are going to collect primary data to illustrate funding needs for an asthma initiative. To
start, you are going to re-create the Asthma Pre-Intervention Survey in an electronic format.

Refer to Appendix A: Code Sheet and Appendix B: Parent School Asthma Pre-Intervention
Survey as you create the survey.

You need to create a new project and a new view. Once inside the project, you can add pages
and create views to address all the survey questions. Later, you will enter records into the
survey.

Be sure to place all your tutorial files in the EIHA Tutorial folder you created in File Set-Up.

1. From the Make View navigation menu, select File>New. The Create or Open
Project window opens.

2. Using the Look In drop menu, select your C drive.
3. Double click to open the Epi_Info folder.

4. Double click to open the EIHA Tutorial folder you created in the File Set-Up
section.

5. In the File Name field, type AsthmaSurvey.
6. Click Open. The Name the View dialog box opens.
7. Name the View PrelnterventionSurvey.
®  View names cannot have spaces or begin with numbers.
8. Click OK.

* The name of the window changes to Make/Edit View: PrelnterventionSurvey.
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The Field Definition Box

When you right click inside the View, anywhere inside the gray background area, the Field
Definition dialog box opens. This box is your main interface with the Make View module.
From here, you will create the fields where data will be entered into your survey and assign
names to the variables that make up your data table.

Use the Field Definition dialog box to:
* Enter a Question or Prompt. Use the tab key or your mouse to move from field to field.

=  Enter a Field Name. Field Names created in Make View are the Variable names used in
Analysis. No two Field Names can be the same.

= Select options for your field. For example, Read Only, creates a field that does not allow
for data entry.

®  Delete an existing field. Right click the text to open the Field Definition dialog box and
click Delete. To delete Legal Values and tables, open the associated table from the Field
Definition dialog box, and click Delete. There is no Undo button or verification prompt,
so be sure of your selection before choosing to delete variables or code tables.

-15-



EPI INFO™ TUTORIAL

Field Definition x|

Question or Prompt

Enter the Question or Prompt in this field.
Use the Font for Prompt button to overarite
vour default font and change the =tyle or =ize

;l Font for
j Prompt

of text.
Field MNarnes are the
—Field or Variable —Field Hame ﬁmsimdl &i::.'row
ta fal .l
Type | Text j Double click in prompt to char Irsis modide, rou
| will uze these names
Size | j to work with rour
data.

The Field or Variakle T:FPE will zet the type of

information entered for rour Prompt. id | Related View |

Based on the Trpe selected, Tou may be given
I- Rﬂlm‘t the option to select a corresponding Pattern for —Code Tables

the entrr. For example, if vou select Trpe as
|'_ Require MNumber, oucan select a pattern for that Legal Values

menber a5 7, 55, 55, ete. The Zize /Pattern

drop-dow = bazed on the Ty f field
I_ Read Or op-down change on TDE O Codes

zelected.
[ Sounde|

Field oz Variable Trpes dictate how data will be Comment LEQ&'
I_' Retain i =otered and how it will be available for analyzes

later.

oK Help

Field or Variable Types
From the Field or Variable type drop-down, you can create the following types of variables.
Click Cancel to close the Field Definition dialog box once you are familiar with the available

options.

Text

Creates a text data entry field. Letters or numbers can be entered in text fields. Text fields can
be sized for specific entries, or contain up to 128 characters. Can be used to create name or
address data entry fields.

Label/Title

Creates a title for the page or a label for a question. This field type is not searchable, not listed
in the tab order, and not visible for Check Code. Can be used to create a title in the view.

Text (Uppercase)
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Creates a text data entry field that can contain letters or numbers, but forces all text entties to
appear in uppercase only. Can be used to create a data entry field for state abbreviations or
identification fields that must use all caps.

Multiline

Creates a data entry field that can contain letters or numbers up to two gigabytes of
information. Can be used as a comments field or to enter long addresses.

Number

Creates a number data entry field based on a selected pattern, for example #, or ## H# ##.
Only numbers can be entered in the field. Can be used to enter identification numbers or
ages.

PhoneNumber

Creates a phone number data entry field based on phone number patterns. Select from one of

two patterns, #HH-HH#HH or HHH-HHH-HHHH.
Date

Creates a date entry field based on a selection of patterns, for example MM-DD-YYYY or
DD-MM-YYYY. Dates entered must match the selected pattern. Can be used to enter today's
date or a date of birth.

Time

Creates a time entry field based on a selection of patterns, for example HH:MM:SS. Times
entered must match the selected pattern.

Date/Time
Creates a data entry field that contains both a Date and Time based on a selected pattern.
Checkbox

Creates a checkbox response. The Checkbox field is treated like 2 Yes/No field. When using
the Checkbox field, non-selected boxes do not appear as Missing in Analysis. Can be used
with Check All That Apply type questions.

Yes/No

Creates a Yes or No data entry field. Field will accept the typed word Yes or No. Yes/No
fields left blank will appear in Analysis with Missing values for those questions. The yes or no
answer is stored in the database as a 1 or 0. When creating Check Code use the (+) = Yes or
(5 = No to register a yes or no response.

Option
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Creates a radio button selection list. Use with Select One Answer Only questions. The Option
field is for mutually exclusive choices; only on choice can be made. If more than one choice is
needed, then use the Checkbox option.

Command Button

Creates links to other components or files. For example, you can incorporate an executable
button in the view to open Analysis or another program such as Microsoft Excel.

Image

Creates a placeholder to insert images into the view. Use an image field to insert an image per
record, for example, a patient, rash, or bacteria picture. The image file types that are accepted
are Graphics Interchange Format ((GIF), Joint Photographic Expert Group (JPG or .JPEG),
Windows Bitmap Format (BMP), Windows Icon File Format (ICO), Windows Metafile
Format (WMF), and Enhanced Metafile Format (EMF).

Mirror

Creates a field that appears on many pages. Mirror field types only work with multiple pages
in a single view. For example, if a Patient ID is on page one, the value of Patient ID can be
echoed onto another page using the mirror field. Mirror fields are read only.

Grid
Creates a related table/grid that can be inserted into a questionnaire or view to track specific
information, for example, a child’s measurements.

Relate

Creates relationships between your main view ("patent” view) with sub views ("child" views)
ONLY within the same .MDB. For example, link the general patient information to the
patient's record of visits.
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Create Fields Part 1

There are many types of entry fields that can be created in Make View. For this lesson, you
will create fields for Title, Text, Number, Date, and Legal Value.

Create a Label/Title Field

1. To create a field, right click in the Make View workspace. The Field Definition
dialog box opens.

2. In the Question or Prompt field, type the title of your survey.
»  Parent School Asthma Pre-Intervention Survey

*  The Question or Prompt box allows you to create a question that holds 128
characters. Entered text always appears centered.

3. From the Field or Vatiable Type drop-down menu, select Label/Title.
4. In the Field Name field, highlight the default field name, and type PreSurvey.

*= The Field Name will take part of the Question or Prompt and will
automatically create its own name. Because the Field Name cannot begin
with numbers, if a number is the first character in the Question or Prompt, a
letter will precede the rest of the Field Name.

= Notice that your Field Name is the same as your title. Field Names are
created automatically by Epi Info™ based on the data entered in the
Question/Prompt field.

= Field Names are also called Variable Names. Variable Names are used by the
Analysis module. Try to create names that will be easy to reference later in
Analysis.

» Field Names cannot have spaces in them.
=  Some applications that work with Epi Info™ cannot use field names longer
than eight characters. Keep this in mind if you will be using your data with

other statistical programs.

» Field Names cannot be changed once your data table is set in the Enter
module.

5. Click Font for Prompt. The Font dialog box opens

» The Font for Prompt button is used to change the font setting for the
question or prompt for the field.

6. Select a font from the list.
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7. Make the font Bold and size 14.
8. Click OK Your title text has been formatted with the new font type

= A Label/Title field cannot be used to create Check Code, cannot be
searched, nor is it included in the tab order list.

9. Click OK The title of your survey appears on the page.
= To move your title to the top center of the page, use the click and drag

technique. Select the text with your mouse, left click and hold while moving
the text to the desired location.
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# Practice

Add instructions to the survey.
Right click in your view to open the Field Definition box.

Create a Label/Title Field that states, "Please answer all the questions below, whether ot not
your child has asthma."

Give your variable the Field Name Instruction.
Make the font size for your instructions 12.
Move your instructions underneath the title.

Follow the same process to create Text type fields for the following:

Prompt/Question Variable | Field Name | Other
Type
School ID Number Text SchoolNum
Student ID Number Text StudentID Select Required option.
Zip Code Text Zip

Notice that you are making fields generally considered numeric into text fields. This is to
ensure that theses numbers will always appear as entered.

To restrict the number of characters that can be entered in a text field and thereby control the
data entry process further, you could select from the size drop-down located in the Field
Definition dialog box, and limit the number of characters allowed during data entry. When
thinking about form design, you would need to consider potential errors that could be made
by allowing typing into all fields. Creating Legal Value drop-down boxes (covered later) are
another way of controlling data entry and limiting potential typing errors.

Page 1 of your View should look similar to this example:

M* B[l 31| Make/Edit Yiew: AsthmaSurvey

File Edit View Insert Format Tools Help

Add Page
Insert Page
Delete Page

e fer Ve

Proaram . S¢ ‘ Al .S:i.llde:m ID Nt

-21-



EPI INFO™ TUTORIAL

Create a Legal Value Field

When you create a Legal Value or Comment Legal field, you are creating a drop-down menu
within your view. Only selections from the drop-down menu will be accepted during data
entry. When creating a Legal Value field, the variable type must be Text.

The dataset contains a question about gender, which you are going to make a Legal Value
field.

1. Open the Field Definition box.

2. In the Question/Prompt field, type Gender.

3. From the Variable Type drop-down, select Text.
4. Use the default Field Name, Gendet.

5. From inside the Field Definition dialog box, locate the Code Tables section.

—Code Tables

Legal Values

Codes

Comment Legal

6. Click Legal Values. The Set Up Code/Legal Links dialog box opens.

7. Click Create New. An entry box opens for your selected value.

8. In the first line, type Female and press Enter, then type Mal and press Enter.
9. Click the Do Not Sort checkbox.

= Make View sorts all Legal Values alphabetically, unless you select Do Not
Sort.

10. Click OK to accept the Legal Values.
11. Click OK to accept definition entries.

= Notice your survey now contains a drop-down box with the values, Female and Male
as selections.
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Create a Date Field

The Date field is a numeric field with pre-set date patterns that are selected from the pattern
drop-down menu.

1.

To create a date field, right click in the Make View workspace. The Field
Definition dialog box opens.

In the Question/Prompt field, type Child’s Date of Birth.
From the Variable Type drop-down, select Date.

From the Pattern drop-down, select MM/DD/YYYY.
In the Field Name section, type DOB.

Select the Required option.

Click OK.

Create a Numeric Field

The Number field is a numeric value field that has six predefined value patterns. A new
pattern can be created by simply typing the pattern into the Pattern field.

Similar to Date Fields, selecting a Field type of Number gives you many Pattern selection
options. You need several types of number fields to complete the survey.

1.

2.

Open the Field Definition dialog box.

In the Question/Prompt field, type Age.

From the Variable Type drop-down, select Number.
From the Pattern drop-down, select ##.

Use the default Field Name, .4ge.

Select the Read Only option.

Click OK.

* In Lesson 2, you will create a Check Code to calculate this field, based on the
child's date of birth.
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# Practice

Create the Phone Number and PS School Number fields.

Hint: Phone Number is a new variable type.

Prompt/Question Variable Type | Field Name | Other

Home Phone Number PhoneNumber | Phone Select the Pattern
HHH #HE HHaH

PS School Number Text PSNumber Select Read Only
option.
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Set the Tab Order

The tab order is set automatically based on the positioning of the fields in your View;
however, you can manually change the order of tabs in your survey. If you do not verify the
tab order, then your cursor may jump to fields out of sequence with data entry and cause
errofs.

You want to be sure that the order of fields matches the way information will be entered from
the paper survey. Refer to Appendix B to review the field order of the paper survey.

1. Click Edit>Order of Field Entry (Tab Order). The Order of Field Entry
dialog box opens.

inio Order of FieldEntry . x|

Page Controls:

TabIndex |Prompt Name Tab Stop
1| School ID Number SchoolNum | True
2| Student ID Number Studentld | True Cancel |
3| Zip Code Zip True
4| Gender Gender True

Child's Date of Birth DOB Up I
E|Age Aage True
7| Home Phone Number Phone True
8| PS School Number PSNumber | True Down I

2. Seclect the field order you would like to impose by selecting a prompt and then
using the up and down buttons.

*  For example, the variable Age should come after the variable DOB.
3. Click OK to accept the new tab order.

4. C(lick File>Save.
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Name the page

If your survey contains more than one page, use the Page Names window to navigate pages. The
Page View Menu Panel displays the created Views' names and gives you access to created pages.
You can Add Pages, Insert Pages, and Delete Pages from this menu.

The Make View Program Editor can be accessed from this menu panel by clicking the Program
button. If you have a Related View in your project, the Home and Back buttons are available to

navigate between parent and child views.

1. From the Page Names panel, right click on the Page Name 1. The Pagename
window opens.

2. In the Page Name Field, type Personal Information.
3. Click OK. The page name appears in the list.

Page 1 of your View should look similar to this example:

Add Page
Insert Page

Delete Page

[ Program
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Create a Code Table

There are four schools responding to the survey. To ensure accuracy and speed of data entry,
you are going to create a Code Table that links the information entered in the SchoolNum
field to the information in the PSNumber field. This means that each time a School 1D
Number is selected from the drop-down, the field PS School Number will be automatically
populated based on the data table values you create. This helps to ensure consistency and
eliminate errors during data entry.

1. Right click on the text School ID Number to open the Field Definition dialog
box.

*  PSNumber and SchoolNum must be Text type fields.
*  PSNumber must be set to Read Only.

2. From the Code Tables section, select Codes. The Set Up Codes/Legal Links
dialog box opens.

3. Select PSNumber as the field you want to link to SchoolNum.
4. Click Create New. The Codes for Field box opens.

= The schools are named A, B, C, and D. Based on the School ID Number selected,
you want the corresponding PS School Number to populate automatically.

5. On the first line enter 4. Tab over and type 723 as the PSNumber.

intc Set Up Code/Legal Links : x|

Codes for field: SchoolHum

SchoolMum PShumber v Donotsort
A 123
B 234 OK
o 345
J|o 458 Create Hew
*
Use Existing Table
Cancel

- 27-



EPI INFO™ TUTORIAL

Use the tab key to navigate through the table set-up. Complete the series as
follows:

= SchoolNum B and PSNumber 234

= SchoolNum C and PSNumber 345

= SchoolNum D and PSNumber 456

Select Do Not Sort.

Click OK in the Legal Links dialog box.

Click OK in the Field Definition dialog box.

= School ID Number # now contains a drop-down menu. Once you select a School

ID Number, the PS School Number will automatically populate with the value you
entered in the code table.
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Formatting Options

This section outlines ways to customize your workspace and to edit fields in your View. Try
changing the background color or altering the grid settings. Color changes will appear in the
Enter module.

Changing the Background Color

You can alter the background color of your Make View workspace and apply the changes to
one or all pages in your project.

= Select Format>Background. The Background dialog box opens.
®  (lick Change Color. The Color selection window opens.

= Select a new background color for your survey.

*  Click OK to accept the selected color.

= Select Apply to Current Page Only or Apply to All Pages.

® (lick OK to view your selection.

®  (lick Clear Color from the Background dialog box return to the default grey.
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Changing the Grid Settings
Grid settings give you a way to align the fields in the View. There are several ways to

customize your grid settings.

From the Make View navigation bar, click Format>Settings. The Snap to Grid dialog box
opens.

infc SNap to grid , x|

Snap to grid Yisible arid on screen

[V Snhaptogrid on v Visible arid on

13 ﬁ Character widths between grid lines

(" Snap left side of prompt to grid

(¢ Snap left side of entry field to grid

oK Cancel

The default setting of Snap to Grid is On. When moving a field on the View screen, the field
will snap to the left portion of the grid it is closest to. You have the option to snap based on
the prompt or the entry field. Select the Snap to Grid option if you want your fields to snap
in line with your grid when they are created or moved. De-selecting the Snap to Grid
checkbox allows you to move fields to any location on the page.

Select the Visible Grid option if you want your working space to contain a grid while
designing the View. The grid is not visible in the Enter module. Visible Grid on Screen,
allows you to remove the visible grid from the MakeView screen. If the checkmark is on, then
you have the option to change the width between the grid lines.

You can change the size of the grid spacing by using the up and down arrow keys next to
Character Widths Between Grid Lines. Changing the widths of the grid lines, gives you
more control over the spacing of fields.
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Resizing Fields

Entry fields can be resized.

Left click an entry field box (not the prompt text).

Use the blue bounding box and the click and drag method to make the data entry boxes
larger or smaller.

The numbers inside the fields tell you how many characters are visible in the survey.

To resize a drop-down box, press the Alt key and left click to get the blue bounding box
and resize using the blue bounding box handles.

Aligning Fields

Fields can be selected and aligned either horizontally or vertically.

Left click at the corner the field you want to align.

Hold your mouse button and drag a rectangle around several fields.

i |
| Zip Code [ |
. PS School # [ |
| '

Select Format>Alignment>Vertical or Format>Alignment>Horizontal. The
selected fields will line up based on your selection.

PSSchool # [ ZipCode [
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Copying and Pasting Fields

Fields can be cut, copied, and pasted.

Left click and drag a rectangle around the field you want to copy.
Select Edit>Copy.

Select Edit>Paste. The pasted field appears on top of the copied field.
Left click and drag the field to move it.

Right click the pasted field to open the Field Definition dialog box. Notice that a number
has been added to the Field Name since field names must be unique.
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Create Fields Part 2

Now you will create the asthma history section of the survey. The first question on the paper
survey is a setries of yes or no checkboxes related to asthmatic conditions. You are going to
create one checkbox per condition and then group all the conditions. This will allow you to
analyze how many students checked Yes per condition and to analyze the conditions as a
group. A single checkbox will indicate a yes if checked and a no if blank. To create the next
section of the survey, you will need to create separate fields for the question and the
checkboxes.

Questions have been shortened in the electronic survey; refer to Appendix B Parent School
Asthma Pre-Intervention Survey to see the original questions.

You are not going to create the entire survey in Lesson 1; however, you can use the field
information in the Appendix A: Code Sheet for additional practice.

Add a New Page
1. From the Page Names panel, click Add Page. The new page appears.

2. Right click inside your new page. The Field Definition dialog box opens.

3. Enter the following Prompt: Has a health professional ever told you that your child has any
of the following conditions?

= For long questions, you may need to enter a line break inside your prompt.
To do this, hold the Ctrl key and press Enter inside the sentence where you
want the break to occur.
4. Select Label/Title as your Variable Type.
5. Type the Field Name: Condition.

6. Click OK

Create a Checkbox

1. Under the question, right click to open the Field Definition dialog box.
2. Enter the following Prompt: Asthma.
3. Select a Variable Type of CheckBox.

4. Use the default Field Name, Asthma.

o

Click OK. The Asthma checkbox appears in your view.
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* In the Enter Data module, checkboxes appear as selected or not selected.
* In the Data Table, checkboxes ate stored as -1 and 0.

=  When used in Analysis Commands, checkbox values are selected and coded

as (+) and (-).

< Practice

Create three checkboxes to complete the question.

Arrange the checkboxes near each other and align them horizontally or vertically, depending
on your workspace and preference.

Prompt/Question Variable Type | Field Name | Other
Reactive Airway Disease Checkbox RAD

Asthmatic Bronchitis or Checkbox Bronchitis

Wheezy Bronchitis

Wheezing Checkbox Wheezing

Your checkboxes should look similar to this example:

r iixisé Hééiih ﬁ’r&é&s’.ﬁr{éf 'é\é’r’i&l& 'y;iﬁ ihéf ;6.;{ chil ] i;és'é}-} Sﬁh : 'fdiiéié.}igééri ditions? | T
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Groups can be created to organize similar data on a survey. Variables that are part of a group
can be analyzed alone or as patt of the group. Take the question and the variables regarding

conditions and group them.

1. Use the left mouse button to drag a rectangle around the fields that are to be
included in the group. This includes the question and the four variables.

2. From the navigation menu select Insert>Group. The Group Dialog box opens.

3. In the Group Description field, type Asthmatic Conditions.

* To select a different color for the group, click Set Color.

Group Description

Jssthmatic Conditions]

oK

| Set Color

LCancel

4. C(lick the OK.

» To Edit or Ungroup, right click inside the group name. The Edit Group dialog opens.

* To Resize the box containing the group, double click inside the box. A resize arrow

appears.

= To move the entire group, left click the group title text, hold, and drag to the new

location.
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Create a Mirror Field

Mirror fields allow you to show one field on many pages, but only enter the information once.
Because there are several pages of information for each child, you want to place their Student
ID on each page.

1. Open the Field Definition dialog box.

2. Enter the Prompt as ID.

3. Select the Variable Type: Mirror.

4. Use the default Field Name, ID.

5. Click OK The Assign Variable to Mirror Field dialog box opens.

6. Sclect the variable StudentID from the list.

7. Click OK.

8. Move the field to the top of the page.

» In the Enter Data module, once the Student ID # field is entered, it will
populate this field automatically.
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Create a Yes/No Field

1.

2.

Open the Field Definition dialog box.

Enter the following Prompt: Has a health professional prescribed any medication to your
child for breathing problems?

» The original question has been modified as it contained more than 128
characters, which is more than allowed in the prompt field.

Select the Variable Type: Yes/No.
Type the Field Name: Medication.
Click OK.

= From the Enter Data module, only the text Yes or No can be entered in this
field.

» In the Data Table Yes/No values ate stored as 1 or 0. Missing values appear
blank.

»  When used in Analysis Commands, Yes/No values are selected and coded as
(+) and (-). Missing values are selected and coded as (.).
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# Practice

Create a new type of drop-down selection box called Comment Legal.

= Comment Legal fields are set up like Legal Value fields, except that Comment Legal fields
allow you to place a number in front of text, so that, when populating fields, a number is
entered. This is a text field, but it will display as a number in the Analysis module.

Create a group that contains the variable Symptoms, Whistle, and Cough. Name the group
Monthly Breathing Difficulties.

Name Page 2 _Asthma Symptoms.

Prompt/Question Variable Type | Field Name | Other

Select the month when your | Text WMonth Click Comment
child's breathing was the Legal. Create a New
Worst. Table.

Enter each month of
the year in the
following format:
1-January 2-
February 3- March,
4- April, 5- May, 6-
June, 7- July, 8-
August, 9-
September, 10
October, 11-
November, 12-
December

Select Do Not Sott.

During their worst breathing | Label/Title Symptoms
month, select how often the
following symptoms
occurred.

Wheeze or whistling in the Text Whistle Legal Value
chest?
The 5 Values are:
Never

2 times each week or
less

3 to 6 times each
week

Every day, but not all
day
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LESSON
Prompt/Question Variable Type | Field Name | Other
Every day and all day
Select the Do No
Sort Checkbox.
Have a cough? Text Cough Legal value

You can use an
existing Legal Value
table to populate new
tables. From the Field
Definition dialog box,
click Legal Values.

From the Set Up
Code/Legal Links
dialog box, click Use
Existing Table. The
Select a View dialog
box opens.

Select codeWhistle.
Click OK. The Select
a Field to Link dialog
box opens.

Select Whistle. Click
OK. The Legal
Values for Cough
populate.

Select the Do Not
Sort checkbox. Click
OK
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Page 2 of your View should look similar to this example:

Edit Yiew:PreInterventionSurvey
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Skills Review
Add a Page to the View.

Create a numeric variable to hold the number of missed school days.

The survey asks respondents if they have missed sports activities. The variable MissSport is a
Yes/No vatiable. Create a Legal Value variable that asks for more information if the
respondent answers Yes. Align the question to the MissSport variable.

Create a numeric variable to hold the number of people living in the home with asthma.

Verify the tab order for all your pages. You want your cursor to follow a logical data entry
path.

Name Page Three Medical Information.

Select File>Save. Epi Info™ saves your data automatically, but it is a good idea to save after
you add new information.

Prompt/Question Variable Type | Field Name | Other

How many days of school has | Number MissDays Pattern ###
your child missed due to
breathing problems?

Have breathing problems Yes/No MissSport
stopped your child from
participating in sports?

If Yes, how many times in the | Text SPTimes Legal Value
past month.
2 times 2 month or
fewer

3 to 4 times a month

1 to 3 times each week
4 times each week or
more

Select Do Not Sort

How many people living in Number IHome HH#
your home, including this
child, have asthma?
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Page 3 of your View should look similar to this example:

’ = |D|_)_<] Make/Edit Yiew:PreInterventionSurvey
1  Personal Information | File Edit View Insert Format Tools Help
2 Asthma Symptoms 1 1
3 Medical Information
of schoal has your chi d
Add Page
Insert Page "
Delete Page ;
Program L fYes h n the past m i
. How many people living in your home, including this child ha.vg.qsth;rﬂ?:-..

If you need to close Epi Info™ before completing your survey, the New Data
Table dialog box will appear and prompt you to create a Data Table. Click Cancel.
You do not want to create a data table until you are ready to enter data.

Data Table dialog box opens.
= (lick Cancel.

When you exit either by going to File>Exit or clicking the close X, the New

If your data table is set before you are ready to enter data, you can use

Tools>Delete Data Table to reset your View. This will allow you to make
edits to your field names and add code tables.

WARNING: This function should only be used if you have not entered any
data; otherwise, all your data will be deleted!
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Lesson Complete!

WHAT YOU LEARNED

LESSON 1

How to
* Navigate Make View.

= Create a new project.

= Use the Field Definition dialog box to create fields.

® Add pages to a View.

"= Customize a View.
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Lesson2
Make View: Check Code

SUMMARY

This lesson is an introduction to creating Check Code inside the Make View module of Epi
Info™. In this lesson, you will learn how to customize your survey by creating a seties of data
entry rules. You will also learn the components of the Make View Program Editor.

In Lesson 1, you created a vatiety of fields to collect data for your survey. In Lesson 2, you
will use the survey you created and add Check Code to some of the fields. Check Code makes
the data entry process faster and more efficient, so there are fewer errors when you begin
using the data later to create the statistics and develop your report.

Time to complete: 2 hours Intermediate

Getting Started with Check Code

Overview of basic information to navigate the Program Editor and understand Check Code.
A list of available commands is provided. Functions and Operators are defined.

Create a Skip Pattern

Use the Program Editor to create an IF/THEN statement. Also introduces the commands
ELSE and GOTO.

Use the ASSIGN Command

Use the Program Editor to create a mathematical function that calculates the Age field based
on entries in the Date of Birth field. Use the YEARS function.

Use the DIALOG Command

Use the Program Editor to notify data entry personnel of specific data entry rules or errors to
avoid.

Skills Review

Series of five review questions based on the reading and hands-on activities in this lesson.

BEFORE YOU BEGIN

Complete Lesson 1 Make View: Create a Survey
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WHAT YOU NEED

Appendix A: Code Sheet
Appendix B: Parent School Asthma Pre-Intervention Survey
Asthma Survey.MDB- created in Lesson 1

Appendix D: Skills Reviews Answer Key

FIVE GOALS

® Be able to open and navigate the three sections of the Make View Program Editor: the
Command Tree, the Check Commands window, and the Program Editor code window.

»  Create a skip pattern using an If/Then statement.
® Create code using the ASSIGN command.
= Create code to calculate age using the YEARS function.

®  Create a DIALOG box that appears during data entry and prompts the user to verify
their data.
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Getting Started with Check Code

Check Code is used to validate data entry and to make the process of entering data faster.
With some advance planning, you can create code that will do calculations, skip questions
based on answers, prompt the user with dialog boxes, and populate fields across pages and
records. In its most basic form, Check Code is a set of rules for the person entering data to
follow. Check Code helps to eliminate errors that can occur when entering large amounts of
data.

Open the Program Editor by selecting the blue Program button located in the Page Names
window or by selecting View>Check Code from the Make View navigation menu.

The Make/Edit View: Check Commands window contains three working areas: the Check
Command Ttree, the Make/Edit View: Check Commands window, and the Program Editor.
The Check Command Tree is not visible until you select a variable from the drop-down
menu.
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The Program Editor Workspace

To access the Program Editor and create Check Code, you must open the survey you created
in Make View Lesson 1.

1. Open the Program Editor by clicking the blue Program button from the Page Names

window or selecting View>Check Code. The Make/Edit View Check Commands
window opens.

Notice that the Page Names window is still open since a variable has not been

selected.

Meseal |nloimabon

i Sinians i :]'  Baiom & At 0K

This is an example of the Program Editor/Check Code wotkspace. The top of the page
shows you ate in the Make/Edit View: Check Commands window.

Make/Edst Wiew: Check Commands . Tl

Chooge field where action will oocur

Befors cr Alter
| Cancal |

This is an example of the Make Edit/View: Check
Command: window.

The Page
MNames window
iz ztill wizible
zince a variable
has not been
zelected.

L Open Sanne Prirt I Bun | Fum This Cosmrmantd I

Editing a View
PrelnterventionSuna

This is the Program Editor window.

Code can be typed directly inte the Program Editor in this space. Alwav: Save
vour code before leaving the Program Editor.

o]

2. From the Choose Field Where Action Will Occur drop-down, select a variable. The

Make/Edit Check Commands window updates to include the Check Command Tree and
the tab selector.
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| [ Fioce £t View:Check Commonds =
Choose field where action will occur
Assign Bedote o et
Hide Stunbusell | Beboon [T 0K I Cancel I
Unhide -
Golo
Cloer get I i I I Ege T Y d MNotice the tab zelection buttonz. You can uze the

Autosearch
I | tabs and buttons to acce:s the same commands that

Execute Do fon | are listed in the Command Tree.
Dinlog
et - When ereating codes that use multiple commands
vou mav need to uze a combination of commands
S T R Pt | == I | fromthe Ttree and the tab zelector.
The Check window

thows the different

commandsz that can
be vzed to create
Checlk Code.

The Check window
will not open until
vou select a varizble
from the Action Will

Occur drop-down Variables with Check Code will be tagged with an * in the Choose Field Where
menu. Action Will Occur drop-down.

Onee vou create Check Code, it appears in the Program Editor.

o | s

*  Check Code must be associated with an existing variable, page, view, or record. The
commands are executed when the data entry cursor enters or leaves the selected
variable. Variables available for Check Code are organized by page in the drop-down

menu.

* The Check window and Command Tree display a list of all available check
commands that can be used in the Make View program. Clicking on one of the
Commands opens the wizard or dialog box needed to create the selected kind of
code.

* The Make/Edit View: Check Commands window allows you to select when and to
which variable the Check Code program you create will be applied. Previously created
Check Code can be accessed from this window. Use the drop-down list to view the
available variables. Any variable tagged with an asterisk (*) has Check Code associated
with it. Select the variable to view the code inside the Program Editor. Since you have
not created code yet, none of your variables will be tagged.

* The Program Editor displays the commands created from the Check Command
Tree. If you have experience with coding, you can type directly into the Program
Editor and save your code without using the wizards or the Command Tree.
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Navigating the Program Editor

Familiarize yourself with the available commands and options present in the Program Editor.

Click Cancel to close any Command Option boxes you open during the Overview.

Click Cancel from the Check Commands window or the close X to exit the Program
Editor prior to starting the next lesson.

Make/Edit View: Check Commands Window

The Choose Field Where Action Will Occur drop-down shows a list of fields in
the current view. Read Only variables will not execute Check Code.

The Before or After radio buttons tell when the action will occur or when your
Check Code will run in the data entry process. You can create code that runs before

you enter data in the selected field or after you enter data when your cursor leaves the
field.

The Tab section gives you another way to navigate and select commands. Click a tab
to open it and see which command buttons are associated with it. Commands
selected from the Tab section open the same wizards/generators and dialog boxes as
the Command Tree.

Check Window

The Command Tree is located inside the Check window. Commands located inside
the Check window act as buttons when clicked. The dialog boxes that open when
you select a command are also called wizards or generators as they are used to guide
you through the Check Code process.

Once you begin creating code, the Command Tree will not be active while inside
some of the dialog boxes. When that occurs you must use the tabs to select
commands.

Available Commands

Define

Use this command to create new vatiables. Located on the Vatiables Tab.

Assign

Use this command to assign the result of arithmetic or string expression mathematics
to a variable. Located on the Variables Tab.
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Hide

Use this command to hide a field from view and make it a read only NOENTER)
field. Located on the Fields Tab.

Unhide

Use this command to make a field visible and return it to the status it had before it
was hidden. Located on the Fields Tab.

GoTo

Use this command alone or in an IF statement to transfer the cursor to a specifically
named variable field. Located on the Fields Tab.

Clear

Use this command to set the field named to the missing value, as though the field had
been left blank. CLEAR is frequently followed by the GOTO command that puts the
cursor in position for further entry after an error. Located on the Fields Tab.

Autosearch

Use this command to cause Enter to search for one or more matching records. If a
match is found, you can display and edit the matching record(s) or ignore the match
and continue to enter the current record. Located on the Records Tab.

If

Use this command to define conditions and/or consequences that result when the
conditions are met. An alternative consequence can be given after the ELSE
statement. Located on the Records Tab.

Execute

Use this command to execute a Windows or DOS program. Located on the
Programs Tab.

Dialog

Use this command to provide interaction with users from within a program. Dialogs
can display information, ask for and receive input, and offer lists for making choices.
Located on the User Interaction Tab.

Help

Use this command to display an .HTM or .CHM document. Located on the User
Interaction Tab.
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Program Editor Menu

Edit

Use the Edit Menu to copy, cut, and paste code. You can also edit your code with
Delete Line and Replace Line options. Search your code using Find, Find Next,
Program Beginning and Program End options.

View

Use the View Menu to see additional menu options. Use the Status Bar to see
information displayed about your script. Use the Tool Bar to edit your script.

Fonts

Use the Fonts Menu to change the font type, style, size, and color that appears in the
Program Editor.

Help
Use the Help menu to view the help file contents.
Save

Use the Save button to save the Check Code you created in the Program Editor. The
Save button also verifies that the code syntax is correct.

Print

Use the Print button to make a paper copy of your code.
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Functions and Operators

Check Code is created using a series of functions and operators. Functions
and Operators are used inside commands to perform tasks such as extracting
a year from a date, combining two numeric values, or testing logical
conditions. Check Code can be typed directly into the Program Editor or
created using the dialog box generators. Within each dialog box, there are
Function and Operator buttons to guide you in creating the proper syntax for
your Check Code. You can also click Functions from within each dialog box
to see a list of all the available functions and examples of the proper syntax.

Functions modify the value of one or more variables to produce a result. For
example, the function ROUND produces a whole from a variable that has
decimal places. Almost all functions require arguments enclosed in
parentheses and separated by commas. Where arguments are required, do not
place spaces between the function name and the left parenthesis.

These are the function buttons available using the Program Editor dialog
boxes.

AND OR "Yes" “No" | “Missing"

Operators are used to combine two items. For example, the "+" operator
combines Varl and Var2 to produce a sum, as in Var3=Varl+Var2.

These are the operator buttons available using the Program Editor dialog
boxes.

+|-=]t]l=]<]|>]|&]|"]| (]|)]

Operator Buttons

+ Addition = Equal or Assign

- Subtraction < Less Than

* Multiplication > Greater Than

/ Division <> Less Than or Greater Than (not Equal
to)

& String Concatenation " Enclose dialog or text

( Parenthetical Expression ) Parenthetical Expression
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Create a Skip Pattern

Skip patterns can speed up the data entry process by moving the cursor to a specified field
based on the answer to a question. In this survey, parents were asked if their children have
missed sports due to breathing problems. If they have missed sports, then you want them to
specify how often, if they have not then you want them to move to the next question.

To create a skip pattern, you will need to use the IF command. First, plan out what you want
the code to accomplish.

If a respondent answers Yes, they have missed sports, Then you want the cursor to GoTo
the next question. Else (if they answer No) you want the cursor to GoTo (or skip) to a new
question.

MissSport Variable

SpTimes Variable
Have breathing problems stopped IF »  Yes THEN GOTO——| If Yes, how many times in the past
your child from participating in month?
sports?
ELSE

l

No

GOTO

l

IlIHome Variable
How many people living in your
home, including this child, have
asthma?

IF/THEN Diagram: Creating a Skip Pattern
To create a skip pattern inside the survey, you are going to use the Program Editor.

1. Click Program from the Page Names window. The Make/Edit View: Check
Commands window opens.

2. TFrom the Choose Field Where Action Will Occur drop-down, select MissSport.
*  You want the action to occur After data is entered into the MissSport field.

3. From the Records tab or the Check Command Tree, select If. The IF dialog box
opens.

4. From the Available Variables drop-down, select MissSport. The selected variable
appears in the If Condition field.
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LESSON

From the Operators, click =.

From the Operators, click "Yes".

* The If Condition field will read MissSport=(+)

Click Then. The tab selector appears. The Check Command Tree is not active.
From the Fields tab, select GoTo. The GOTO dialog box opens.

Select SPTimes from the list of variables.

10. In the GOTO dialog box, click OK. The IF dialog box opens.

2

F x|

If Condition

MissSport= (+)

‘ o

Available Variables LI'I*III=I< >|&|"|(I)

MissSport

I ISSSPO EI AND OR “Yes" "No" "Missing"
Then

GOTO SPTimes GOTO lliHome

Functions | OK I

Clear | Help Cancel |

11. Click Else. The dialog box disappears.

12. From the Fields tab, select GOTO. The GOTO dialog box opens.

13. Select IllHome from the list of variables.

14. Click OK. The IF dialog box opens.

15. Click OK. The code appears in the Program Editor:

IF MissSport= (+) THEN
GOTO SPTimes
ELSE
GOTO IIHome
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END
16. Click Save.

= Notice in the drop-down that the field MissSport now has an asterisk meaning there
is code associated with that field.
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Use the ASSIGN Command

To program a mathematical function, you must use the Program Editor. In the survey, you
have a field called Date of Birth and a field called Age. You are going to create Check Code
that will calculate and enter the age of the respondent based on the date of birth and the date
the survey was completed.

1.

9.

From your View, click Program or select View>Check Code. The Program
Editor opens.

From the Choose Field Where Action Will Occur drop-down, select DOB. The
Check Command Tree opens.

= After is the default setting for when all actions will occur. The calculation needs to
run after you enter information into the Date of Birth field.

From the Variables tab or the Check Command Tree, click Assign. The
ASSIGN dialog box opens.

* To complete the code, use the Functions and Operators buttons and the keyboard to
type in the = Expression field.

From the Assign Variable drop-down, select Age.

= The calculated value appears in the Age field.

In the = Expression field, type the function YEARS.

»= To see a list of all the available functions, click Functions.
Type, or click, the left parenthesis.

»  Statements of a function must be enclosed in parentheses. Use the Operator buttons
ot type them in from your keyboard.

From the Available Variables drop-down, select DOB.
Type a comma.

Type the survey date of 10/25/2005.

10. Type or click the right parenthesis.
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assiN x|

Assign Variable

[hge ]

= Expression

Years(DOB,10/25/2005)
« 2

Available Variables |- ]=]<=]&]"](])]

DOB
I —J AND OR "Yes" "No* “Missing"

Functions | | OK

Clear | Help | Cancel |

11. Click OK. The Check Code appears in the Program Editor.

» ASSIGN Age=Years(DOB,10/25/2005)

12. Click Save in the Program Editor.

»  Always save your Check Code. Codes will not update unless you save. The
Save feature will also inform you of any syntax errors that will affect the code
functionality.

= Notice that DOB now has an asterisk next to it in the Choose Field Where
Action Will Occur drop-down menu. This signifies that the variable has
Check Code associated with it.

13. Click OK in the Check Commands window to return to the Make/Edit View

main page.
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Use the DIALOG Command

You are going to create Check Code that will provide a dialog box and added instructions for
the person entering data into the project survey. The DIALOG command provides
interaction with the data entry personnel from within a program. Dialogs can display
information, ask for and receive input, and offer lists for making choices.

In the survey, you have a variable called MissDays. This variable refers to the question "How
many days of school has your child missed due to asthma?" You want to make sure that any
half days are rounded up and counted as whole days during the data entry process. Using the
DIALOG command allows you to set a reminder to run during data entry. This will help to
ensure you get the most accurate count from your survey data and that all persons entering
data will be doing so based on the same set of rules.

1. From your View, click Program or select View>Check Code. The Program
Editor opens.

2. From the Choose Field Where Action Will Occur drop-down, select MissDays.
*  You want the action to occur after data is entered into this field.

3. TFrom the User Interaction tab or the Check Command Tree, select Dialog. The
DIALOG box opens.

X

—Dialog Type

' Simple: (" Get Variable " List of Values

| Ok |

Clear Help ] Cancel ]

4. In the Title field, type Missed Days.
» The Dialog Type radio button will be selected as Simple.

5. In the Prompt field, type Count any half days as one.
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5,

Dialog Type
(6‘ Simple (" Get Variable {" List of Values
Title
IMissed Days
Prompt
Ijum any half days as one.

1

Clear Help I Cancel |

Click OK. The code appears in the Program Editor.
DIALOG "Count any half days as one." TITLETEXT="Missed Days"
Click Save in the Program Editor.

= When you test your code in the next chapter on Enter Data the following dialog box
should appear once you enter data in the MissDays variable.

Missed Days [

Count any half days as one.
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Skills Review

Place a checkmark by the answer to the following questions. Refer to Appendix D Skills Reviews
Answer Key for additional details and the answers.

1. Check Code can run Before or After values are entered in a variable.

[ JTrue
[ ]False

2. Using the Program Editor, you can create Check Code that will run across pages or
records.

[ JTrue
[ |False

3. In the Check Command window, variables tagged with an X have Check Code associated
with them.

[ JTrue
[ JFalse

4. Which Function is used to create an age variable?
[ JROUND
[ JYEARS
[ JTXTTONUM
5. How does the answer Yes appear in the Program Editor?
L)
1o
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Lesson Complete!

WHAT YOU LEARNED

How to

* Navigate the Program Editor.

*  Create a Skip Pattern using the IF/THEN commands.
= Use the ASSIGN Command.

= Use the YEARS function.

= Use the DIALOG command.
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Lesson3

Enter Data

SUMMARY

This lesson is an introduction to entering data from the Make View and Enter Data modules
of Epi Info™. In this lesson, you will learn how to enter data, navigate the survey you created
in Make View, and enter data for the sample survey provided. You will also learn how to
search for records from the Enter module. When you enter records in the survey, you are
populating the data table with information that will be used for later analyses.

In Lesson 1, you created an electronic version of the survey you will use to collect data to aid
in your asthma initiative project. In Lesson 2, you added Check Code to your survey to speed
the data entry process and to act as a quality control measure. In Lesson 3, you will begin
entering data about the students from the survey population. Data entered in this lesson will
be used to create statistics and develop a picture of the student body of the county for which
you are trying to get funds.

Time to complete: 1 hour Beginner

Getting Started with Enter Data

Overview of basic information to navigate the Enter Data module.
Enter Data to the Survey

Use the record information provided to enter data into the View you created. Verify your
Check Code works as intended.

Enter Data to the Sample Survey

Gives you the opportunity to view a complete survey with existing records. Enter data from
the surveys in Appendix C.

Find Records
Introduction to the Find feature. Practice lesson included.

Skills Review

Series of five review questions, based on the reading and hands-on activities in this lesson.

BEFORE YOU BEGIN

Complete Lesson 1 Make View: Create a Survey.

Complete Lesson 2 Make View: Check Code.
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Download the sample project Asthma Survey 2005.

WHAT YOU NEED

Asthma Survey.MDB- This is the project you created in Lessons 1 and 2.
Asthma Survey 2005.MDB- This is the provided dataset used in this Lesson and Lesson 4.
Appendix C Sample Parent School Asthma Pre-Intervention Surveys

Appendix D Skills Reviews Answer Key

FIVE GOALS

® Learn to navigate the Enter Data module.

* Enter 4 records in the View you created.

" Verify that the data entry conditions and Check Code functions.
® Troubleshoot your Check Code, if there are errors.

= Enter 2 records in the sample View and Data table provided. The sample view and data
table Asthma Survey 2005.MDB will be used in Lessons 4-10.
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Getting Started with Enter

The Enter Data module can be accessed by clicking Enter Data from the Epi Info™ main
page. You can also access Enter Data through the Make View module by selecting
File>Enter Data. Use the Enter Data module to enter information into the survey/view you
created in Make View. When you enter data into the view, you are populating the data table
inside your project (mdb). You can navigate from Make View to Enter to test your Check
Code and Tab Otder, but once you create a data table and start adding data, you cannot make
changes to field names or types in your view.

The Enter program displays the View you created in Make View, constructs your data table,
and controls the data entry process by using the settings and Check Code established in Make
View. From the Enter Data module, you will enter new data, modify existing data, or search
for records. The Find function allows records to be located based on a seties of matched
variables. As you enter data, the cursor moves from field to field, page to page, and saves data.
Navigation is provided for New, Next, Previous, First, and Last records and through related
tables.
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The Enter Data Workspace

If you do not have the project Asthma Survey.MDB that was created in Lesson 1 and 2, you
can use the provided project titled Asthma Survey 2005.MDB. Use this project for a reference
as you read the navigation sections and then skip to Section 3: Enter Data in the Sample
Survey.

1.

2.

From the Epi Info™ main page, click Enter Data. The Enter window opens.
Select File>Open.

Open the project you created in Make View titled AsthmaSurvey. The Select a
Table dialog box opens.

Select the View PrelnterventionSurvey.
Click OK. The Data Table dialog box opens.
Click OK to create a New Data Table. The New Data Table dialog box opens.

Click OK to keep the Data Table Name and Unique ID set as the default. The
Enter page opens with the view you made in Make View.

® Notice you are in Record 1 of 1 on Page 1 titled Personal Information.
® The Enter Page Panel displays a list of pages created in the project. Data entered into

a page is automatically saved; however, you should use the Save Data button or
File>Save after making changes to existing records.
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This is an example of the Enter Data workspace. The top of the page shows you are in the
Enter module.

2 Medical Information
3 Asthma Symploms

Parent School Asthma Pre-Intervention Survey

Please answer all the questions below, whether or not your child has asthma.

Nesxt
Save dua School ID # - Student ID # | Zip Code
Mtk pecoid as debted
I v —

Thiziz an exammple of the Enter Data Gender :' Child's Date of Birth s Age [_

Page Panel

Notice that you can navigate entered

records by using the arrow buttons Phone Number | - - PS School #

at the bottom of the page. You are in

Fecord 1 of 1.

Voucan eater 2 new seord br Thiz iz an example |.:>fthr: Emter main page. Thleleft hand pane

. _ L shows that rou are in the Enter module of Epi Info™ and are on

chicking the New button or tabbing - 1 call ;:IP o oot .

through the record to the end of the 2ge 1 called Fersonal Information.

available felds. The cursor iz sitting in the Student ID # field where Toucreated a
Code Table. Notice in the bottomleft hand section of the wereen,
the words Must Enter. woutab to fields that contain Checks

“ode, the text in thels ges, For example, 2
Reguired field will read MMust Emter w vou tab toit.
Record
1 Mew Riecoad
<< I z|>| 5> MusiEries

Navigating Enter Data

You cannot navigate through pages until data has been entered in the preceeding page or until
all required fields are filled. You can familiarize yourself with the workspace prior to adding
records. Keep the Enter module open to complete the next lesson.

Enter Data Main Page
File

Use the File menu to open, close, save, print, or exit. You can also compact your database
with the compact utility. This reduces the size of your database but does not affect your data.

Edit

Use the Edit menu to Find specific records or to delete records. Deletion removes the current
record from the project, and all records associated with it. It also marks the record as deleted
in the database. You can exclude deleted records from your analyses. Click Undelete to
return the record to active status.

Options
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Use the Options Menu to select the values of Yes/No vatiables. Variables can appear as
Yes/No or True/False. From Options, you can also maximize the size of your screen image
by selecting Full Screen.

Help
Use the Help Menu to view the online help.
Enter Data Page Panel

Use the Page Panel to navigate pages in your View. If you are entering data and have a
required field, you must enter information into that field before proceeding to the next page.
From the Enter Page Panel you can go to the next record, save data, delete a record, find a
record, or create a new record.

Use the navigation arrows at the bottom of the Enter Page Panel to move between records.
Single arrows move you one record forward or backward. Double arrows move you to the
first or last record.

Record

801 New Record

<<|<|>|>>|

Type a specific record number in the Record field and press Enter to go directly to a record.

Enter Data into your View

Begin entering the four student records listed in the table on the following page. Tab through
each field to run the Check Code and to navigate through the survey. If you do not tab
through the survey, your check code will not run.

1. Verify that your Check Codes are functioning,

Is the Code Table you created between the variables for School Number and PS
School Number functioning?

* Did the Age field populate after you tabbed out of the Date of Birth Field?

= If your answer to Missed Sports is No, is the Number of Times variable skipped? Did
the cursor go to the following question? If the answer is Yes, did the cursor go to the
Number of Times variable?

* Did the dialog box pop-up after you tabbed through the question regarding missed
days?
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= After entering all the records, use the arrow keys to navigate between records and
pages. Is the code functioning across records and pages?

2. Sclect File>Save.

Check Code Troubleshooting

If your Check Code did not function, you can close the Enter module and return to
Make View to verify the following. Use Lesson 2 on Check Code to verify your code
appears as coded.

®  Verify your tab order. Coded fields must be in the proper order and on the
proper page to function. For example, does the Age field come after the Date of
Birth field in your tab order list? Are SpTimes and IllHome in the proper order?
On the same page?

* Did you Save all your Check Code in the Program Editor after it was created?
Open the Program Editor and verify that there is an asterisk next to the variable.

* Is your code applied to the correct field? Are your If/Then statements in the
proper order?

® Is your code syntax correct? You can verify this by placing the cursor inside the
code and clicking Save. Did the code turn green or red? Red means you have an

error in your code.

* Do your commands have END statements?
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Enter the following Student Records

Refer to the section on Check Code Troubleshooting if your codes do not work.

Student 1 Student 2 Student 3 Student 4

School ID Number A | School ID Number B | School ID Number C | School ID Number D
Student ID Number 1 | Student ID Number 2 | Student ID Number 3 | Student ID Number 4
Zip 12207 12084 12077 12059

Male Female Male Male

01/29/1994 08/19/1995 11/08/1995 07/28/1994
555-555-5555 444-444-4444 333-333-3333 222-222-2222
Asthma, Wheezing No Conditions Asthma, Bronchitis RAD

Yes, Medication No Yes, Medication Yes, Medication
October N/A September July

Wheeze 2 times each | Never Wheeze, 3 to 6 times Wheeze, Never

week cach week Cough, 2 times each
Cough, 2 times each Cough, Every day but | week

week not all day

Missed 11 days Missed 0 days Missed 5 days Missed 3 days

Yes, Missed sports, 1
to 3 times a week

No, Did not miss
sports

Yes, Missed sports, 2
times a2 month

No, Did not miss
sports

Asthma in home=1

Asthma in home=0

Asthma in home=2

Asthma in home=1
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Enter Data into the Sample View

If you are working with the Asthma Survey project you created in Lesson 1 and 2, you are
going to change projects. The sample project contains an example of the entire survey created
in Make View with ten records already entered. The sample project Asthma Survey 2005 is
located in the EIHA Tutorial folder

If you already have Asthma Survey 2005 open, skip to Step 7.

You will be entering the data from the two attached surveys located in Appendix C.

1. From the Enter Data menu, select File>Open. The Select a Table dialog box
opens.

2. Click Change Project. The Select a Project window opens.

3. Locate the EIHA Tutorial folder and select the sample project Asthma Survey
2005.

4. Click Open. The Select a Table dialog box opens.
5. Select the View PrelnterventionSurvey.

6. Click OK. The project opens to the next new record, which is number 11. The
sample project contains ten previously entered records.

7. Use the surveys from Appendix: C Data Entry Surveys to add two additional records.
You should have twelve records at the end of this lesson.
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_ (0| x| Fie Edit_options Help

2 Medical Information
3 Asthma Symptoms

Idertification

School ID Number - Student ID

Number

—

Parent School Asthma Pre-Interventation Survey

Gender -

Next
Save data Personal Information
Mark. lac;r:‘ das deleted Zip Code l—
Child's Last Name | Child's First Name [
New

Child's Date of Bith [ - Age [

Your Last Name |

PS School Number

Relationship to Child

Your First Name

Home Phone Number -

Grade [ Today's Date [ - -

Record
11 New Record
< | < | > | >> Coded
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Find Records

There are two ways to locate specific records in a large data table.
1. From the Record field located on the Enter Page panel.
®  Type the number 3 into the Record number field.
® Press Enter. Record 3 of 12 appears in the window.
2. Click Find from the Enter Page panel. The Find Record window opens.
*  Use the Find feature to locate specific records in a large dataset to edit.

" Select a variable to search, try Zip. An entry field appears. Enter the search criteria.
For this example, enter 12207. Click OK or press Enter.

* To open a Record from Find, double click the black arrow to the left of the results

row.

* Embedded text items in multiline and text fields can be found by searching for
*word*. This type of search is called a Wild Card Search. In a Wild Card search, the
asterisk is used to represent any letter or string of letters. For example, a search of
last names as with the field ChildLast could look like *jo*. This search would pull

names with the letters jo in the beginning or end of a word in the last name field, ie.
Jones, Johnson, Johns, etc.

* Dates and numeric fields can be searched using less than or greater than values (<>).
= OR can be used search for matches based on more than one critetia.
* ?can be used to search for a single unknown character.

* (lick Reset to clear the page and begin a new search.
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~ Practice
Find the students who attend School A.

Find the students who do not have bronchitis. Hint: Bronchitis NO.
Find the students who missed more than 5 days of school. Hint: MissDays>5.
Find the students who attend School A and have Asthma.

Find the students whose last name begins with S. Hint: ChildLast S*.
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Skills Review

Place a checkmark in the correct answer for each of the questions below. Refer to Appendix
D: Skills Review Question and Answer Sheet for further details.

1. Once you create a you cannot change field names or types in your view.
[ ISurvey
[ ]Data Table
[ Legal Value
2. What are the two ways you can enter a new record? Check all that apply.
[ ]Tab through to the last record.
[ ]Click New.
[ ]Select the last available page.

3. If you are entering data and have a required field, you must enter information into that
field before proceeding to the next page.

[ JTrue
[ |False

4. What expression could you enter in the Find feature to locate children who are greater
than 6 in age?

[ ]Age=6
[ ]Age<6
|:|Age>6

5. From the Find feature, what button do you click to clear the page and begin a new
search?

[ ]Start

[ JReset
[ ]Cancel
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Lesson Complete!

WHAT YOU LEARNED

How to

= Navigate Enter Data.
= Enter Records.

=  Change Projects.

®*  Find records.
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Lesson4

Analysis: Basics

SUMMARY

This lesson is an introduction to the Analysis module of Epi Info™. This lesson shows
different ways information can be viewed, based on selection inside Analysis.

In Lesson 3, you entered student data in a survey to collect information on asthma symptoms.
In Lesson 4, you will use the Analysis module to READ in that data and view it. Once
records are in Analysis, you can use several commands to SELECT, SORT, or LIST data that
can be included in the asthma report you want to create to apply for funding. Lesson 4 covers
these basic skills and shows you how to READ in data and Change Projects, which are
important skills you will use every time you open the Analysis module.

Length of time to complete: 1 hour Beginner
Getting Started with Analysis

Overview of basic information to navigate Analysis. Includes information about the Current
Project and Data Source settings. Use the READ Command to view the Asthma Survey 2005
Project.

Use the List Command

Use the LIST Command to view the variables in your dataset.

Use the Sort Command

Use the SORT Command to organize your data.

Use the Select Command

Use the SELECT Command to organize your data. Includes a practice lesson.
Skills Review

Series of five review questions based on the reading and hands-on activities in this lesson.

BEFORE YOU BEGIN

Complete Lesson 3 Enter Data
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WHAT YOU NEED

Asthma Survey 2005.MDB- If you have not completed Lesson 3, you can use the Asthma
Survey 2005.MDB project to complete this lesson as an introduction to Analysis; however,
you will have ten records rather than twelve.

Appendix D: Skills Reviews Answer Key

FIVE GOALS

= Understand and be able to use the READ/IMPORT command. This command is used
every time you open Analysis.

= Use the LIST command to create a grid or web table and view the variables in your data
table.

®  Use the SORT command to view variables in a specified order.
®  Use the SELECT command to view requested vatiables.

® Beable to cancel a SELECT or a SORT and return to the original data count.
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Getting Started with Analysis

The Analysis module can be accessed by clicking Analyze Data from the Epi Info™ main
page. You can also select Programs>Analyze Data. Analysis can read data files created in
Make View and other types of databases such as DBase, FoxPro, MS Excel, and others.
Analysis can produce graphs and interact with Epi Map to display geographic data. Once you
have collected your data, Analysis acts as a statistical toolbox providing you with many ways
to transform you data and perform statistical evaluations. Analysis also provides you with
ways to export your data to new file formats such as MS Excel.

The Analysis module contains three working areas: the Analysis Command Tree, the Analysis
Output window, and the Program Editor.

1. The Analysis Command Tree contains a list of available commands separated into folders
by command type. The Command Ttree is used to create the functions and programs that
run your statistics from the data. Selecting a command opens the corresponding dialog
box for that command, function, or statistic to run.

2. The Output window acts as a browser and displays all the information that is generated
from the commands run in the Program Editor. The Output window buttons allow you
to navigate through the program scripts that have been run and displayed in the output
screen.

3. The Program Editor displays the dialog/code of the commands created using the
Command Tree. Commands can be directly typed into the Program Editor. Programs or
PGM files written in Analysis are stored in the open .MDB. Programs can be saved and
run against new data when the data becomes available.
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The Analysis Workspace

1. Click Analyze Data or select Programs>Analyze Data to open the Analysis module.

This is an example of the Analyze Data workspace. The top of the page shows that you
are in the Analysis module. The Analysis module consists of three windows: the
Command Tree, the Output window, and the Program Editor.

PRIES] .
. =
| f‘*‘i‘d‘ﬂ-tiﬁl:l
(sl Iy 5 J b Prirk M
bb = = =l
ala i
Froud (impoet Epi Info
Relste
‘white [Expot]
Merge
Delete File/T able
Delete Records
Undelete Records
= Variables
Define Thiz is the Crutput window.
Undefing
Axmgn
Recode After fou mon 3 command, the results
Dasplay appear in this window.
= Selectll
Select
Cancel Select Once you Read ina file, the Crutput
" window shows your Current View and the
Thiz iz the C d Record Count for that View.
Teee for Analysis.
Comumands are broken - |
into folder groups.
The Help button appears ol e
at the bottomofthe Hew Open Sve Brint I Bun I Fam This Command I
window. =
Thiz iz the Program Editor window.
Comrmands generated from the
Command Tree wizards appearin
thi= window.
e pd |
Help | =
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Reading in a Project

Read this section and then Read/Impott your survey data by completing the steps listed in
the next section.

In order to analyze data, you must Read or Import a project into the Analysis module. The
Read command allows you to select a project and data table on which to run your statistics.
The Read/Import command will be used every time you open the Analysis module in order
to begin work.

From the READ dialog box, you will select a project containing data for analyses. The
Current Project is the database file (MIDB) which is the default source of data. Output files
created from this data will be stored in this destination folder, unless otherwise specified. In
our project, the destination for Output files is the EIHA Tutorial folder.

Read x|

C:- Current Project
[~ ICEpi—infoEtHA TutorialAsthma Survey 2005.mdb

Data Formats
Epi 2000 ﬂ

C Data Source >
IC:Epl_InqulHA Tutoriallisthima Survey 2005.mdb _|

—Show
i+ \Views Al

Views
e eI e e O U Y e

Change Project 1>  Save Only | oK |

Clear | Help | Cancel |

It is recommended that the Current Project and the Data Source match. Having the same
Project and Data Source allows you to keep all your data and tables together. If they do not
match, click Change Project. The project you select will appear as the Current Project and
Data Source.

If you Read in a file where the Project and Source do not match, you will be asked to create a
linked table. Data sources other than the current project are accessed through link tables
located in the current project. Linked files are references to the data tables, and not the actual
data, so if you move your files to a new location, the links will be broken.
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From the Data Formats drop-down you will specify the data format for the data to be read
ot wtitten, for example MS Excel. From the Show section, you can select project Views or
All tables, views, and links for a project. When you click OK, the READ command will
be saved in the Program Editor and it will run the command at the same time. Save Only
allows you to save the command to the Program Editor only and does not run the READ
command.
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Read/Import an Epi Info™ Project
From the Analysis Command Tree, click Read (Import). The READ dialog box

1.

opens.

Click Change Project. The READ File Name box opens.

Use the Look In drop-down menu to locate your C drive.

Open the Epi_Info folder.

Open the EIHA Tutorial folder.

Select the project Asthma Survey 2005. This is the project you added records to
from the Enter module in Lesson 3.

Click Open. The Cutrent Project field and the Data Source field inside the
READ dialog box will populate.

Select the view PrelnterventionSurvey from the Show section.

Click OK. The Output window opens.

Exit

e

Analysis Output

t | ¥ | 2| @

Previous | Mext Last History

=

Open

&

Print

O

Maximize

e

Bookmark.

[ Analysis Commands
(= Data
Read (Import)

Relate
Write (Export)
Merge
Delete File/Table
Delete Records
Undelete Records
[ Variables
Define
Undefine
Assign
Recode
Display
[ Select/If
Select
Cancel Select

Sort

Cancel Sort
[ Statistics

List

Frequencies

Tables

Match

Means

Summarize

Graph

Map
[ Advanced Statistics
Linear Regression
Logistic Regression
Kaplan-Meier Survival
Cox Proportional Hazards
Complex Sample Frequencies
Complex Sample Tables
Complex Sample Means

Help

|»

=

Epi Info

Current View: C:\Epi_Info\ETHA Tutorial\Asthma Survey 2005.mdb:viewPreInterventionSurvey
Record Count: 12 (Deleted records excluded) Date: 4/27/2005 11:57:35 AM

- New Program []
s Run Help

Program Editor
File Edit

New | open | sae | print ] Run Run This Command

[READ 'C:\Epi_Info\EIHA Tutorialllisthma Survey
2005.mdb' :viewPrelnterventionSurvey

* The Output window shows your Current View from inside the EIHA

Tutorial folder.
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You should have a Record Count of 12.

Notice the READ command you executed appears in the Program Editor.

Navigating Analysis

Read the following sections and familiarize yourself with the Analysis workspace. Click
Cancel or the close X to exit any dialog or command boxes you open.

Output Window

The Analysis Output window acts as a browser to display all the output information
that is generated from the commands created and run in the Program Editor. The
Output window buttons allow you to navigate through program scripts that have
been run and displayed including Previous, Next, Last, History, Open, Bookmark,
Print, and Maximize.

¥ | 1

i

@ém‘

Previous MNext Last History Open _ﬁookmark Print Maximize
Program Editor Menu
File

Use the File Menu to create New files, Open, Save, Close, Print, and Exit.
Edit

Use the Edit Menu to Copy, Paste, Delete, Find, Replace, or go to the Program
Beginning, and Program End.

View

Use the View Menu to place the Status Bar and/or the Tool Bar.
Fonts

Use the Fonts Menu to select Fonts, Style, and Color.

Run

Use the Run Menu to Run a Program or Run This Command to run one line of
code.
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Commands in this Lesson

The Command Tree contains a set of commands located in a serties of nine folders.
READ/IMPORT

READ is the most commonly used command. The Read (Import) command changes the
current data source and/or the current project. It removes any standard defined variables.
The READ command operates on many different types of data. Epi Info™ can Read in 24
different types of files. Located in the Data folder.

SELECT

The Select command specifies a condition that must be true for a record to be processed. Use
to select a set of records for analyses. For example, select records based on gender or zip
code. Located in the Select/If folder.

CANCEL SELECT

The Cancel Select command cancels a previous SELECT command. Located in the Select/If
folder.

SORT

The Sort command specifies the sequence in which records will appear when using the LIST,
GRAPH, or WRITE commands. SORT organizes the listed data in an ascending or
descending order, based on selected variables. For example, you can sort by last name or age.
Located in the Select/If folder.

CANCEL SORT

The Cancel Sort command cancels a previous SORT command. Located in the Select/If
foldet.

LIST

The List command creates a listing of the current data table. Lists can be customized to list all,
exclude, or show specific records. Located in the Statistics folder.
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Use the LIST Command

The LIST command creates a line listing of the current dataset. Select specific variables from
the Variables drop-down to narrow the list or select * (the Wild Card) to display all the
variables. Check the All (*) Except box and select from the Variables drop-down to exclude
variables from the list.

1. From the Command Tree Statistics folder, click List. The LIST dialog box

opens.
x
Variables
I =
[~ Al (*) Except Display Mode
" Weh (HTML)
{« Grid

" Allow Updates

Save Only OK

Clear Help Cancel

2. Click OK to accept the default settings. The variables in your dataset appear in a
grid table inside your Output Window.

* Notice the LIST command in the Program Editor.

*  Grid output is not embedded, so an Output file is not created.
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oo T o]
Scho StudentID |Zip Gender DOB Age Phone YourLast |PSNumber | ChildLast | ChildFirst |Yd
Exit A 1 12207 male 01231934 11 | 555-555-555 Smith 123 Smith Randy Cl
A 2 12210 female 10281997 |7 | 456783123 Sullivan 123 Sullivan Brittany Bil
[ Analysis Commands Allla 3 12206 male 06-23-1995 9 | 456-878-459 Lewis 123 Lewis Benii Ki
[ Data A 4 12183 male 02-01-19% |9 | 896-564-548 Jones 123 Jones Lee Rid
Read (Import) A 5 12110 male 04031934 11 | 156-489-456 Michaels 123 Michaels  Steve E
Relate A 3 12047 male 03131935 10 564-986-532 Logan 123 Logan Ken Jin
‘Write (Export) A 7 12202 male 07-21-1998 6 | 569-784-521 Rogers 123 Rogers Aaron Ly
Merge A 8 12209 male 0912-19% |8 | 564-956-231  Phillips 123 Philips Larry M
Delete File/Table A 9 12209 male 09051997 |7 | 564-896-523 Sutton 123 Sutton Brett Ci
Delete Records A 10 12208 male 12181935 |9 | 789-456-156 Davidson 123 Davidson | Mark S
Undelete Records A 12208 female 11-30-1934 10 | 555-665-555 Evans 123 Evans Katie
(= Variables A 12203 female 11081995 9 333-333-333 Wiliams 123 Williams Beth
Define
Undefine
Assign
Recode
Display
= Select/If
Select

Cancel Select

Sort
Cancel Sort
(= Statistics
Frequencies
Tables =
Match ¥
.
Summarize .
Graph File Edit View Fonts Run Help
New | Open l Save [ Print | Run | Run This Command ‘

¢ % =
Lineas Hegrestion READ 'C:\Epi_Info\EIHA Tutoriallisthma Survey :|
Logistic Regression 2005.mdb ' :viewPreInterventionSurvey
Kaplan-Meier Survival ILIST * GRIDTABLE

Cox Proportional Hazards
Complex Sample Frequencies
Complex Sample Tables

Complex Sample Means _,J

Hob . o]

Create a Web Format List
1. Click List. The LIST dialog box opens.

2. From the Display Mode section of the LIST box, select the radio button Web

3. Click OK The List appears in the Output window in a web table format.
= Web display mode creates an embedded Output file.

= Notice the title bar now contains the name of your default output file.
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Use the Sort Command

The SORT command allows you to specify the sequence in which records will appear. If
more than one variable is selected, records are sorted in order by the first variable. After you
sort records, you must use the LIST command to see the results.

1.

2.

From the Command Ttee Select/If folder, click Sort. The SORT dialog box opens.
Double click the variable DOB to place it in the Sort Variables field.

= Variables can be sorted by ascending or descending order.

Click OK.

* The Record Count stays at 12.

Use the LIST command to view all the variables. You can view the list in the format you
prefer, Grid or HTML.

* Notice how the list is sorted based on the DOB variable.

Click Cancel Sort. The CANCEL SORT dialog opens.

Click OK.

= Records remain sorted until you close Analysis, Read in a new project, or Cancel Sort.

= Notice the Sort information is listed in your Output window.

Current View: C:\Epi_Info\ETHA Tutorial\Asthma Survey 2005.mdh: viewPreInterventionSurvey
Sort: DOB
Recard Count: 12 (Deleted records exciuded) Date: 9/14/2005 1:03:48 PM
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Create a List of Sorted Variables
1. Click Sort. The SORT dialog box opens.

2. Double click the variable ChildLast to place it in the Sort Variables field.
3. Click OK.
4. Click List. The LIST dialog box opens.
5. Select Web (HTML) from the Display Mode.
6. Irom the Variables drop-down select
= ChildFirst
» ChildLast
»  Asthmatic Conditions
7. Click OK. The selected variables appear in a web table format.

* Notice the list is sorted alphabetically by the Child's Last Name vatiable.

C:Epi_Info\EIHA Tutorial,0UT144.htm
p V|0 =8| &0
Previous {dexk Last History Open Bookmark Print Maximize
5|
‘ Chill\}i;:!frst ‘ Chili;i;:nl‘;.ast Rea;)t:tsr:a?:':way A sthna Asthmate Bl;:::::;lnt:]ss or Wheezy Wheemic
IMark |Davidson ]Yes |Yes |Yes |Yes
IK atie lEvans |Yes [Yes [Yes IYes
|Lee IJ’ ones lNo |Yes IYes |Yes
Benji Lewis Yes Tes No No
’Ken |Logan |No |Yes IYes lNo
ISteve IMichaels lNo IYes IYes IYes
ILan'y |Phi]1ips |Yes |Yes IYes |Yes
|Aaron |Rogers |No |Yes IYes |No
Randy Smith No Yes  No Yes
|Btittany ISul]ivan |Yes |Yes lYes |Yes
IBrett ‘Sutton |Yes |Yes INo ’Yes
IBeth |Williams |Yes |Yes |No |Yes

8. Click Cancel Sort. The CANCEL SORT dialog box opens.

9. Click OK. The original dataset order is applied.
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Use the Select Command

You can use the SELECT command to specify criteria for data to be included in Analysis
functions. Think about the various ways you could divide your data into groups using this
command. From the current data, you could select based on Age, Gender, Zip Code, or any
combination of variables, in addition to illness information.

Once you make a selection, it affects all the analyses that follows. You must use the Cancel
Select command to remove the selection. Selections accumulate until you Cancel Select, close
Analysis, or Read in a new project. Use the LIST Command to see the selected records.

From the survey, select only the male students' data.

1. From the Command Tree Select/If folder, click Select. The SELECT dialog box
opens.

2. From the Available Variables drop-down, select Gender. Gender appears in the
Select Criteria field.

3. Click the = operator.
4. Click or type quote ".
5. Type the word Make.

* The word Male must be enclosed in quotes because it is a text field. Text variables
must appear in quotes.

6. Click or type quote " to close the expression.

N ]

Select Criteria
Gender="male"

< 2

Available Variables ﬂ 2 | = | I = | < | | &I " | { | H
I Gemvlos j AND | OR "Yes" "No" | "Missing"
Functions | saveony | oK |

Clear | Help I Cancel |

7. Click OK. The Output window updates with your new selection criteria.
» The Current View stays the same

» The Select criteria appears as Gender="Male"
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The Record Count changes to 9.

The Program Editor contains the Select command information.

Analysis y

Exit

i

Analysis Output

L/

Previous Next

i

Last

=

Print

O

Maximize

&

Bookmark

3

History

—
=
Open

[ Analysis Commands
= Data
Read (Import)
Relate
‘Wiite (Export)
Merge
Delete File/Table
Delete Records
Undelete Records
(= Variables
Define
Undefine
Assign
Recode
Display
(= Select/If
Select
Cancel Select
If
Sort
Cancel Sort
(= Statistics
List
Frequencies
Tables
Match
Means
Summarize
Graph
Map
(= Advanced Statistics
Linear Regression
Logistic Regression
Kaplan-Meier Survival
Cox Proportional Hazards
Complex Sample Frequencies
Complex Sample Tables
Complex Sample Means

Help

|

Epi Info

Current View: C:\Epi_Info\EIHA Tutorial\Asthma Survey 2005.mdb:viewPreInterventionSurvey
Select: Gender = "male"

Record Count: 9 (Deleted records excluded) Date: 4/27/2005 12:08:05 PM

Program Editor - New Program .
File Edit View Fonts Run Help
New | open | save |  print | Run | Run This Command

IREAD 'C:\Epi_InfD\EIHA TutoriallAsthma Survey
|2005.mdb' :viewPreInterventionSurvey

ISORT ChildLast
ILIST ChildFirst ChildLast AsthmaticConditions

[SELECT Gender="male"

List the Selected Records
1. Click List. The LIST Dialog box opens.

2. Select Web (HTML) as the Display Mode.

3. Click OK to view all the variables.

Notice that all the records in the list are for male students.
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Select Based on Age

Remember the Select command has a cumulative affect on your data. Now select all the Male
students who are younger than the age of 9. You have already selected the male students.

1. Click Select. The SELECT dialog box opens.

2. From the Available Variables drop-down, select Age.
3. Click or type <.

4. Type the number 9.

» The Select Criteria field should read Age<9.

M x

Select Criteria
Age<9
« 2
Available Variables LI 2 I = | I = I <|s I &I L | { | )
I Auo LI AND OR "Yes" "No" "Missing"
Functions | Save Only I | OK I
Clear | Help ] Cancel |

5. Click OK. The Output window updates.
= Notice the Record Count is now 2.

* Notice that your Select criteria reads (Gender = "male") AND (Age < 9). This
expression could have been entered into the Select Criteria field at one time.

» The expression SELECT Gender = "male" AND Age < 9 could have been typed
and Run directly from the Program Editor.

Current View: C:\Epi Info\ETHA Tutorial\Asthma Survey 2005.mdh: viewPreInterventionSurvey
Select.: (Gender = "male" ) AND (Age<9)
Record Count: 2 (Deleted records excluded) Date: 9/14/2005 1:07:33 PM

6. List the records in a Web format.
7. Click Cancel Select.

= Notice the Record Count returns to the original 12.
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~ Practice
Select the students who answered Yes to Bronchitis. (Hint: Bronchitis="+") You should get a
Record Count of 8.

Sort those 8 students by Age.
List the students in a web format.

Do not forget to Cancel Sort and Cancel Select to return to the original 12 records.
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Skills Review

Place a checkmark next to the correct answer for each of the following questions. Refer to
Appendisc D Skills Reviews Answer Key for further details.

1. After you run a command, the code appears in which window?
[ ]Output window
DProgram Editor window
[ ]JCommand Tree
2. What command allows you to open a project for analysis?
[ JLIST
[ JREAD
[ ISELECT
3. What command would you use to see variables and records in the current data table?
[ JLIST
[ JSORT
[ JREAD
4. What command would you use to specify a sequence for records to appear?
[ISORT
[ JLIST
[ JSELECT
5. What are the two Display Modes you can use with the LIST command?
[ Web (HTML)
[ ]Grid
[ IMS Word
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Lesson Complete!

WHAT YOU LEARNED

How to

= Use the LIST Command.

= Use the SORT Command.

= Use the SELECT Command.

= (Cancel and Sort or Select of records.

Read/Importt an Epi Info™ project.
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This page intentionally blank.
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LessonS
Analysis: Creating Statistics

SUMMARY

This lesson is an introduction to creating statistics using commands available in the Analysis
module. You will create results using the FREQUENCIES, MEANS, and TABLES
commands. Record your results on the Tear Out Answer Sheet provided. Verify your results
with the answers listed in Appendix E Lessons 5 Answer Key.

In Lesson 4, you used the READ command to view records entered in the survey during
Lesson 3. In Lesson 5, you will merge the 12 records from the Asthma Survey 2005.MDB
into records gathered and recorded in an MS Excel spreadsheet format. Many times
information needed for analyses will come from a variety of sources. In this example, you
have student records in an .MDB and in an MS Excel spreadsheet. You will use the MERGE
command to place all the student records in one project and then create statistics to see what
these records can tell you about asthma among the sampled student body.

Some of the things you are interested in discovering from the data is the frequency of asthma
among the students, the worst month for asthma among the students, and what is the average
number of missed days of school due to asthma. These types of data will be used to create the
report that illustrates the need for asthma initiative funding.

Length of time to complete: 2 hours Beginner
Commands in this Lesson

Brief explanation of the commands used in this lesson and the results produced by using
those commands.

Use the Display Command

Use the DISPLAY command to view information about the variables in the project.
Use the Set Command

Use the SET command to generate viewing options for records and statistics.

Use the Merge Command

Use the MERGE command to join information from an MS Excel spreadsheet to an Epi
Info™ project file.

Use the Frequency Command

Use the FREQUENCY command to produce results based on a number of selected
occurrences. Includes a Practice Lesson.
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Skills Review

Use the SELECT command to create a Frequency for a subset of records.

Use the Means Command

Use the MEANS command to define an average.

Skills Review

Use the ASSIGN command to populate a field. Compute the MEANS of the new values.
Use the Tables Command

Use the TABLES command to produce results based on cross-tabulation of variables.
Includes a Practice Lesson.

Save a Program

Use the Program Editor to save and run the program created in this lesson.

BEFORE YOU BEGIN

Complete Lesson Four Analysis Basics

WHAT YOU NEED

Asthma Survey 2005.MDB
AsthmaTable.xls
Tear Out Q/A Sheet- Record your answets on this page.

Appendix E Lesson 5 Answer Key- Compare your answers to this page.

FIVE GOALS

®  Merge records from an Epi Info™ project file with an MS Excel file.

= Use the FREQUENCY Command to discover which condition has the highest number
of affected students.

= Use the MEANS Command to discover which school in the survey had the highest
average of missed school days due to breathing problems.

=  Use the TABLES Command to discover the odds and risk ratios for having wheezing
and asthma.

= Save a program (.PGM) for use in a later lesson.
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Tear Out Q/A Sheet

Use this sheet to record your answers in the Answers column as you progress through the
Lesson 5. Answers are listed in Appendix E Lesson 5 Answer Key.

A. Questions in Lesson 5 are marked with a letter.

Frequency Sections Answers

A. Are there more males or females in the survey population?

B. Which condition has the highest frequency?

C.  Which month had the highest number of students with
breathing difficulties?

D. Which school had the highest number of students with
bronchitis?

E. Which gender has the highest frequency of Asthma?

F. How many students answered Yes to Reactive Airway Disease?

G. What s the percentage of students with Reactive Airway
Disease that have been prescribed medication?

H. Which zip code has the most surveyed students living in it?

I.  Of that zip code, which condition had the highest frequency?

J. How many students answered Yes to all four conditions:
Asthma, Reactive Airway Disease, Bronchitis, or Wheezing.

K. Based on all four conditions and zip code, are the conditions
evenly distributed among the survey population?

L. Does one school have mote students in affected zip codes and
with all four conditions than the others do?

Means Sections Answers

=

. What was the most frequent number of missed days?

N. What is the mean (average) number of days missed due to
asthmatic conditions?

O. Which school had the highest average of missed days?
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Means Sections Answers
P. Was the school with the highest average of missed days for
males the same as the school with the highest average of
missed days for females?
Q. Is the average number of missed days higher among those who
answered Yes to asthma than the overall average? Refer to
Question N.
R. What is the average age of the student population?
Tables Section Answers

S. Does one school have a higher number of students with
asthma?

T. Which school has the highest number of students with
wheezing?

U. How many students had both asthma and wheezing?

V. What are the odds that you have the condition wheezing if you
have the condition asthma?

W. Is the Odds Ratio for Bronchitis and Reactive Airway Disease
lower or higher than Asthma and Wheezing? Refer to
Question V for the Odds Ratio for Asthma and Wheezing.

X. How many children with the conditon wheezing were
prescribed medication? From those results, what is the Risk
Ratio?

Y. Is the Risk Ratio for being presctibed medication for the
condition asthma higher or lower than being prescribed
medication for wheezing? Compare the results to Question X.

Z. Are the risk ratios for Asthma and Wheezing higher for

children under 10 than they are for the survey population as a
whole? Compare to the results from Question Y.
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Commands in this Lesson

The following commands are used in this lesson.
DISPLAY

Use this command to display table, view, and database information. Use the display option
Variables Currently Available to see all the variables in the dataset, including names, field
types, and format information. Use Display, prior to merging or creating statistics, to ensure
that field types and variables names have been coded as needed. Located in the Variables
folder.

SET

Use this command to view the current values of Analysis option settings and generate
commands to change them. Statistical and graphic viewing options can be selected. Yes, No,
and Missing values can be viewed in alternate forms. Allows the inclusion or exclusion of
missing records in statistical computations. Located in the Options folder.

MERGE

Use this command to merge records in one dataset with those in another, using one or more
defined identifiers or build keys to establish the match between records. Merged records can
be appended or updated to the new dataset. Merge is only supported when the READ data
source is an Epi Info™ or MS Access table. The MERGE data source can be of any type.
Located in the Data foldet.

FREQUENCIES

Use this command to produce a table showing how data is distributed, counts of any given
interval, how many records have each value of a selected vatiable, or the number of
occurrences for a specified variable. If more than one variable is given, a separate table is
created for each variable. Confidence limits for each proportion are included. Records may be
included or excluded from the count by using SELECT statements. Located in the Statistics
folder.

MEANS

Use this command to compute descriptive statistics for a continuous numeric vatiable. The
mean of a set of data is equal to the sum of the data divided by the number of items in the
data set. When used with a cross-tabulation variable, it also computes statistics showing the
likelihood that the means of the groups are equal. The mean of a yes/no variable is the
proportion of respondents answering yes. Means can be created for continuous or categorical
values. Continuous variables fall along a continuum with one variable selected, for example,
age. Categorical variables are groupings or categories with two variables selected, for example,
gender. If one variable is selected, the program produces a table similar to the Frequencies
table plus descriptive statistics. If two vatiables are selected, the first is a numeric variable
containing data to be analyzed and the second is a variable that indicates how the group will
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be distinguished. The output of this format is a table similar to that produced by Tables, plus
descriptive statistics of the numeric variable for each value of the group variable. Means
produces the following statistical tests: parametric tests, Analysis of Variance or ANOVA (for
two or more samples), student's t-test (for two samples), non-parametric tests, Bartlett's Test
for Inequality of Population Variances, Kruskal-Wallis one-way analysis of variance (for two
ot more samples), and Mann-Whitney/Wilcoxon Two Sample Test. Located in the Statistics
folder.

TABLES

Use this command to create cross-tabulations of categorical variables. Tables can help
determine the probability that a risk factor is linked to an outcome. For these values to have
their accepted epidemiological meanings, the value representing presence of the exposure
(independent value) and outcome conditions (dependent variable) must appear in the first
row and column of the table. Epi Info yes/no variables ate automatically sorted. Values of the
first selected variable will appear across the top of the table, and those of the second selected
variable will be on the left margin of the table. Normally cells contain counts of records
matching the values in the corresponding marginal labels. For 2x2 tables, the command
produces odds ratios and risk ratios. For tables other than 2x2, Chi-Squared statistics are
computed. Chi square for trend tests for the presence of a trend in dose response or other
case control studies where a series of increasing or decreasing exposures is being studied. The
p-value is the probability that the association between two vatiables may be due to chance. A
low p-value of <.05 means the risk factor may be closely associated with the illness. Located
in the Statistics folder.
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Display Files

This command allows the display of table, view, and database information. You are going to
use it to view information about the variables in your current dataset and to determine which
variable to use as the Build Key when you merge your student records with the student
records from MS Excel.

1. Read/Import the Asthma Survey 2005 file located in your EIHA Tutorial folder.
You should still have 12 records. Remember that your Project and Data Source
need to match when you read in a file.

2. From the Command Tree window, click Display from the Variables folder. The
Display dialog box opens. You want to see Information for Variables From the
Variables Currently Available.

]

—Information for

............................

{+' Mariables: " \iews {" Tables

............................

From
--Variables currenthy available LI

Output to Table

Save Only OK

Clear Help Cancel

3. Click OK to accept the default settings. The Variables in the Asthma Survey 2005
project appear in the Output window.

4. Scroll through the variables listed.

= Display is an important command to use before importing data or
completing analyses on unfamiliar data. If needed, you could use this
information to format the cells in your spreadsheet prior to merging or
importing files. Display can alert you to potential errors in Analysis, for
example, assuring that variables are coded as the same field type.

* To see how the MS Excel file you are merging into the project is set up, you
can open the AsthmaTable file in MS Excel and view the data. Do not make
any changes to the file. Notice that the MS Excel and the Epi Info™ project
file both contain variables called StudentID. This field corresponds to both
sets of data and will be used to join the datasets. The spreadsheet does not
contain all the personal information collected in your Epi Info™ project.
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Values that do not correspond will appear as missing in Analysis. Be sure to

close MS Excel before beginning the merge.

Set Options

The SET command provides various options that affect the performance and output
of data in Analysis. These settings are used whenever the module runs. You want to
be sure that the Statistics setting is Advanced or the Risk and Odds Ratios may not

appear in your results.

1. From the Command Tree Options folder, click Set. The SET dialog box opens.

SET

YES as

Representation of Special Values

NO as

MISSING as

X

fres|

[v Show Graphics
[v Show Hyperlinks

=] [Mo

[v Show Complete Prompt

LI |Missing
[v Show Selection Criteria
[v Show Percents

v Show Tables in Output

-]

Statistics " None " Minimal
" Intermediate {« Advanced
[~ Include Missing
Process Records ¢« Normal {undeleted) " Deleted
" Both
Save All Save Only OK
Reset Help Cancel

2. Set your options as follows.

*  Yesas Yes

= NoasNo

= Missing as Missing

» All Show boxes selected

»  Statistics Advanced

* Include Missing not selected

»  Process Records as Normal (undeleted)
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3. Click OK

105



EPI INFO™ TUTORIAL

Merge Files

The current project contains 12 student records. In order to view all the available records for
the county, use the MERGE command to join the 12 records you created in Enter Data with
a larger data table gathered using MS Excel. Merge is only supported when the READ data
source is an Epi Info™ or MS Access table. The Merge data source can be of any type, for
this example, you will use the MS Excel spreadsheet called AsthmaTablexls located in the
EIHA Tutorial folder. A merge requires a Build Key that represents a matching variable
inside both sets of data. The MS Excel file used for this lesson has been formatted so that the
column headings and data types match the field names you created in Make View. You are
going to merge the files based on the Build Key StudentID. When you created the View, you
made StudentID a Required field. In our example, there are no duplicate values on the field
StudentID. Each record will have a unique value.

1. From the Command Tree window Data folder, click Merge. The MERGE
dialog box opens. Notice that the MERGE dialog box is very similar to the
READ dialog box.

* Be sure your current project is C:\Epi Info\EIHA Tutorial\Asthma Sutvey
2005.mdb.
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MERGE x|
Current Project
|C:1Epi_lnfo\ElHn Tutorial'Asthma Survey 2005.mdb
Data Formats
| Epi 2000 |
Data Source
[C:Epi_lMo\EIHA Tutorial\Asthma Survey 2005.mdb __'
—Show
{* \iews Al
\iews
hiewPrelnterventionSurvey
Key v Update v Append
< Jid|
Build Key Save Only OK
Clear Help Cancel

cleats.

. Click the Data Source Browse

opens.

spreadsheet.

. PFrom the Data Formats drop-down, select Excel 8.0. The Data Source field

button. The Merge File Name window

. Select the file called AsthmaTablexls located in the EIHA Tutorial folder.

. Click Open. The MERGE dialog box populates with information about the

. Click the Worksheet called SurveyData. The Build Key button activates.

= SurveyData is the named worksheet in the MS Excel file.
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MERGE x|
Current Project

IC:IEpi_Info'lEIHA Tutorial'Asthma Survey 2005.mdb

Data Formats
| Excel 8.0

=
Data Source
[C:Epi_lMo\EIHA TutoriallAsthmaTable.xlIs __j

Show
(G‘ Worksheets {" Named Ranges

Worksheets

<Specify>
W- b

Key v Update v Append

Build Key Save Only OK

Clear Help Cancel

7. Click Build Key. The RELATE-BUILD KEY dialog box opens.

»  Keep in mind that you need a variable that can be joined from the Current
Table that corresponds to the Related Table.

8. TFrom the Available Variables drop-down, select StudentID.
9. C(lick OK. The Cutrent Table field shows StudentID.
10. From the Available Variables drop-down select, StudentID.

11. Click OK. The Related Tables field shows StudentID.
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RELATE - BUILD KEY 8 X|

Key Component

Ly 5

Available Variables + I . I = |y I = I <| > I &I u | ( | )

| StudentiD | —
AND OR "Yes" “No" *Missing"

* Current Table(s) " Related Table

StudentiD StudentiD

Functions I

Clear | Help Cancel

12. Click OK to accept the Build Key designations. The MERGE window opens.

* The Update and the Append checkboxes should be selected. For matching records,
Update replaces the value of any field in the READ table whose build key matches
the MERGE table. For unmatched records, Append creates a new record in the
READ table with values only for those fields that exist in the MERGE table.

» For this merge, you want to Update and Append records, meaning that
records containing the same StudentIDs will be updated (overwritten) if there

is new information, and all other records will be appended (added) to the end
of the data table.

13. Click OK from the MERGE dialog box. The FILESPEC dialog box opens.
* Be sure the First Row Contains Field Names checkbox is selected.
14. Click OK. The READ dialog box opens.

* Because you are bringing a new data source into the project, you must decide
if you want to create a temporary or permanent link between the two sets of
data. For this exercise, you will be working with the 800 records for several
exercises so make the link permanent.

15. In the READ dialog box, type the link name AsthmaTable.
16. Click OK. The Record Count in the Output window reads 800.

= LIST the variables in a Grid.
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* Notice the first twelve records contain information from your survey. The
StudentIDs are the same, so the records were updated to reflect any changes.

= Use the Close X to exit the grid listing and return to the Output window.

* Notice that the Program Editor shows the commands used to create the

Merge and the List.

Create a Frequency

You are going to use the FREQUENCY command to get a count and view the 95%
Confidence Limits on selected variables. The FREQQ command produces a frequency table
that shows how many records have a value for each variable, the percentage of the total, and a

cumulative percentage.

The command FREQ * creates a table for each variable in the current view other than unique
identifiers. This command is often used to begin analyses on a new data set. To exclude
variables, use the All (*) Except checkbox and select variables to be excluded.

Since you just merged in new data, you want to develop some basic information and then

build up to more complex statistics.

1. From the Command Tree Statistics folder, click Frequencies. The FREQ dialog box

opens.
FREQ x|
Frequency of Stratify by
L | Frea [% ] | [
i_! i\ﬂ I~ &ll (*) Except
— | 37 |65%
Total| 57 | 100%
Weight
| =
Output to Table
settings | saveonty || oK |
Clear l Help | Cancel l

2. From the Frequency of drop-down, select SchoolNum.

3. Click OK The Frequency distribution of SchoolNum appears in the Output window.
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The Frequency column gives you the count of students per school. The Percent
column indicates the school's percentage of the total number.

The 95% Confidence Limits are a range of values for a variable that indicates the
likely location of the true value of a measure. In this frequency, the Confidence Limits
for School A are 21.6%-27.7% and the actual percentage is 24.5%, which falls within
the range.

Forward

lSchool Number |Frequency ]Percent lCum Percent !

A | 196 | 24.5% | 24.5% |

B | 205| 25.6% | 50.1% |

5 | 208| 26.0%) 76.1% |

D | 191) 23.9%  100.0%
|

800/100.0%  100.0%
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~ Practice

Answers to questions throughout Lesson 5 can be entered on the Tear Out Q/A Sheet
provided at the beginning of Lesson 5. Each of the variables used in the following frequencies
were created in the original survey in Make View.

A. Are there more males or females in the survey population?

Hint: Create a Frequency of Gender to find out.

B. Which condition has the highest frequency?

Hint: Create a Frequency of Asthmatic Conditions. Notice you get four tables, one for
each condition.

C. Which month had the highest number of students with breathing
difficulties?

Hint: Create a Frequency of WMonth.
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Stratify a Frequency

Frequency tables can be stratified or grouped by a selected variable.

D. Which school had the highest frequency of students with bronchitis?

1. Click Frequencies. The FREQ dialog box opens.
2. From the Frequency of drop-down menu, select Bronchitis.

3. From the Stratify By drop-down menu, select SchoolNum.

4. Click OK. You will get four tables containing the frequency of bronchitis per school.

< Practice

E. Which gender has the highest frequency of Asthma?

Hint: Create a Frequency of Asthma stratified by Gender.
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Select Variables for a Frequency

You can use the SELECT Command to specify a subset of students and then create a
frequency for only those records. You are interested in discovering how many students have
Reactive Airway Disease and if they are currently taking medication for the condition.

F. How many students answetred Yes to having Reactive Airway Disease?

G. What is the percentage of students with Reactive Airway Disease that have
been prescribed medication?

1

. Use the SELECT command to view those who answered Yes to having Reactive Airway

Disease. (Hint: RAD="Yes")

2. Create a Frequency of students who have been prescribed medication (Hint: Frequency
of Medication)

3. Click Cancel Select to return to the original 800 records.

~ Practice

H. Which zip code has the most surveyed students living in it?
Hint: Create a frequency of zip code (variable Zip).

I.  Of that zip code, which condition had the highest frequency?

Hint: Use SELECT to view only those students living in zip code area 12046. (Zip Code
is a text field. Text fields must be surrounded by quotes when used in commands
Zip="12046")

Create a frequency of Asthmatic Conditions.

Remember to Cancel Select.
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Skills Review
Record the following results on the Tear Out Q/A Sheet.

J.

How many students answered Yes to all four conditions: Asthma, Reactive Airway
Disease, Bronchitis, or Wheezing.

Based on all four conditions and zip code, are the conditions evenly distributed
among the survey population?

Does one school have more students in affected zip codes and with all four
conditions than the others do?

You want to find out how many children from the survey responded Yes to all the
asthmatic conditions. Then you want to find out if the affected students are concentrated
to one zip code or one school.

Select the students who had all four conditions.

Hint: Use the SELECT command to ctreate the code below. You need to select the
students who answered Yes to Asthma and Yes to Bronchitis and Yes to RAD and Yes
to Wheezing,

SELECT Asthma= (+) AND Bronchitis= (+) AND RAD= (+) AND Wheezing=
()

Create a Frequency of Zip Code.
Create a Frequency of SchoolNum.

Cancel Select to return to the original 800 records.
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Create a Means

M. What was the most frequent number of missed days?

N. What is the Mean (average) number of days missed due to asthmatic conditions?

One of the items you want to include in the funding request is the simple means of the
number of days children missed school due to asthma or an asthma related condition. The
MEANS command will give you the frequency and the means results.

The MEANS command can be used to get an average for a continuous variable. The mean of
a yes-no variable is the proportion of respondents answering yes. The MEANS command has
two formats. If only one variable is supplied, the program produces a table like that produced
by FREQUENCIES, plus descriptive statistics.

If two variables are supplied, the first is a numeric variable containing data to be analyzed and
the second is a variable that indicates how groups will be distinguished. The output of this
format is a table like that produced by TABLES, plus descriptive statistics of the numeric
variable for each value of the group variable.

1. From the Command Ttree Statistics folder, click Means. The MEANS dialog box opens.

MEANS x|
Cross-tabulate by Value of Stratify by
Means of
[~ | A
Weight LN ILL
[ ~] HEIGHT | + |— |
620 | 20|40
625 | 37| 69 % 7
——— Optional Page Settings
Output to Table ,_ Columns per Page
[ No Line Wrap
Settings | saveony | oK |
Clear Cancel |

2. From the Means Of drop-down menu, select the variable MissDays.

3. Click OK. The Output window populates with the results. The table results show a
breakdown of missed days aggregated per answer.
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i[sm??ny days of school has your child missed due to Feetioncy [Peceunt S:::lent ‘
0 [ 8 1.0%] 10%)
i [ 241 30.1% | 31.1%|
2 [ 233| 29.1% | 60.3% |
3 [ 59| 7.4%)| 67.6% |
4 | 65| 81%|  758%)
5 [ 8 10%|  768%]
6 l 17) 21%|  78.9%|
[7 [ 23| 29%)| 81.8%
8 [ 29| 3.6%)| 85.4% |
9 [ 24| 3.0%)| 88.4% |

. Scroll down to see the Mean and Standard Deviation results.

Obs  Total IMean Vanance Std Dev
800 3014.0000 3.7675 13.5379 3.67%4
Minimum  25% Median 75% Maximum Mode
0.0000 1.0000 2.0000 4.0000 15.0000 1.0000

»  Variance- A measure of the dispersion shown by a set of observations.

» Standard deviation- A statistical summary of how dispersed the values of a variable

are around its mean.

* Standard error (of the mean) - The standard deviation of a theoretical distribution of

sample means of a variable around the true population mean of that variable.

*  See Appendix H: Glossary for more definitions, or visit the source at

(http:/ /www.cdc.gov/excite/library/glossary.htm).
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Use the Means Command with a Cross-Tabulated Variable

O. Which school had the highest average of missed days?

To determine which school had the highest average of missed days, you need to compute the
means of missed days by school. Use a cross tabulation variable to compute statistics showing
the likelihood that the means of the groups are equal.

1. Click Means. The MEANS dialog box opens.

2. Sclect the Means Of Variable MissDays.

3. Select the Cross-Tabulate by Value Of Variable SchoolNum.

4. Click OK Results appear in the Output window.

5. Scroll to the Descriptive Statistics. Notice the Mean is computed by School.

Descriptive Statistics for Each Value of Crosstab Variahle

Obs Total Mean Vanance Std Dev

A 196 815.00004.1582 14.5543 3.8150

B 205 813.0000 3.9659 13.8371 37198

C 208 786.0000 3.7788 13.6610 3.6961

D 181 600.0000 3.1414 11.658% 3.4145
Minimum 25% Median 75% NMaximum Mode
0.0000 1.0000 2.0000 7.0000 15.0000 1.0000
0.0000 1.0000 2.0000 6.0000 15.0000 1.0000
0.0000 1.0000 2.00004.0000 15.0000 2.0000
1.0000 1.0000 2.0000 3.0000 15.0000 1.0000

g0 QW=
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Create a Stratified Means

P. Was the school with the highest average of missed days for males the same as the school
with the highest average of missed days for females?

Use the Means command with Stratify By to group your data by gender.
1. Click Means. The MEANS dialog box opens.

2. Sclect the Means Of Variable MissDays.

3. Select the Cross-Tabulate by Value Of Variable SchoolNum.

4. Seclect the Stratify By Variable Gender.

5. Click OK. Results appear in the Output window.

= Two tables and two sets of descriptive statistics are created, one for female and one
for male.

6. Scroll through the results.
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Use Select with the Means Command

Q. Is the average number of missed days higher among those who answered Yes to asthma
than the overall average? Refer to Question N.

You can use the SELECT Command to create subsets of data and then use the MEANS
command to create statistics.

1. Click Select. The SELECT dialog box opens. Use the SELECT Command to display
only those students who answered Yes to Asthma.

2. From the Available Variables drop-down, select Asthma.

3. Use the Functions and Operators buttons to create the code Asthma=(+) in the Select
Criteria field.

4. C(lick OK. You should have 91 records.
5. Create a Means of Missdays.

6. Click Cancel Select to return to the original 800 records.
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Skills Review

R. What is the average age of the student population?

The age field for the imported data has not been populated. You need to assign a code to
populate this field. The variable Age did not exist in the MS Excel data that you merged. You
do have a date of birth; however, so you can compute the age by using the YEARS function
as you did in the Check Code lesson.

From the Command Tree Variables folder, click Assign. The ASSIGN dialog box opens.
From the Assign Variables drop-down, select Age.

In the =Expression field type your code. This is the same code you used to create the age
field Check Code in Make View.

Use the Years function and then create your mathematical code: Survey date minus date of
birth variable.

Age= YEARS(DOB, 10/25/2005)

Click OK. The code appears in the Program Editor.
List the Age variable in a grid.

All the once missing fields should now contain ages.

Create a Means of Age.

Create a Table

S. Does one school have a higher number of students with asthmar

T. Which school has the highest number of students with Wheezing?
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You are going to use the Tables command to examine the relationship between two or more
categorical values. You want to further explore the idea that there may be a connection
between school location and asthmatic conditions. You are also interested in seeing what
kinds of results you can get with the 800 student records available to you as a primary data

source.

1. From the Command Ttree Statistics folder, click Tables. The Tables dialog box opens.

TABLES

Outcome Variable

Stratify by

!
B AN

Exposure Variable

|

|~ Matched Analysis

Weight R ILL
I LI HEIGHT | + |—
620 | 2040
625 | 37| 59 ¢ 7
Optional Page Settings
Output to Table I— Columns per Page
[” No Line Wrap
Settings | saveonty || oK |
Clear | Help | Cancel |

2. From the Exposure Variable drop-down, select SchoolNum.

3. From the Outcome Variable drop-down, select Asthma.

4. Click OK. Results appear in the Output window.
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ASTHMA
School ID #| Yes | No TOTAL
Al 29 167 196
Row% | 14.8| 852 100.0
Col% | 319 236 245
B| 25 180 205
Row% | 12.2| 87.8| 100.0
Col%| 27.5| 254| 256
C| 21| 187| 208
Row% | 10.1| 83.9| 100.0
Col%| 23.1| 264 260
D| 16| 175 191
Row%| 84|916 1000
Col%| 17.6| 247| 239
TOTAL| 91| 709 800
Row% 114|836  100.0
Col % |100.0|100.0| 100.0

5. Create the same table, but select Wheezing as the Outcome Variable.

LESSON 5
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Create a 2x2 Table

U. How many students had both Asthma and Wheezing?

V. What are the odds that you have the condiion Wheezing if you have the condition
Asthma?

For 2x2 tables, the Tables command produces odds ratios and risk ratios. You want to
determine if there a correlation between the children who have asthma and those with
wheezing.

1. Click Tables. The TABLES dialog box opens.
2. Seclect the Exposure Variable of Asthma.
3. Select the Outcome Variable of Wheezing.

4. (Click OK

Forward
WHEEZING .

\Asthma | Yes | No |TOTAL

Yes, 63 28 91
Row% 692 30.8| 100.0
Col% | 63.6| 4.0 114

No| 36 673 709
Row% | 5.1 94.9| 100.0
Col% | 36.4| 96.0 88.6

TOTAL | 9% 701 800
Row% | 124| 87.6 100.0
Col % 100.0/100.0 | 100.0

* Notice the graphic representation of your results.
= A 2x2 table was created because each variable had a yes or no answer.

» The largest square represents the children who answered no to both wheezing and

asthma.

5. Scroll down to view the Single Table Analysis.
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Single Table Analysis

Point 95% Confidence Interval

Estimate Lower Upper

, P S: Odds-based
2 QOdds Rapiolcross product) 24.0911 734400 (m)
Odds Ratio (MLE) 41.5616 23.9981 735508 (m

232358 76.3616 (F)
PARAMETERS: Risk-based
Risk Ratio (RR) 13.6346 96419 19.2806 (T)
Risk Difference (RD%) 64.1532 545335 73.7729 (T)

(T=Taylor series; C=Cornfield; H=Mid-P:; F=Fisher Exact]

STATISTICAL TESTS Chi-square 1-taled p 2-talled p

Chi square - uncorrected 306.0983 0.0000000000
Chi square - Mantel-Haenszel 305.7157 0.0000000000
Chi square - corrected (Yates) 300.2107 0.0000000000
Mid-p exact 0.0000000000
Fisher exact 0.0000000000

Odds Ratio- A measure of association that quantifies the relationship between an
exposure and health outcome from a comparative study; also known as the cross-
product ratio.

Risk Ratio- A comparison of the risk of some health-related event such as disease or
death in two groups.

Chi Square- A test of statistical significance that is used to determine how likely it is
that an observed association between an exposure and a disease could have occurred
due to chance alone, if the exposure was not actually related to the disease.

See the Appendix H: Glossary or Appendix I: Data Sources for definitions and links
to more information on interpreting statistics.
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» Skills Review
Complete the following:

W.

Is the Odds Ratio for Bronchitis and Reactive Airway Disease lower or higher than
Asthma and Wheezing? Refer to Question V for the Odds Ratio for Asthma and
Wheezing.

Hint: Create a 2x2 table for Bronchitis Exposure and RAD Outcome.

How many children with the condition wheezing were prescribed medication? From
those results, what is the Risk Ratio?

Hint: Create a 2x2 table for Medication Exposure and Wheezing Outcome.

Is the Risk Ratio for being prescribed medication for the condition asthma higher or

lower than being prescribed medication for wheezing? Compare the results to Question
X.

Hint: Create a 2x2 table for Medication Exposure and Asthma Outcome.

Are the risk ratios for Asthma and Wheezing higher for children under 10 than they are
for the survey population as a whole? Compare to the results from Question V.

Select the children who are less than age 10. (Hint: Select Age<10)

Be sure that the Age field is calculated for all records. If you have use the READ
command to bring in a new file or program or closed Analysis, then you will have to
calculate the Age field as you did for the MEANS exercise.

Create a table for Asthma Exposure and Wheezing Outcome.

Click Cancel Select.
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Saving a Program

Notice the large amount of code in the Program Editor. In order to re-create the same
statistics after data has been added, you want to save the program or code. By doing so, you
can run these same statistics on the new records.

Analysis automatically saves the last program created in the program editor in a file called
LastPGM. This file is created and saved in the Epi_Info folder and gets overwritten each time
a new PGM is created and the application is closed. You want to create your own program
based on your data.

1. From the Program Editor, click File>Save. The Save Program dialog box opens.

Soveprogam ]
Project File

lt:lEpi_lnfolElHn Tutorial'Asthma St

Program

Author Comments

Date Created

Date Updated -

| <] :

Change Project Delete OK
Text File Help Cancel

* The Project File field contains the information about where you will be saving your
file. You want to leave this information set to the EIHA Tutorial folder.

2. In the Program Field, type Lesson 5.
3. In the Author field, type your initials.
4. In Comments, type EIHA.

5. Click OK.

* The date created and date updated fields will be populated with new information each
time you open the program.

6. Click Exit to close Analysis.
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Test the Saved Program

1.

2.

Open Analysis.

From the Program Editor, click File>Open. The READ dialog box opens.

From the Program drop-down, select Lesson 5.

Click OK. Your saved program appears in the Program Editor.

Select Edit>Program Beginning.

Click Run This Command. The first command inside your program runs. The first
command was Read, so your 800 records appear. If you had updated records, the new

information would be reflected in the results.

*  You can run any previous commands by placing your cursor in the command and
clicking Run This Command.

Click Run to run the entire program.

» The program you saved is part of your project, to keep it updated you must save it.
To access the LASTPGM file, click the Text File button from the Save Program
dialog box and locate the file in the Epi_Info folder.

= Do not close Analysis if you plan to complete Lesson 6 at this time.
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Lesson Complete!

WHAT YOU LEARNED

How to

®  Use the DISPLAY command to view vatiable types in your project.
®  Merge an MS Excel file into an Epi Info™ project.

= Use the FREQ command to see how your data is distributed.

®  Use the MEANS command to see if one set of data is equal to the sum of the
data divided by the number of items in the data set.

= Use the TABLES command to see if risk factors are linked to outcomes.

= Save Program (PGM) files for use with later data tables or updated data.
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Analysis: Epi Graph

SUMMARY

This lesson is an introduction to the Epi Graph module of Analysis. In this lesson, you will
create and customize several types of graphs using the survey data including, bar, pie, and line.
You will also export a graph as an image. Results created in Epi Graph can be used in reports
later to present your findings as graphic representations.

Based on the survey data, many types of graphs could be produced to illustrate the need for
funding. In this lesson, you will create graphs to illustrate age groups, missed days by gender,
and the worst month for asthmatic conditions by school. For the asthma funding report, you

will be creating a pie chart to illustrate which month is the worst month for asthmatic
conditions based on data from the children surveyed.

You must have the Lesson5.PGM open and run prior to completing this lesson, as the code
created in the previous lesson affects these graphs.

Length of time to complete: 2 hours Beginner
Graph Types

Overview of the types of graphs created in this lesson and how to use the GRAPH dialog
box to make graph type selections.

Create a Bar Graph
Use the GRAPH command to create a bar graph for the Age variable.
Create a Pie Graph

Use the GRAPH command and the Customization dialog box to create a Pie Graph of the
worst month for asthma. This graph will be exported and used in Lesson 10 Epi Report.

Export a Graph

Use Epi Graph to export a graph as an image for use in later reports and presentations.
Create a Rotated Bar Graph

Use the GRAPH command to create a rotated bar graph of missed days of school by gendet.
Plot a New Graph Type

Use the Customization dialog box to change a bar graph into a line graph.
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Create a Stacked Bar Graph

Use the GRAPH command to create a stacked bar graph of the worst month for asthmatic
conditions by surveyed school.

Skills Review

Series of five review questions based on the reading and hands-on activities in this lesson.

BEFORE YOU BEGIN

Complete Lesson 4 Analysis: Basics.

Complete Lesson 5 Analysis: Creating Statistics.

WHAT YOU NEED

Asthma Survey 2005.MDB

Lesson 5.PGM

FIVE GOALS

Create a bar graph containing the ages of the children in the survey population.

= Create a pie graph of the worst month for asthmatic conditions and export it to be used
in a later lesson.

= Create a rotated bar graph of missed days of school by gender.
®  Create a stacked bar graph of worst month for asthmatic conditions by school.

®  Use the Customization dialog box to plot new graph types and edit your graphs once
created.
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Graph Types

From the Analysis module, you will use the GRAPH command to create graphical
representations of your data. From the Graph dialog box, you will select a Graph Type, an X-
Axis variable, a Y-Axis variable, and a Series variable by using the corresponding drop-down
boxes.

x|
Graph Type 1st Title | 2nd Title
Template Q

.

g

e . ,
Main Variable(s) Show Value Of 'y Bar for Each Value of

3 -
| - )| - gEI

TN

- okl Greoh for SUBsegUst ~ Multiple Graph Settings
overlay [~ Multiple Graphs per Page
~Show preview window
[v During interaction
[~ When running PGM
Browse | saveony || oK |
Ger | b | cowa |

The following graph types will be created in this lesson:
BAR

Bar Graphs are used to group data together according to categories and display a bar for each
value in that category. Bar lengths represent quantities in a set of data. Bars are color-coded
according to the seties represented and displayed vertically.

ROTATED BAR

Rotated Bar Graphs are bar graphs with horizontal bars representing the count or weight of
each value of the main variable(s).

STACKED BAR

Stacked Bar Graphs are created in the same manner as non-stacked bar graphs, except that
the Y values from each series accumulates. Bars are stacked on the end of the previous bar
with each separate series color-coded.
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AREA

Area Graphs display data sets on X-Y axis with the area under the line filled.
SPLINE

Spline Graphs have values indicated by points connected with a smooth curve.
POINT

Point graphs contain data indicated by a marker for each data point.

LINE

Line graphs are used to determine trends and cyclic variation based on interaction of data
elements. Data points are plotted on the graph and connected with lines. Line graphs can
display large amounts of data that varies along some accepted sequence such as time,
temperature, price etc. Line graphs with multiple lines can be used to display several variables
to conserve space and to facilitate comparison of more than one dependent variable on a
single independent scale. Line graphs must have numeric variables for both X and Y-axes and
the X variable values are treated as continuous. To generate a line graph utilizing categorical X
variables, use the Bar graph command and then customize the graph style to Line.

PIE

A pie graph is a circular graph used for proportional assessment by comparing data elements
such as percentages or counts against other data elements and against the sum of the data
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You must have the Lesson5.PGM open and run prior to completing this
lesson, as the code created in the previous lesson affects these graphs.

Create a Bar Graph

Use bar graphs to make comparisons of single events and the differences between them. To
visually present the age distribution of the survey population, you will create a bar graph of
the Age variable.

1. From the Command Tree Statistics folder, click Graph. The Graph dialog box opens.

GrapH x|

Graph Type 1st Title | 2nd Title
[Bar] .l
[~ 3D Template
X-AXIS Y-AXIS SERIES
Main Variable(s) Show Value Of Bar for Each Value of
| | [count =] #
Weight Variable One Graph for Each Value of

! ||| 3

—Multiple Graph Settings
r Hold graph for subseguent
overlay [~ Multiple Graphs per Page
Show preview window
v During interaction
[~ When running PGM
Browse | Save Only | | OK I
Clear | Help | Cancel |

* The default graph selection is Bar.
2. From the Main Variable drop-down menu, select the X-Axis value of Age.
3. Click OK. Epi Graph opens.

*  You may need to click the flashing Epi Graph icon from the task bar.
4. View the bar graph.

* Be sure that the Age field is calculated for all records. If you have READ in a new file
or program or closed Analysis, then you will have to calculate the Age values. Age
fields should be coded, if you have the Lesson5.PGM open and run from the
Program Editor.
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. Click the Close X. The bar graph is now embedded in the Output window and part of
your output file.

Your graph should look like the following:

N i

File Edit Yiew Help
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Create and Customize a Pie Graph

Create a Pie graph that illustrates the worst month for asthmatic conditions. In the survey
parents were asked which month presented the most breathing problems for their child based
on their symptoms. To illustrate your findings, you will create a pie graph on the WMonth
variable.

1. Click Graph. The Graph dialog box opens.

2. From the Graph Type drop-down, select Pie.

3. From the Main Variable drop-down, select WMonth.

4. Click OK. The WMonth Pie Graph appears.

5. From the main navigation bar, select View>Customization, or use your mouse to right

click inside the graph and select Customization Dialog from the pop-up menu. The
Customization dialog box opens.

51

General I Font I Color | Style I
Main Title: —Data Label Type
| (¢ Percentage { Yalue
Sub Title: — Group Percentages
f'w/Month " No Grouping
~Viewing Style ——————————— % 1% and Under
' Color ¢ Monochrome " 2% and Under
; (" 3% and Under
— Font Size 4% s Urd
" Large  Med ¢ Small Sl
" 5% and Under
— Numeric Precision
A e ST TR —3D
{¢ 0ff ¢ Shadow " 3C

| oK I Cancell Spply | Export... l Maximize...l

= Each tab inside the Customization dialog box allows you to change a part of your
graph and how it is viewed on the page.

6. From the General tab, in the Main Title field, type Worst Month for Asthmatic Conditions.
7. Declete the text Wmonth from the SubTite field.
8. Seclect the 3D radio button.

9. Click Apply. The graph updates.
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10. Click the Font tab.

11. Select a new font for your title.

12. Make the title Bold.

13. Click Apply. The title font updates.

14. Click OK to close the Customization dialog box.

15. From your graph, left click on the number 9. The Point Label dialog box opens.

Enter Point Label

OK

LCancel

16. Type the month name Seprermber and click Ok.

17. Name each Point Label for the month with which it corresponds.

Your pie graph should look similar to the following:

R

File Edit View Help

WORST MONTH FOR ASTHMATIC CONDITIONS

November 6.7%
December 3.6%

18.6% October
February 7.7%

March 6.7%

4.6% January
April 5.7%

May 5.2%

June 5.7%
24.2% September

July 5.7%

August 6.7%
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Export a Graph

Now you are going to Export the WMonth pie graph for use in another program. Graphs can
be exported for use in other programs such as MS Word, PowerPoint, or Epi Report. You
will be using the WMonth pie graph in Lesson 10 Epi Report when you create your asthma
Initiative report.

1. From the Epi Graph main navigation menu, select File>Export. The Exporting dialog

box opens.
%
— Export
¢ MetaFile ¢ BMP " Text / Data Only

— Export Destination

* ClipBoard

" File  Browse |

" Printer

~ Object Size
_ Cancel |

¢ No Specific Size © Milimeters C Inches € Points

Width: |1 000 / 685 Units

Cancel

2. From the Export section, select BMP to create a bitmap file.

3. From Export Destination, select File.

4. Click Browse. The Save As dialog box opens.

5. Locate the EIHA Tutorial folder. Name your file WMonthPieGraph.
6. Click Save.

7. TFrom the Exporting dialog box, click Export.

8. Close Epi Graph.

*  You will use the exported graph in the Epi Report lesson.
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Create a Rotated Bar Graph

In this section, you want to illustrate the number of missed days of school by gender. This will
help in determining whether there is a difference in how much school is missed based on the
gender of the survey population.

1.

2.

3.

Click Graph. The GRAPH dialog box opens.

From the Graph Type drop-down menu, select Rotated Bar.

For the Main Variable drop-down, select MissDays.

From the SERIES Bar for each Value of drop-down, select Gender.
Click OK. Epi Graph opens.

*  Your Rotated Bar graph should look similar to this example:

REE
File Edit Yiew Help
F | Mal
emale ale
COUNT

Cl) 10 20 30 40 50 60 70 80 90 100 110 120

| | | | | | | | | | | |
rrrrrrrrrrrrrrrrrrr T rrrr Tt Tt T T e i T T T T T T I T i T T T T T TTTT

MissDays

From the Epi Graph navigation bar, select View>Customization. The Customization
dialog box opens.

From the General tab, type the Main Title Mizssed Days by Gender.
From the General tab, select the Font Size Small radio button.

From the General tab in the Grid Lines section, select Y.
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10. Click Apply.

11. Click OK. Do not close Epi Graph.

File Edit Yiew Help

=10l x|

Female

Missed Days by Gender

COUNT
60 70

Male

MissDays
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Plot a New Graph Type

You can change a bar graph with categorical X values into a line graph by using the
Customization dialog box. You are going to use the rotated bar graph from the previous
lesson and view it in a different format.

1.

9.

From the Epi Graph navigation bar, select View>Customization. The Customization
dialog box opens.

Click the Plot tab.
From the Plot Style selection, select Line.
Select the Mark Data Points check box.

Click Apply. The rotated bar information is transformed into a line graph.

[HEpi Graph =10l x|

File Edit View Help

Missed Days by Gender

Female Male

[
=1

=]

=}
(=}

©
=]

f=]
=)

=
o

COUNT
@
=}

(43}
(=)

5
(=]

]
(=]

=N

/ \

20 ¥
/‘\

10 { \\ ._/y_.,/<:’\ \:\ﬁ(‘_____..\ e

{ %/ v,“‘\'}(‘\
0

0 1 2 3 4 5 B 7 8 a 10 11 12 13 14 15

MissDays

Click the Points tab, select the Point Label Orientation, Slanted.
Click Apply.
Click the Style tab.

Select Female and from the Point Type drop-down, select the solid diamond.

10. Select Male and from the Line Type drop-down, select the small blue dotted line type.
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11. Click the Burgundy color box.
12. Click Apply.
13. Click OK.

14. Close Epi Graph.
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Create a Stacked Bar

To determine if one school had more students with breathing problems in any given month
than the others, you can create a stacked bar of the WMonth variable with a series bar for
each value of SchoolNum. This will show you, for example, that School A did not have any
students who answered that their worst breathing month was December.

1. Click Graph.

2. From the Graph Type drop-down, select Stacked Bar.

3. From the Main Variable drop-down, select WMonth.

4. From the SERIES Bar for Each Value, select SchoolNum.

5. Click OK. Epi Graph opens. Notice that the months are not in sequence by month, but
by the first digit of the number. In Lesson 7 Exporting Files, you will use the RECODE

command to re-order the months to appear in the proper sequence.

Your stacked bar graph should look similar to the following:

C1 | L .
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6. Right click the graph and select Customization Dialog from the pop-up menu.
7. Click the Plot tab.

8. From the Plot Style section, select Points and Spline.
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9. Click Apply.

10. Click OK.

The same worst month information is now presented in a Points and Spline format.
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11. Right click the graph and select Customization Dialog from the pop-up menu.

12. Click the Plot tab.

13. Select Area Stacked.

14. Click Apply.

15. Click OK.

The same worst month information is now presented in an Area graph format.

16. Close Epi Graph.
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Skills Review

Place a checkmark next to the correct answer for each of the following questions. Refer to
Appendisc D Skills Reviews Answer Key for further details.

1. You can use a Line Graph to determine trends and cyclic variation.

[ JTrue
[ ]False

2. Which type of graph presents a circular proportional assessment by comparing data
elements such as percentages or counts against the sum of the data elements?

[ Line Graph
[ |Bar Graph
[|Pie Graph
3. From Epi Graph, select the two ways you can open the Customization dialog box.
[ Right click and select Customization Dialog from the pop-up menu
[ ]Select View>Customization
[ 1t automatically opens

4. Graphs can be exported for use in other programs, such as MS Word, PowerPoint, or
Epi Report.

[ JTrue
[ JFalse

5. You can plot a new graph type from an existing graph using the Customization dialog
box.

[ JTrue
[ JFalse
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Lesson Complete!

WHAT YOU LEARNED

How to

® Create a Bar, Pie, Rotated Bar, and Stacked Bar Graph to illustrate statistical
findings.

=  Export a Graph for use in another program or for a presentation.

®  Use the Epi Graph Customization dialog box to create graphs specific for your
project or plot a new graph type.
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Analysis: Exporting Files

SUMMARY

This lesson focuses on ways you can export files or data from Epi Info™. In this lesson, you
will create two new graphs and learn ways to RouteOut and Write/Export files for use in

other programs. This lesson also includes advanced coding, graphing, and an introduction to
the command RECODE.

The RECODE command allows you to create groups, transform code from one system to
another, change variable values, and create new values for variables. You will use RECODE
to re-order the variable WMonth to appear in a school year sequence.

In this lesson, you will also use the WRITE command to create a new data table that contains
selected information from the survey records. This new data table will contain information
selected by age and symptom. The new data table will be used to create a line graph that maps
all symptoms on one graph by age, so that you can look for trends in symptoms based on age.

Length of time to complete: 2 hours Intermediate
Managing Data

Overview of export types and commands covered in this lesson. Also describes and discusses
the creation and storage of output files from the Analysis module.

Use Header, PrintOut, and RouteOut Commands

Use the HEADER, PRINTOUT, and ROUTEOUT commands to customize Output
window results and to print results from the Output window.

Use Define and Recode

Use DEFINE to create new variables and RECODE to assign values to create a graph with
re-ordered dates based on the survey variable WMonth.

Use the Write Command
Use the WRITE command to create a new data table for specified vatiables.
Write and Append a Data Table

Use the WRITE command to create a new table containing specified variables. Use the new
data table to create a graph.
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Write to MS Excel
Use the WRITE command to export your data to an MS Excel file.
Skills Review

Series of ten review questions based on the reading and hands-on activities in this lesson.

BEFORE YOU BEGIN

Complete Lesson 4 Analysis: Basics.
Complete Lesson 5 Analysis: Creating Statistics.

Complete Lesson 6 Analysis: Epi Graph

WHAT YOU NEED

Asthma Survey 2005.MDB

Microsoft Excel

FIVE GOALS

Understand and be able to view output files created by Analysis.

Use the RECODE command to define a variable.
®  Use the WRITE command to place selected variables in a new data table.

= Use the format commands NUMTODATE and TXTTONUM to assign and format a
date variable.

=  Use the WRITE command to export to data to an MS Excel file.
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Managing Data

Information gathered and analyzed in Epi Info™ can be exported to other formats and used
in other programs. In this lesson, you will manage data in three ways.

1. You will use the HEADER command to customize and then print data from the
Analysis Output window.

2. You will use the ROUTEOUT command to designate a new Output file. In this lesson,
you will create a new graph of Worst Month for Asthma and send it to the new file. This
lesson also introduces the RECODE command.

3. You will use the WRITE command to do three kinds of exporting:

» Export and create a new data table to save a temporary value as a permanent value.

» Export selected data to a new table and use the new table to create a line graph of
symptoms by age.

= Export the selected variables and new data to an MS Excel file.
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Commands in this Lesson
HEADER

The Header command sets up specific headings that appear in the Output window until a
new file is Read into Analysis. Located in the Output folder.

ROUTEOUT

The RouteOut command directs the output to the named file until the process is terminated
by Closeout or by exiting Analysis. RouteOut creates an HTML document that can be read
by any browser. Located in the Output folder.

CLOSEOUT
The CloseOut command closes the current output file. Located in the Output Folder.

PRINTOUT

The Printout command sends the current output file, or some other file specified by you, to
the default printer. Located in the Output folder.

WRITE

The Write/Export command sends records to an output table or file in the format that you
specify. Use this command to write your files to a new data type such as MS Excel or a text
file. Located in the Data folder.

DEFINE
The Define command allows you to create new variables. Located in the Variables folder.
RECODE

The Recode command allows grouping of data for age and other variables, or transformation
of coding from one system to another. You can use this command to change some or all
values of a vatiable. The new values can be stored in the same vatiable or in a new one.
Recode can convert a numeric variable into a character vatiable or the reverse, or create a2 new
variable based on recoded values of an existing variable. Located in the Variables folder.

ASSIGN

The Assign command stores the value of a variable, or assigns the result of mathematics to a
variable. Located in the Variables folder.

GRAPH

The Graph command produces various graph types based on data and selections. Located in
the Statistics folder.
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STORING OUTPUT

The Storing Output command allows a change of the default settings for storing output files.
Located in the Output folder.
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Output Files

Each time you read a file into Analysis and run a command, you create an Output file. The
Output appears in the Output window and in the Output file inside your project directory.
Output files are stored in the directory of the current project with a name composed of a
prefix and a sequence number, the default is OUT#.htm, for example, C:\Epi_Info\EIHA
Tutorial\OUT120.htm. The name, number, and destination of your Output files can be
changed using the Storing Output command. From the Result Storage dialog box, you can
change the file prefix, sequence number, and location of output.

Resutstorage ]
Output File Prefix Output File Sequence
jourt {100]
Results Folder
[C-Epi_InfolEIHA Tutorial g View | Archive |
Archive Folder
|C:\Epi_Info'EIHA Tutoriall ® Delete | Browse |
Flag output files exceeding these limits
Age in Days Number of Results File Size (KB)
[20 100 [s00
Help | Close oK

The output of a single statistical procedure is called a result. Results accumulate in a given
results index file called IResults.htm, located in the project directory. If several projects share
the same directory, they share the same results index. Results continue to populate this file
until the data source changes by READ, RELATE, SORT, SELECT, or SET PROCESS, or
until a CLOSEOUT command is executed.

When Epi Info creates the Out#.htm file, it also creates a corresponding Out#.xml file.
Out#.htm files are stored for reference purposes. Out#.xml files are stored for use in the Epi
Report module.

When Output files are created, the name and location of the file appears in the Output
window title bar as a reference. Outputs are added to the same file until the data source is
changed.

When you create an Output file, you will see the location and name of the file in the title bar
at the top of your window.

C:\Epi_Info'EIHA Tutorial\OUT141.htm
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View Output Files

Each task you complete in Analysis creates results which appear in the Output window and in
the Out#.htm file. Now view the Output files you have created so far.

1.

2.

Open the Analysis module.

From the Output window button bar, click Open. The Browse dialog box opens. It
should be open to your destination folder, EIHA Tutorial.

| 4| 1 @@ém‘

Previous MNext Last History Open _ﬁookmark Print Maximize

» Notice the list of OUT#.htm files in your folder.
Select one of the OUT files.

Click Open. The file opens in your Output window.
= This is the saved reference output you created.

» Notice the Program Editor does not update, as you are not running a command, only
viewing data.

From the Output window button bar, click Open.
Select IResults.htm.
Click Open. The Results Library appears.

* The IResultshtm file in your directory and the Results Library link inside active
output windows, open the same file.

* In the Command column, you will see a list of blue hypetlinks.

» (lick a link to view the results.

= This is another way to view previous Output for reference.
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Use the HEADER Command

You are going to customize the Output window using the HEADER command to label
results. Customizing Analysis Headers is useful if you will be creating long lists of code that
need to be labeled for specific project files, uses, or data tables.

1. From the Command Tree Output folder, click Header. The HEADER dialog box
opens.

HeapER x|

Title Option
‘—(: Set Text or Font (" Reset Title {" Remove Last Line

Title I____ine
| 2 File Title z| [~ Append Text

Title
I.S‘jhool Survey Data|
41

[~ Bold [ Htalic [~ Underline
Font Size Font Color
I Elll =
saveonly | oK
Clear Help | Cancel

2. From the Title Line drop-down, select 2 File Title.
3. In the Title Field, type School Survey Data.

4. From the Font Size drop-down, select +3.

5. From the Font Color drop-down, select Blue.

6. Click OK. The Output window appears.

* The header code appears in the Program Editor, but it is not applied until you
Read/Import a file.

7. Click Header. The HEADER dialog box opens.
8. From the Title Line drop-down, select 3 Data Source Title.
9. In the Title Field, type School Year 2004-2005.

10. Select Bold.
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11. Select Italic.
12. Click OK.

13. Read/Import your Asthma Survey 2005.mdb. Be sure the project and the data source
match. If not, click Change Project and select the Asthma Survey 2005 project.

14. Click OK.
= Header information stays in effect until you read in a new file.

= Your Output window should look similar to this example.

School Survey Data

School Year 2004-2005

Next Dataset Results Library
Current View: C:\Epi_Info\ETHA Tutorial\Asthma Survey 2005.mdb: viewPreInterventionSurvey
Record Count: 800 (Deleied records exciuded) Date: 5/16/2005 2:03:27 PM

Use the PrintOut Command

PRINTOUT can be used to print results directly from the Output window.
1. Create a Frequency of SchoolNum.
2. Create a Frequency of Medication.

» Notice the Data Source Title School Year 2004-2005 appears above your results.
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C:\Epi_Info\EIHA Tutorial\OUT789.htm

\/

{dext

4

Previous

3

Last

E

Print

O

Maximize.

a.’«

Bookmark

3

History

~
=
Open

School Year 2004-2005

Previous Dataset Results Library

FREQ Medication

Next Procedure

Forward

Has a health professional prescribed any medication to
your child?

|
‘Frequency

Percent B ‘
Percent

Yes | 64| 80%)

8.0% |

No 736 92.0% |

100.0% |

|
Total [ 800 100.0% |

100.0% |

95% Conf Limits
Tes 6.3% 10.2%

b

3. From the Command Tree Output folder, click PrintOut. The PRINTOUT dialog box

opens.

PRINTOUT B

Filename to print (leave blank for current)

Browse Save Only OK

x|
o

Clear Help Cancel

4. To print the current Output window and settings, click OK. The Print options window

displays.

5. Click Cancel. If you are connected to a printer, you can click Print to see the results in

paper form, otherwise cancel the print command.
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Routeout Data to a New File

You are going to create a new graph to be included in a presentation. Rather than saving the
graph as an image file, you are going to route the graph and results to a new file. The
ROUTEOUT command stays in effect untl you use the CLOSEOUT command.
ROUTEOUT will name your output and place it in the location of your choice on the

computet.

1. From the Command Tree Output folder, click RouteOut. The ROUTEOUT dialog box
opens.

ROUTEOUT i x|

Output Filename

|| |

[~ Replace any existing file

Browse Save Only OK

Clear Help Cancel

2. In the Output Filename field, type School Y ear Graph.
3. Click OK.

=  Output results will now go to the School Year Graph.htm file instead of the
Out#t.htm file.
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DEFINE and RECODE

In an earlier lesson, you create a bar graph using the variable WMonth. You may have noticed
that Epi Graph ordered the variables in sequence based on the first number, 1, 10, 12, etc. To
create a graph with months occurring in school year sequence, you are going to use the
DEFINE command to create a new variable and the RECODE command to place existing
values in a new order. A program example is located in Asthma Survey 2005 Sample. MDB.
The program is called MonthsRecode. PGM.

In the survey, some students selected their worst month for asthma symptoms from a
comment legal field, those who made no selection are considered Missing values. Students did
not select a year in this field. You want the dates in your graph to be distributed based on the
school year when the questions were asked. You are going to use the RECODE command to
assign a year (vatiable name addyr) to the months and to place them in the order September
2004-August 2005.

Once the months are recoded, you will define a new variable (NewWMonth) to indicate the
new sequence of months with the new year value. When you create the final code, you will
designate how you want the dates to appear and specify that the Legal Value fields, which
were once text, will appear as numbers. To do this you will use the function NUMTODATE.
NUMTODATE tranforms a set of three numbers into the year, month, day format and
allows you to order the variables by the new dates.

Your final code will say that the value of the NewWMonth variable will change from a
number to a date. The date will be formatted as the year 2000 plus the addyr variable, the
WNMonth variable, and the first day of the month. Since WMonth is a text field, you also have
to add in the code to format it as a number (TXTTONUM).

Keep in mind that the ROUTEOUT command is in effect and will send data to the new
output file School Year Graph.htm. This information and the graph can then be used in your
asthma report.

1. From the Command Tree Variables folder, click Define. The DEFINE dialog box
opens.

peFie x|

Variable Name

[addyr
—Scope
{+ Standard " Global " Permanent
Save Only OK
Clear Help Cancel

2. In the Variable Name field, type addyr.
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3. Click OK

* The data table now contains a new Standard variable. Standard variables are
temporary. Values and definitions are lost at the next READ command.

4. TFrom the Command Tree Variables folder, click Recode. The RECODE window opens.

N

From To
[ | | H

Dates must bhe in US format

Value (blank = other)| To Value (if amy) Recoded Value

Fill Ranges Save Only OK

Clear Help Cancel

5. Use the From drop-down box to select WMonth.

* You are taking the values from the variable WMonth and recoding them to appear in
the variable addyr.

6. From the To drop-down box, select addyr.
7. In the Value (blank=other) field type "9" and press Enter.

* Remember the value of 9 is September. September is a text value and text values
must be enclosed in quotes.

8. In the To Value (if any) field type "9" and press Enter.

9. In the Recoded Value field type the number 4 and press Enter. A new blank entry line
appears.

160



LESSON 7

You are creating the code to differentiate the year 2004 from the year 2005. The
number 4 is the year you will add to 2000 to reorder the months.

You are creating code so that September begins the list and appears in the year 2004.
October- December appears in the year 2004.

January -August appears in the year 2005.

From To
|WMonth | |addyr ;]
Dates must be in US format

Value (blank = other)| To Value (if any) Recoded Value

Ilgll llgll

L1 1 0“ L1 1 2ll

L1 1 " ll8ll

)
Fill Ranges Save Only OK
Clear Help Cancel

10. Complete the code as follows.

Value "10" To Value "12"=4
Value "1" To Value "8"=5
Value blank To Value blank= (.)

You are adding the condition that any values that do not fit the pattern are considered
Missing.

11. Click OK.

Your code should appear in the Program Editor as follows:
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RECODE WMonth TO addyr

rgqer _ ngQr = 4
riQr — mq2m = 4
i _ rngr = g
ELSE = {.)

END

Define a new variable to contain the date code

1. Click Define. The DEFINE dialog box opens.

DEFINE x|
Variable Name
[NewwwMonth
Scope
l‘G‘ Standard (" Global " Permanent
Save Only OK
Clear Help Cancel

2. In the Variable Name field, type NewlWMonth.
3. Click OK.
Assign a value to the new variable

1. From the Command Tree Variables folder, click Assign. The ASSIGN dialog box opens.

O ]
Assign Variable
|Newwnnomh |
= Expression
numtodate(2000+addyr txttonum({wmonth),1)
« 2
Available Variables +|_I*I,I=|< >|&|..|(I)
I j AND OR "“Yes" "No" *Missing"
Functions saveony | oK |
Clear | Help | Cancel I
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2. From the Assign Variable drop-down, select NewWMonth.
3. In the =Expression field, type nunstodate(2000+addyr,txttonum(WMonth),1)

* You are assigning a date format to the variable NewWMonth. You want the
year/month/day format because you are going to order the months by the year. This
code says the value of the NewWMonth variable will change from a number to a
date. The date will be formatted as the year 2000 plus the addyr variable, the WMonth
variable, and the first day of the month. Since WMonth is a text field, you also have to
add in the code to format it as a number.

4. Click OK. The code in the Program Editor appears as follows.

DEFINE NewlWMonth
ASSIGN NewlMonth=numtodate (2000+addyr, txttonwa (wmmonth) , 1)

Create a bar graph using the new variables and date code
1. Click Graph. The GRAPH dialog box opens.
2. From the Graph Type drop-down, select Bar.

3. From the Main Variables drop-down, select NewWMonth. The Display Format drop-
down opens.

4. TFrom the Display Format drop-down, select mmm yyyy.

5. Click OK
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NewWMonth

* Notice the months now appear in the School Year order you coded as September
2004-August 2005.

Customize the graph

1. Left-click the X-Axis text NewWMonth. The X-Axis Label dialog box opens.
2. Highlight the text NewWMonth.

3. Delete the text.

4. (Click OK

5. Right click the graph and select Customization Dialog from the pop-up menu.
6. In the Main Title field on the General tab, type Worst Month for Asthma.

7. In the SubTitle field, type Schoo/ Year 2004-2005.

8. Click OK.

9. Close Epi Graph.

= Notice that the window title bar shows the Output file as School Year Graph.

C:\Epi_Info'EIHA Tutorial'School Year Graph.htm
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10. From the Command Tree Output folder, click CloseOut. The CLOSEOUT dialog box

opens.

Save Only

Help

CLOSEOUT '

Stop routing output to designated file

x|

Cancel

11. Click OK.

*  Results will resume being created and saved as Out#.htm files.

12. From the Output window, click Open. The Browse dialog box opens.

13. Locate the EIHA Tutorial folder. Notice the file School Year Graph.htm is listed among
the other Out##.htm files.

14. Click Exit to close Analysis.
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Creating and Writing New Data Tables

For your asthma report, you want to see if there is a connection between age and asthmatic
symptoms. You want to illustrate the findings in the form of a graph.

There are times when it may take a series of steps to prepare your data for analyses. In Section
4 and 5 of this lesson, you will follow a series of steps in order to create a line graph that
shows trends in symptoms per age based on survey data. You will take all the students who
answered Yes to the individual symptoms and use the WRITE command to create a new data
table that contains Yes answers. The new data table can then be graphed.

In an eatlier lesson, you used the ASSIGN command to calculate the Age variable inside the
data table. The Age variable created was Standard, meaning that the code you assigned was
temporary and the values were reset each time you read in a new file. You cannot create a
global or permanent variable for Age because neither type can contain values that depend
directly or indirectly on table fields as the YEARS function does. For this exercise, you want
to create a line graph using age as a variable; however, you do not want to calculate the Age
field each time you create this graph, so you are going to use the WRITE command to create
a new data table containing the assigned age variable.

Using the new table, you will create person-symptom pairs of information (children answering
Yes to a symptom and their age) and WRITE/APPEND those records to a new data table
that contains only information for ages and symptoms. You can then READ in the age-
symptom data table and GRAPH the results.

An example of the following code is available in the Asthma Survey 2005 Sample. MDB. The
program is called LineGraphSample. PGM.

1. Open Analysis and Read in the Asthma Survey project file that contains your 800 records.
Be sure the Project file and the data source match.

2. From the Command Tree Variables folder, click Assign. The ASSIGN dialog box opens.
3. From the Assign Variable drop-down, select Age.

4. In the =Exptession field, type YEARS(DOB,10/25/2005).
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AssiGN x|
Assign Variable
[Age =

= Expression

Years(DOB,10/25/2005)
i .
Available Variables ﬂ _|* | { |=|< >|&|--| (I U

DOB v
I —J AND OR "Yes" "No* “Missing"

Functions | Save Only | | oK |

Clear | Help | Cancel |

5. Click OK.

6. List the variable Age to make sure it is populated.

Write the Age variable and the variables needed for the line graph to a new file.

1. From the Command Tree Data folder, click Write/Export. The WRITE dialog box

opens.
were ]
................ Output Made
v ,g_llt*) [~ 8ll{* Except I>(0" Append " Replace
Variables Output Formats
SchoolNum - I Epi 2000 EI
git:demln File Name
Gender b | _I
DOB Data Table
Phone =
YourLast I —I
PSNumber
ChildLast
ChildFirst ~|
Browse | saveony || oK |
Clear I Help I Cancel |

2. Use your mouse to click and select the following variables.
= SchoolNum

= StudentID
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= Gender
= DOB
*  Asthma
= RAD

» Bronchitis
= Wheezing
*  Medication
= MissDays

= Age

3. In the Output Mode section, select Replace.

4. From the Output Formats drop-down, select Epi 2000.

5. C(lick the Browse button next to the File Name field. Locate the EIHA Tutorial folder.

6. In the File Name field, type SympromsbyAge.

7. Click Save.

8. In the Data Table field, type AUSymptoms.

]
Output Mode
[~ AN [~ All{*) Except [(" Append (+ Replace
Variables Output Formats
MissSport | |Epi2000 ~
ﬁﬂ)‘:::s File Name
Personalinformation Ic:iEpi_lnfo\ElHn Tutorial'Symptomshyage.m _I
Whistle Data Tahle
Cough All oms Y
ShortB I Sympt —I
WakeUp
PreinterventionSurvey.RECSTATUS ;]
Browse I Save Only OK |
Clear I Help Cancel |

9. (Click OK.
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Read in the new project

1.

2.

Click Read/Import. The READ dialog box opens.

Click Change Project.

From the EIHA Tutorial folder, select SymptomsbyAge. MDB.
Click Open.

Select the table AllSymptoms.

Click OK.

List your variables.

*  Your new project contains only the variables you specified when you wrote the new
file.

* The new data is made up of the data table AllSymptoms. There is no view associated
with the table.

= Notice that the field Age is populated.

169



EPI INFO™ TUTORIAL

Write and Append Tables

You are going to use the new project and data table to create a graph that has one record for
each person-symptom pair. To do this, you are going to write out a new table, which contains
the symptoms you select, and the age of the individual with the symptoms. This will create a

second table inside the SymptomsByAge.mdb.

You must define the table, select the criteria, and write it to the new table. You will then

append the table to include all four of the symptoms.
1. Click Define. The DEFINE dialog box opens.
2. In the Variable Name field, type syzptomss.

3. Select Standard as the Scope.

4. (Click OK

5. From the Command Ttee Select/If folder, click Select. The SELECT dialog box opens.

6. Use the Select Dialog box to create the code Asthma="Yes".
7. Click OK. You should see a Record Count of 91.
8. Click Assign. The ASSIGN dialog box opens.

9. From the Assign Variable drop-down, select symptoms.

10. In the =Expression field, type or use the Available Variables drop-downs to create the

variable "Asthma".

» The variable Asthma is a text field so you must enclose it in quotes.

AsSIGN
Assign Variable
|symptoms j
= Expression
“Asthma"|
‘ >
Available Variables Ll . I = |y I = I <| > | &I u | ( I U
I —'I AND OR "Yes" "No" "Missing"
Functions | saveonty || oK |
Clear | Help I Cancel |

11. Click OK. The code in the Program Editor appears like the following:
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DEFINE symptoms
SELECT Asthma= (+)
ASSIGN symptoms= "Asthma"

Write the 91 asthma records to a new table

1.

Click Write/Export. The WRITE dialog box opens. You only want to include the
variables you want to graph in the new table.

From the Variables box, select Age and symptoms.

=  Remember symptoms contains your Asthma=Yes values. You are constructing a new
table that contains the Yes answers per symptom and the Age of the student
answeting Yes. You will add the information for each symptom/age to this table.

In the Output Mode section, select Replace.

Click the File Name Browse button.

Select the project SymptomsByAge.mdb.

Click Save. The File Name field populates.

In the Data Table field, type ageandsympton.

Click OK.
were ]
~ Output Mode
[~ Al{Y [~ All{*) Except ‘ " Append (+ Replace
Variables Output Formats
MonthlyBreathing :_] | Epi 2000] j
::::zg:ﬁt File Name
SpTimes |C:1Epi_lnfo\ElHn Tutorial'Symptoms by Age.t _]
lIHome Data Table
Personalinformation I ageandsymptom j
Age
symptoms
PreinterventionSurvey.Recstatus
UniqueKey ¥
Browse I Save Only | OK |
Clear I Help I Cancel |

The code inside the Program Editor should appear as follows:

171



EPI INFO™ TUTORIAL
WRITE REPLACE "Epi 2000" 'C:\Epi_Info\EIHA
Tutorial\SymptomsbyAge.mdb"ageandsymptom Age symptoms
9. Click Cancel Select.

= Now you need to complete a similar series of steps to add Bronchitis, RAD, and
Wheezing Yes answers to the new table.

Add/Append Symptoms

1. Select Bronchitis=Yes. There should be Record Count of 86.
2. Assign symptoms="Bronchitis".

3. Click Write/Export. The WRITE dialog box opens.

4. TFrom the Variables box, select Age and symptoms.

5. In the Output Mode section, select Append.

*  You want to add or append this information to the asthma data table you created
earlier.

6. Click the File Name Browse button.

7. Select the project SymptomsByAge.mdb.

8. Click Save.

9. From the Data Table drop-down, select ageandsymptom.
10. Click OK

11. Click Cancel Select.

Now follow the Bronchitis procedure and create the code to add data for RAD and
Wheezing to the ageandsymptoms table.

*  RAD contains 93 records.
*  Wheezing contains 99 records.

= Do not forget to select Append as the Output Mode and to Cancel Select when switching
between variables.
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* Remember that RAD and Wheezing must be enclosed in quotes in the ASSIGN

command.

Your final code should look like the following:

DEFINE syrptons

SELECT Asthma= (+)

ASSIGN symptoms="Asthma"

WRITE REPLACE "Epi 2000" 'C:\Epi Info\EIHA
Tutorial’ Symptomsbyige.mdbh' :ageandsymptom Age
SELECT

SELECT Bronchitis= (+)

ASSIGN symptoms="Bronchitis"

WRITE APPEND "Epi 2000" 'C:\Epi_Info\EIHA
Tutoriall Symptomsbyige.mdh' :ageandsymptom Age
SELECT

SELECT RAD= (+)

ASSIGN symptoms="RAD"

WRITE APPEND "Epi 2000" 'C:\Epi Info\EIHA
Tutorial’ Symptomsbyige.mdh' :ageandsymptom Age
SELECT

SELECT Wheezing= (+)

LSSIGN symptoms="Wheezing"

WRITE APPEND "Epi 2000" 'C:\Epi_Info\EIHA
Tutoriall Symptomsbylige.mdbh' :ageandsymptom Age
SELECT

symptons

symptoms

symptons

Synptoms

Read in the new data table

1. Click Read/Import.

= Be sure the Current Project and Data Source is SymptomsbyAge.

2. Seclect the table ageandsymptom. Remember to select All in the Read dialog box to see

the new tables.

3. Click OK

= There should be 369 records.
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Create the graph

1. Click Graph. The GRAPH dialog box opens.

2. From the Graph Type drop-down, select Line.

3. From the Main Variables drop-down, select Age.

4. TFrom the Line for Each Value of drop-down, select symptoms.
5. Click OK.

6. Open Epi Graph.

The graph should look like the following:.

[PEepi Graph =10l x|
File Edit View Help
————} _ = N N . . L} }
Asthma Bronchitis RAD Wheezing
_ i
| 2 Ree
20.0 k
15.0 —
a -
> o
>
8 100
5.0
0.0
I I I I I 1 I
S 6 7 8 9 10 11
Age

Customize the graph
1. Right click the graph and select Customization Dialog from the pop-up menu.
2. Title you graph Symptoms by Age.

3. Click the Plot tab.
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. Change the Plot Style to Bar.

. Click OK.

. Right click the graph and select Export Dialog from the pop-up menu.

. Export the Symptoms by Age graph as a .JPG file to your EIHA Tutorial folder.

. Close Epi Graph.

R
File Edit Yiew Help
Symptoms by Age
[ | [ | =] [l
Asthma Bronchitis RAD Wheezing

20.0 —
15.0
- _
= _
8 -
o 10.0:
5.0
0.0 -
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Write a File to Excel
1. Click Read/Import.

2. TFrom the Read dialog box, select the table All Symptoms.

= Be sure the Current Project is Symptoms by Age and the Current Data Source is
Symptoms by Age.

3. Click OK.
4. Click Write/Export.
5. Select the All checkbox to export all the variables.
6. In the Output mode section, select Replace.
7. From the Output Formats drop-down, select Excel 4.0.
8. Click Browse from the File Name field.
9. Locate the EIHA Tutorial folder and create a new Excel file called New.AsthmaTable.
10. Click Save.
11. In the Files field, type New.AsthmaData.
12. Click OK.
» Ifyou have Excel, you can open this file and view the exported data.

= If the DOB fields in Excel contain ### rather than dates, expand your columns.
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Skills Review

Place a checkmark next to the correct answer for each of the following questions. Refer to
Appendisc D Skills Reviews Answer Key for further details.

1.

Which command allows you to designate a new Output file?
[ ]WRITE

[ JREAD

[ JROUTEOUT

Which command allows you to create a new vatiable?

[ JSELECT

[ JASSIGN

[ |DEFINE

Which command allows you to store the value of a variable or assigns the result of a
mathematical expression?

[ JASSIGN

[ |DEFINE

[ JusT

When changing, assigning, or selecting text fields, the value must be enclosed in what?

[ ](Parenthesis)
[ ]*Asterisks*

[]"Quotes"

In the Program Editor, the value of Missing appears how?
L&)

10

LI+
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10.

To change a number variable to a date, what function would you use?
[ JTXTTONUM

[ INUMTODATE

[ JTXTTODATE

Which command allows you to create a new data table?
[ IMODIFY

[ JREAD

[ JWRITE

Which command allows you to open a new data table?
[ JREAD

[ [WRITE

[ JLIST

From the WRITE dialog box, what Output Mode would you select to add data to an
existing table?

DReplace

[ ]Append

The WRITE command can be used to export a data table to MS Excel.
[ JTrue

[ |False
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Lesson Complete!

WHAT YOU LEARNED

How to
®  Use the HEADER and PRINTOUT commands to customize output.

* Use the ROUTEOUT and CLOSEOUT commands to create named output
files.

®  Use the DEFINE and RECODE commands to change variable values.
= Use the WRITE/EXPORT command to create new data tables.

= Use the WRITE/EXPORT command to create an MS Excel file.
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Lesson8

Analysis: Data Management for
Maps

SUMMARY

This lesson is an introduction to creating maps in the Analysis module using Epi Map
features. The lesson focuses on the data management skills necessary to map data.

In this lesson, you will aggregate or group data using the SUMMARIZE and FREQUENCY
command. Data tables must be aggregated and contain a geographic value in order to be
mapped. At the end of this lesson, you will have a map that shows the count of missed days
from your survey mapped by zip code. From this, you can see which zip codes have the
highest number of absences based on answers to the survey question.

Maps can be saved as images and used in reports to later illustrate the findings as part of the
asthma report. In this lesson, you will use a map to illustrate the number of missed days of
school by the zip codes of the survey population.

Length of time to complete: 1 hour Beginner
Getting Started with Epi Map

Introduction to Epi Map including a diagrammed explanation of how data must match or be
aggregated to match shape files to produce maps.

Use the Map Command

Use the SUMMARIZE command to aggregate data and create a choropleth map using the
data to show the sum of missed days of school per zip code in the region.

Aggregate Data for Mapping

Use the FREQUENCY command to create a data table that contains the count of asthma
cases per zip code for the survey population. This data table will be used in Lesson 9 Epi
Map.

Skills Review

Hands-on task to practice creating an aggregate data table that contains the count of
bronchitis cases per zip code for the survey population. This data table will be used in Lesson
9 Epi Map.
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BEFORE YOU BEGIN

Complete Lesson 4 Analysis: Basics
Complete Lesson 5 Analysis: Creating Statistics
Complete Lesson 7 Analysis: Exporting Files

Download the map files to the EIHA Tutorial folder.

WHAT YOU NEED

Asthma Survey 2005.MDB.
ALBZCTA_region.SHP
ALBZCTA_region.PR]
ALBZCTA_region DBF

ALBZCTA_region.SHX

FIVE GOALS

* Be familiar with the types of data that can be mapped in Epi Map and the types of map

files needed.

= Use the SUMMARIZE command to create a sum of the variable MissDays that can be

plotted on a map.

= Use the MAP command and make geographic selections leading to a choropleth map of

the MissDays data table.

*  Use the FREQUENCY command to create an output table containing the count of

asthma cases by zip code.

*  Use the FREQUENCY command to create an output table containing the count of

bronchitis cases by zip code.
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Getting Started with Epi Map

Epi Map, the mapping component of Epi Info, is built around MapObjects software from
ESRI, the makers of ArcView and Arclnfo, popular Geographic Information System (GIS)
tools. Epi Map displays shapefiles from these two systems, and uses the enormous reservoir
of map boundaries and geographic data available on the Internet in ESRI-compatible formats.

Epi Map is designed to show data from Epi Info files by relating data fields to shapefiles
containing the geographic boundaries. Shapefiles can also contain data on population or other
variables, and can therefore provide numeric data that becomes part of the display as either a
numerator or a denominator. Numeric data can be displayed either as color/pattern
(choropleth) maps or as dot density maps with the dots randomly distributed within
geographic regions.

Point locations can be plotted automatically from data files containing X and Y coordinates in
various symbols, colors, and sizes. Shapefiles can contain lines or points to represent streets or
point locations, and points can be placed on top of the shapefile layer to represent homes in
which cases occurred or other geographic points of interest.

Choropleth and Case-Based maps can be created through Analysis; however, there are more
map options available when working through the Epi Map program on its own.

For information on how to download shape files refer to Appendix G: Preparing to Use Epi

Info™,
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Mapping Your Data

N Fil

.MDB file (data table)
Map File (.SHP file)

.

One Map File Contains

.DBF
.PRJ
SHX
SHP

Types of Maps

Case-Based
Choropleth
Dot Density
Point

Mapping Rules

 Must have a geographic text field that

corresponds to the map

« Data must be aggregated to a unique
geographical field that corresponds to the

map

* Data being plotted must be in numeric

format

e Zip code fields must be in text format

e X, Y Axis fields must be numeric

Types of Shapes

+ Polygon
e Line
« Point

= T

Corresponding Fields to Plot

/\.

Needed in Your Dataset

Text geographic field (must be
exclusive, e.g. one zip code
represented per record)

Match to

X, Y Coordinates

Match to

Numeric data field to plot

Match to

>
>
>

Map File

.DBF: Text (e.g. Zip) case-
based, choropleth or dot density

.DBF: X, Y Coordinates e.g.
points

.SHP: e.g. polygon, line or point
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Commands in this Lesson
SUMMARIZE

The Summarize command creates a new table containing descriptive statistics for the current
dataset or its strata. Analysis creates a new table or appends to an existing table containing
variables that represent aggregates or groups of variables in the current data source. Located
in the Statistics folder.

Aggregates are computed for each group of records, determined by the Stratified Variables,
which are also included in the table. Available aggregates are Count, Minimum, Maximum,
Sum, Average, Variance, and Standard Deviation.

MAP

The Map command produces a choropleth (color coded) map by summarizing data based on
a geographic field that matches the geographic field of a .SHP file. Through Epi Map, the
map can be customized by the user, and this customization can be saved into a MAP
template. Located in the Statistics folder.

SELECT

The Select command allows you to specify an expression that must be true for a record to be
processed. Located in the Select/If folder.

FREQUENCY

The Frequency command produces a table showing how many records have each value of
selected variables. Confidence limits for each proportion are included. Located in the Statistics
folder.
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Aggregate Data in Analysis

In this lesson, you are going to create a map of the sum of values in the MissDays variable.

Map data must be aggregated to a unique geographic field that corresponds to the map file. In
order to create a map that shows the sum of missed days per zip code, you must use the
SUMMARIZE command to aggregate your data. Then you can create a new table that will
contain the Count of MissDays grouped (aggregated) by Zip.

1. Read/Import the Asthma Survey 2005.MDB that contains your 800 records.

2. From the Command Tree Statistics folder, click Summarize. The Summarize dialog box

opens.

Summarize x|
Aggregate Variable Group By
nm Elll Y =
Into Variable
[ Apply |

Weight
| H
Output to Table
Save Only OK
Clear Help Cancel

3. From the Aggregate drop-down menu, select Sum.

4. From the Variable drop-down, select MissDays.

5. In the Into Variable, type DaysSun.

6. Click Apply. The code appears in the open field as DaysSum:Sum(MissDays).
7. From the Group By drop-down, select Zip.

8. In the Output to Table field, type DaysTable.
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Summarize X
Aggregate Variable Group By

[ | # i
Into Variable Zip
[ Apply |

DaysSum :: Sum(MissDays)

Weight
Output to Table
|D_aySTahIe|
Save Only OK
Clear Help Cancel

9. Click OK. The following message appears in the Output window.

*  Output table created: C:\Epi_Info\EIHA Tutorial\ Asthma Survey
2005.mdb:DaysTable

10. Click Read/Import. The READ dialog box opens.

11. Click the Show All radio button. All the tables in your dataset appear in a list.
12. Locate and select the DaysTable.

13. Click OK. You should have 33 records in the Output window.

* Click List if you want to see how your data has been aggregated with the number of
missed days summed per zip code.
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Create a Choropleth Map from Analysis

Now that the data has been aggregated, you can use it to create a choropleth map. Choropleth
maps are shaded with a range of colors indicating differing sums. A corresponding legend is
also created. To see sample code for all the maps in this chapter, open the Asthma Survey
2005 Sample. MDB and run the program MapCode. PGM.

1.

From the Command Tree Statistics folder, click Map. The MAP dialog box opens.

Mae x|

[~ 4’record per geographic entity,  LUe

Aggregate Function lﬂ _»l

| Count =] Shapefite

Geographic Variable __I
Ll Geographic Variable Denominator

?ata\lariahle - | ~| |_

Weight
| H
Template File
]
Output to Table
[~ Run Silent
Browse I Save Only | | OK I
Clear I Help I Cancel I

Select the 1 Record per Geographic Entity checkbox. The Aggregate Function drop-
down defaults to Sum.

From the Geographic Variable drop-down, select Zip.
From the Data Variable drop-down, select DaysSum.
Click the Browse button next to the Shapefile field. The Look In Map dialog box opens.

Locate and select the file ALBZCTA._region.SHP. This is a map of Albany, New York
by zip code regions.

Click Open.

From the Geographic Variable drop-down, select Zip.
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v 4 record per geographic entity: Title
Aggregate Function 4 _»_[
Sum | Shapefiie
Geographic Variable C:'Documents and Settings\dnn2\Desktopidownloads'ALBZCTA_regi _J
I_Zip .'J Geographic Variable Denominator
Data Variable [zIp [ ~|
[ DaysSum = [z =
Weight 12469
I :J 12120
= 12147
Template File 12186
.| [12023
Output to Table 12009 hd
[~ Run Silent
Browse | Save Only I | OK |
Clear l Help I Cancel l

9. Click OK. The Incomplete Join window appears.

*  From the Incomplete Join window, you can see which zip codes are in your data table
and not in the map files, and which zip codes are in your map files and not in the data
table.

= In this example, you have 7 zip codes that are part of the map files, but not in the
survey data, and 1 zip code that is in the survey data, but not part of the map. In
order to get the most accurate representation of the data, you would need to verify
that the survey data was correct and did not contain missing records or data entry
errors and that you had the best map to represent the surveyed area.
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Incomplete Join ). ]

X

ALBZCTA_region.SHP

The values of the Geographic Field in your data table do not match the values of the Geoaraphic Field in your map layer. The
values in your datatable may be misspelled or missing or the record may be missing from the data table.

Asthma Final. MDB: TMPMAR_2

MapX

12055

Save the lists
Print the lists
Continue
10. Click Continue. Epi Map opens.
The map you created should appear like the following:
Epi Map =3 x]
File Edit Shape (Boundary) Dats Map Type View Help
2| als|8| x(x|e]salx H

Legend - SUM_DaysSum
Missing or Excluded
8.00 to 58.50
58.51 to 109.00

109.01 to 159.50
159.51 and Above

Scale 1:0.0803 ‘ X:-74.51152 Y:42.86583

4:03PM
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You have created a choropleth map. Choropleth is used to categorize features into
equal ranges or counts (quantiles).

Notice the legend at the bottom left of the window. Your map is color-coded, based
on the sum of days missed per zip code. This map shows you a graphic
representation of the number of missed days by zip code, and enables you to see if
there are areas of the county in close proximity to each other with large numbers of
missed days.

Click the close X to exit Epi Map.
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Aggregate Data for a Case Based Map

You can add case-based data to a choropleth map. Normally, case-based maps are used to
show different symbols based on levels of classification (e.g., Confirmed, Probable,
Discarded, Suspected).

In this example, you will aggregate asthma data to place numbers of cases on the map per zip
code. You will use Analysis to create the data table. The new data table will be used in Epi
Map Lesson 9.

1. Read/Import the Asthma Survey 2005 project with 800 records.

2. Use the SELECT command to select those who answer yes to asthma. You should have
91 records. (Hint: Asthma=Yes)

3. Create a FREQUENCY of Asthma stratified by Zip.

FPREQ x|
Frequency of Stratify by
ILL | Freq |% = |
e | 2 |9 [~ &ll (*) Except
2.,.‘,:'1?* 65% Asthma Zip
Total 57 | 100%
Weight
Output to Table
[Countasthma
Settings | saeonty || oK |
Clear ‘ Help ‘ Cancel ‘

4. In the Output to Table field, type CountAsthma.
5. Click OK.

6. Read/Import in the file CountAsthma. Remember to select the All radio button to see
the all tables in your project. You should have 33 records.

7. List the records.

= Notice that each zip code contains the total count of students who answered yes to
asthma for that zip code.
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Skills Review

To create map containing the count of bronchitis cases per zip you need to create a new
Frequency table for Bronchitis. This table will be used in the Skills Review of Chapter 9.

Read/Import the file Asthma Survey 2005.

Select the students who answered Yes to Bronchitis.
Create a FREQUENCY of Bronchitis stratified by Zip.
Output to a table named CountBronchitis.
Read/Import CountBronchitis.

List the records to verify the data table contents.

Close Analysis.
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Lesson Complete!

WHAT YOU LEARNED

How to

®  Use the SUMMARIZE command to aggregate data.
®  Use the MAP command to create a choropleth map.
®  Use the FREQUENCY command to aggregate data.

= Create Output tables to use in mapping.
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Epi Map

SUMMARY

This lesson is an introduction to using the Epi Map module. You will create choropleth, case-
based, and point maps. This lesson includes information on customizing maps and saving
MAP files.

For the asthma report, you are interested in seeing how survey results can be mapped. You
will create a map containing income data for the selected region and then plot the number of
asthma cases from the survey onto the map. This will give you an idea if income and asthma
are related. You will then create point maps that contain the location of schools and hospitals
in the region. In the Skills Review Section, you will create a map from survey data that shows
you the number of students with Bronchitis per zip code.

Length of time to complete: 2 hours Beginner
Epi Map Overview

Review of information needed to create maps. Provides information on navigating Epi Map
and Map Types.

Create a Choropleth Map

Create a choropleth map using income data and then plot asthma cases on top of it to look
for correlations between income and cases of asthma.

Changing Map Properties
Use the Layer Properties option box to customize a map.
Viewing Map Information

Overview of using Map Tips, the Information button, and the Find button to view data
applicable to the map.

Saving a .MAP File
Walk-through of saving a map in an interactive format.
Create a Case-Based Map

Use data aggregated in Analysis to create a case-based map for the number of cases of asthma
per zip code. This data will be plotted on top of the income choropleth so you can look for
correlations between asthma and income.
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Add Text to a Map
Use the Title and Text options to add editable text to a map.
Create a Point Map

Use the Add Points option to plot school and hospital locations on the county map for the
surveyed region. Includes information on using the Layer Properties options box to edit
points.

Apply Standard Labels
Use the Standard Labels tab to add zip code labels to a map.
Apply Advanced Labels

Use the Advanced Labels tab to label the hospital locations on the map. Also covers the
Zoom and Pan Features of Epi Map.

Use Map Layers

Use the Add Layer feature with the Single tab to create a transparent layer showing the
boundary and zip code overlaps for the region.

Save a Bitmap
Walk-through of saving a map as a bitmap file for use in other programs or presentations.
Skills Review

Practice creating a map for the count of students with bronchitis per zip code based on the
Asthma Survey 2005 project. Use the Unique tab from the Layer Properties options box.

BEFORE YOU BEGIN

Complete Lesson 8 Data Management for Maps in Analysis.

WHAT YOU NEED

ALBZCTA_region.SHP
ALBZCTA_region DBF
ALBZCTA_region.PR]
ALBZCTA_region.SHX
Albany_Demogz.MDB

Data Table CountAsthma
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Data Table CountBronchitis
SchoolPoints. MDB
HospitalPoints. MDB
AlbanyCountyBoundary_region. SHP
AlbanyCountyBoundary_region. DBF
AlbanyCountyBoundary_region.SHX

AlbanyCountyBoundary_region.PR]

FIVE GOALS

Create a choropleth map of median income for the surveyed region.
® Create a case-based map that shows the correlation between income and asthma cases.
= Create a point map to show the location of schools and hospitals in the surveyed region.

® Add a shape layer to a map as a transparent ovetlay to show county boundaries for the
surveyed region.

= Create a map illustrating the distribution of bronchitis cases per zip code in the surveyed
region.
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Using Epi Map

Choropleth and Case-Based maps can be created through Analysis; however, there are more
map options available when working through the Epi Map program on its own. Epi Map
contains two primary interfaces, the Map Manager and the Properties dialog box. Used
together maps can be customized and saved as bitmaps for use in presentations or as .MAP
files that retain interactivity and can be edited and updated as data changes. Map files are
made up of 2-4 connecting files: the .SHP, which is the polygon/shape of the area to be
mapped, the DBF that contains the data, and the .SHX/.PR], which is the index file, linking
the shape and the data together.

For information on how to download shape files refer to Appendix G: Preparing to Use Epi
Info™,

To create maps you must follow some basic mapping rules.

*  You must have a geographic field in your dataset that corresponds to a shape file.
= Data to be mapped must be aggregated to a unique geographic field.

» Data being plotted must be in numeric format.

=  Zip code fields must be in text format.

» X, Y axis fields must be numeric.
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The Epi Map Workspace

1. From the Epi Info™ main page, click Create Maps or select Programs>Create Maps
to open the Epi Map module.

= This is an example of the Epi Map workspace.

File Edit Shape (Boundary) Dzts Map Type View Help

Z| |m|=| AlamaE =

| | ‘ wm

2. Sclect File>Map Manager or click the
opens.

Map Manager icon. The Map Manager
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Map Manager i !

General |

__&ldd Layer...

Add Layer Partial...

Add Data...

Add Eonts...

Bemaoyve Laper

Clear allLayers

Froperties...

Composition,,

Merge Layers...

Butfer Layer...

Case-Based,,.
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Navigating Epi Map

Most of the work in Epi Map is done from the Map Manager, which allows map layers to be
constructed with shapefiles and related data variables. You will use the Map Manager to add,
remove, or re-order layers. The Map Manager also allows you to Add Data, Add Points, or
add Case-Based information to a map. From the Map Manager you will also access the
Properties dialog box, which allows you to customize you map and how the data is displayed
on it.

Maps can be saved as .MAP files that are editable and can be opened in Epi Map or through
Analysis. Maps can also be saved as bitmap graphic files and used in presentations and in
other programs.

Many of the features available in the Epi Map menu are also accessible through the Map
Manager or the Map Tool Bar. The following options are available in the Epi Map menu.

File

When Epi Map starts, there are three options enabled. These include Map Manager, Open
Map File and Exit. Once a layer is added, then usable options are enabled.

Edit
The Edit menu allows you to copy the map as a bitmap to paste to other applications.
Shape (Boundary)

This opens the Shape Editor. The Shape Editor is a blank canvas used to design and edit
polygons.

View

Options available in the View menu are also accessible using the Map Tool Bar.

Z| gla|8| xlaloelslx [

Options available through the Tool Bar are the Map Manager, Print, Find, Global Extent
(centers a map on the workspace), Zoom In and Out, Pan, Information, Graphics, Cursor,
and Records for Feature. Clicking the Graphics icon opens a new tool bar that allows you to
add text or shapes to the map.
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Maps Types

The following maps will be created in this lesson.
Choropleth

Choropleth maps are used to categorize features into equal ranges or counts (quantiles) that
are color coded to indicate changes in the data. In this lesson, you will create a choropleth
map that illustrates Income data.

Case-Based

Case-Based maps allow users to show different symbols based on levels of classification (e.g.,
Confirmed, Probable, Discarded, Suspected). Epi Map produces a Case-Based legend that
displays the symbols, colors and the case classification values represented. In this lesson, you
will create a case-based map that shows the sum of the cases of asthma per zip code based on
the frequency table you created earlier in Analysis.

Point Map

Point maps require that an X, Y-axis be part of your dataset and the map file you are plotting.
When creating a point map, you are also given the option to save the points as a separate
shape. Points can also have labels applied to them during creation. In this lesson, you will
create a point map to illustrate the locations of schools and hospitals in the survey county.
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Create a Choropleth Map

In this lesson, you will create a choropleth map, customize the map, and save the Map as a
MAP interactive map file.

The schools in the survey cover a zip code region containing a variety of demographics. To
determine whether you have more cases of asthma in certain income brackets, you will create
a choropleth map of the regions using income data and then map cases of asthma from the
school survey onto the map. This will help you determine if there is a link between income
and asthma in the students from the survey. First, create the choropleth map and then plot
the case-based data on to the map.

1. Open Epi Map.

2. Click the Map Manager icon or select File>Map Manager. The Map Manager opens.

Map Manager 7 X|

......................

Add Layer...

Add Layer Partial...

Add Qata..

Add Eaints...

Bemoyve Laper

Clear all Layers

Properties...

Composition...

terge Layers,..

Buffer Laver...

R L S e il S—

Case-Based,,.

B B

= Maps work using a series of layers. To start you need to add your region layer.
3. Click Add Layer. The Add Layer window opens.
4. From the EIHA Tutorial folder, select the ALBZCA_region.SHP file.

5. Click Open. The map shape appears in the workspace and the layer appears in the Map
Manager.
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[Croorosr < EIES
Layersl Genelal]
ALBZCTA_region [ Add Caver:

Add Layer Partial...

Add Data...

Add Points...

Remove Layer

Clear all Layers

Compogition...

Merge Lapers

Buffer Layer...

|
I
I
I
I
|
Properties... I
|
|
|
|

Case-Based...

Scale 1:0.0803 | | MapTips | s23am

6. Irom the Map Manager, click Add Data. The Open Data Project window opens.

= Remember that data needs to be in an Epi Info™ project or MS Access file to be
plotted on the map.

7. Locate the EIHA Tutorial folder, select the file albany_demogz.mdb.
8. Click Open. The Select Data Table From dialog box opens.

» There are two tables in the demographic project. One table contains Income data and
one contains Race and Ethnicity data. You want to create a choropleth map using the
Income data. The Income table contains a series of zip codes and the median income
and per capita income for those zip codes. The median income is the value of family
income with 50% of families above the value and 50% of the families below the
value. Per capita income is the total income for that zip code divided by the
population.
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Select Data Table from j - 101 x|

C:AEpi_InfolEIHA Tutornialtalbany demogz.mdb

RACEETHNICITY OK

Change Database

Cancel

9. Select INCOME.

10. Click OK. The Select Relate Fields and Render Field dialog box opens.

Select Relate Fields and Render Field 3 10l x|

Shape Fields INCOME Columns INCOME Columns
Geographic Field Geographic Field Render Field

KEY MEDIANFAMILY
NAME PERCAPITA

STATE_1
zIP
ZIP_1

OK Cancel

11. From the Shape Field Geographic Field box, select Zip.
» This is the field inside the shape file that matches your data.
12. From the INCOME Columns Geographic Field, select ZIP.
» This is the field inside your data that matches the shape file.
13. From the INCOME Columns Render Field, select MEDIANFAMILY.

» This is the data field to be mapped.
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» The Select Relate and Render Field dialog box should look like the following.

Select Relate Fields and Render Field B 101 x|

Shape Fields INCOME Columns INCOME Columns
Geographic Field Geographic Field Render Field
1D
MEDIANFAMILY
PERCAPITA
0K Cancel

14. Click OK. The Incomplete Join window opens.

* This window tells you that the ALBZCTA_region file contains information on the
zip code 12007 that is not contained in the demographic project file.

Incomplete Join N _>£]

The values of the Geoaraphic Field in your data table do nat match the values of the Geoaraphic Field in your map layer. The
values in your datatable may be misspelled or missing or the record may be missing from the data table.

ALBZCTA_region.SHP albany_demogz.MDB: INCOME

ZIP

12007

Save the lists

Print the lists

Continue

15. Click Continue. The choropleth map appears. Notice the legend contains the color codes
for the Median Family Income per zip with the darkest color representing the highest
income range and the lightest color the lowest.

Your map should look like the following:
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Map Manaier

General I

ALBZCTA_region

Add Layer...

LESSON 9

I

&dd Layer Partial...

Add Data,..

Add Boints..

Remove Layer

Clear all Layers

Properties...

Composition...

Merge Layers,..

Buffer Layer...

Case-Based...

B B

Legend - MEDIANFAMILY
Missing or Excluded
13,426.00 to 32,504.50
32,504.51 to 51,583.00
51,583.01 to 70,661.50
70,661.51 and Above

Scale 1:0.0803

|r‘ MapTips 10:47 AM
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Changing Map Properties

Notice that your legend contains a breakdown on information based on five divisions of data.
To extend the ranges and further customize the map, you will use the Layer Properties
options.

1. From the Map Manager, click Properties. The Layer Properties dialog box opens.

Layer properties for ALBZCTA_REGION ) ) 5]

Layer name: IALBZCTA__region

The Choropleth [color/pattern)] classification applies symbols to a set of discrete values.

Single T Unique
Numeric field: Number of classes:
[MEDIBNFAMILY - ~] ColarHamp
~ALBZCTA_REGION - MEDIANFAMILY Start: [
B Salid fil =] [Missing pr [Excluded Enc: |l
Solid fil ~| [13426.00 - |32504.50
- — —l I— Reset Legendl
| |[Solid fil ~|[3250451 |- [51583.00
{Solid fil ~|[5158301 |- [70861.50 [V Draw outines?
[Solid fil ~| [> [7oee1.50 I~ GQuanties
[~ Overay
NOTE: To turn off
Choropleth, apply the
SINGLE tab.
0K Cancel Spply

* The number of classes listed shows how many divisions, or groups, your data is
broken into on the map.

* The Color Ramp on the right side shows the lightest to darkest colors for the map
codes. Use the Color Ramp to change colors inside the map.

= Any changes you make to the choropleth map from the Property box will not be
applied until you click the Reset Legend button. You must click Reset Legend to
accept the changes and Apply to place them in the map.
2. TFrom the Number of Classes drop-down, select 10.

3. Click Reset Legend. The number of classes changes to 10.

4. From the Color Ramp, click the End box. The Color dialog box opens.
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8.
9.

10. Close the Map Manager by clicking the close X.

Select a dark color to be the end color.
Click OK.

Click Reset Legend.

Click Apply.

Click OK to close the Properties dialog box.

Your map should look similar to the following:

LESSON 9

Legend - MEDIANFAMILY
Missing or Excluded
13,426.00 to 21,905.33

[] 21,905.34 to 30,384.67
[ 30,384.68 to 38,864.00
|| 38,864.01 to 47,343.33
47,343.34 t0 55,822.67
55,822.68 to 64,302.00
l 64,302.01 to 72,781.33
72,781.34 t0 81,260.67
81,260.68 and Above

[ et
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Viewing Map Information
Map Tips
The ALBZCTA _region shape file contains census data as part of the associated .DBF file. To

see this information, you can use the Map Tips option.

1. At the right hand bottom of the page, click the Map Tips check box. The Map Tips drop-
down menus appear.

....................

2. From the second drop-down, select Age 5_17.
3. Use your mouse button to hover over different map regions.

* The number that appears under your cursor in each zip code area is the number of 5-
17 year olds in that area per the census numbers.

4. Change the second drop-down selection to Zip.

5. Use your map to hover over the different map regions and see the zip codes.

Information Icon

Another way to get information from your map is to use the Information icon.

o

1. Click the

information icon from the Map Tool Bar.
2. Your cursor will be tagged with the Information icon.

3. Click inside any region on the map. The Identify Results window opens.
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Location: [-73.86239, 42 60457)
1 feature found

X|

Feature list

12054

E

Attribute List

AGE 18 21 =470

AGE 227292901
AGE_30_39 = 2270
AGE_40_49 = 2965
AGE_5_17 = 3284
AGE_50_64 = 2879
AGE_B5_UP = 2624
AGE_UNDER_ = 1028
AMERI_ES = 22
AREAZ17.12
AREALAND = 44393451
AREAWATR = 99575
ASIAN = 229
AVE_FAM_5Z =3
AVE_HH_5Z =2

Theme: ALBZCTA_reaion
Shape Type: Polygon

Close |

E

* The Identify Results window gives you a scroll-through list of all the information
about your selected region contained in the dataset.

4. C(lick Close to exit this feature.

Find Icon

Another way to locate information in the map is to use the Find feature.

&

1. Click the Find (binoculars) icon to activate the Find feature. The Find Features

window opens.
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10.

Find Features ] X|

1. Enter a search string

| |
2. Choose which layers to search
ALBZCTA_region

Eind

3. Pick a feature 0 matches found

4. Select the operation to perform

Highfight InsertPin Pan Tio Zoom 1o

In the Enter Search String drop-down, type the zip code 12054.
Click Find. The Pick a Feature section populates.

* Be sure the ALBZCTA_region file is selected in the Choose Which Layers to Search
field.

Click Highlight and the 12054 zip code region lights up to show its location on the map.
In the Enter Search String drop-down, type the zip code 12046.

Click Find.

Click Highlight.

Click Zoom To. The map zooms into the requested area.

Use the Close X to exit the Find Features window.

Click the ® Full Extent icon to return the map to the center of the workspace.
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Saving a .MAP File

To save your map in interactive mode for editing later you can save it as a .MAP file.
1. Click File>Save Map File. The Save Map File window opens.

2. Name your file IncomeAsthma.

3. Click Save.

4. C(lose Epi Map.
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Create a Case-Based Map

In this lesson, you will create a case-based map that shows the sum of the cases of asthma per
zip code, based on the frequency table you created eatlier in Analysis. This will help to
illustrate which zip codes had more cases of asthma and the income for those zip codes.

1. Click Create Maps. Epi Map opens.
2. Sclect File>Open Map File.

3. Locate and open the file IncomeAsthma.MAP. This file contains the choropleth map of
income you created in the previous lesson.

4. Click Continue, if you receive the Incomplete Join window.
5. Open the Map Manager.

6. Click Case-Based.

7. Locate and select the Asthma Survey 2005.MDB.

8. Click Open. The Select a Data Table dialog box opens.

Select Data Table from 10| x|

C:AEpi_InfoAEIHA Tutorial\Asthma Survey 2005.mdb

codeSchoollD12 -

codeSchoollD123 B DK
codeSchoollD1234
codeSpTimes
codeWMonth Change Database
:CountAsthma

DaysCntTable

DaysT able

daysvar Cancel
dayszip

NY_Age

NY_Eth

NY_race

Population
PrelnterventionSurvey

Programs _'_]

9. Select CountAsthma from the list of tables in your project.

10. Click OK. The Select Case-Based Relate Fields and Classification Field dialog box opens.
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Select Case-Based Relate Fields and Classification Field

Polygon Layer: JALBZCTA,_region

Database: |C:AEpi_Infor\EIHA Tutorialvdsthma Survey 2005.mdb

Table: |Countasthma

Shape Fields Count&sthma Columns Count&sthma Columns

Geographic Field Geographic Field Classification Field

i Asthma
VARNAME
Zip

STATE_1

ZIP

ZIP_1

“I nitializing Case-B ased process oK Cancel

11. From the Shape Fields section, select Zip.

12. From the CountAsthma columns section, select Zip.

13. From the Classification Fields section, select Count.

14. Click OK. The Select Case Symbols dialog box opens.

15. Type in the Legend Entry field. The numbers in the Legend column represent the

number of cases per zip code. For the number 1, type the text 7 Case of Asthma, then 2
Cases of Asthma. You are creating a legend title for each number in the column.

Your legend titles should look like the following:

215



EPI INFO™ TUTORIAL

Select Case Symbols i »

oK

Value(s) Legend Entry Color Symbol Size Font Character

| 1 1 Case of Asthm - |Square Z“ 7 I _vJ I _vJ
I 2 2 Cases of Asthm . ITriangIe _v_I | 5 j I ;]
I 3 3 Cases of Asthm . lCile j I 5 I _v_I I _v-l
l 4 4 Cases of Asthm . ITriangIe _vJ | 5 j I L'
| s 5 Cases of Asthm - [Coss  +] [ 5 =l =
l 8 BB Cases of Asthm . ISquare Z| | 5 j I LI

|

Cancel

Look at the color column. Are there any colors too similar to the choropleth color
rampr For example, if you have a dark blue field in your choropleth layer map, you
might want to select an orange or light color to represent the case shapes. If you have

similar colors in two blocks, you may want to change one.

16. To change colors, click the color block and select a new color from the Color dialog box.

Cases 1 and 2 both have red colors. Change one of them.

17. Use the Symbol drop-down to select shapes for each item. These shapes will populate the
legend and the map.

For this example, do not select True Type from the Symbol drop-down. If you wish
to try different symbol types, you would select True Type and then from the Font
drop-down select Wing Dings, or another symbol-based font. You would then select

a Character from the drop-down to replace the geometric symbols in use.

18. For the symbol size, select 15 for all.

Your Select Case Symbols dialog box will look similar to the following:

Select Case Symbols s

oK

Value(s) Legend Entry Color Symbal Size Font Character

I 1 1 Case of Asthm I_ |Circle jl 15 I j I Ll
| 2 2 Cases of Asthm r Tiange  ~| | 15 | = =
l 3 3 Cases of Asthm - |Square _'_I I 15 I LI I L'
| 4 4 Cases of Asthm . [Coss  +] [ 15 | = ]
I 5 5 Cases of Asthm r_ ICiche :_I I 15 I j I Ll
| 8 8 Cases of Asthm - [Square  ~| | 15 | || |

|

Cancel

19. Click OK. The Map populates with the selected symbols and legend. Close the Map

Manager to see the entire map.
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Your map should look similar to the following:

File

=i

Edit Shape (Boundary) Dzt= MapType View Help

&|n|8 alx|oelan

A
L]
_|_
el
L

659—8059(1 Legend - COUNT

-1 Case of Asthma n=8
-2Casesof Asthma n=9 |/
- 3 Cases of Asthma n=§
- 4Cases of Asthma n=§
-5 Cases of Asthma n=4

- 8 Cases of Asthma n=1

Scale 1:0.0803 | X:-74.51655 42,6422 | HiapTs [ 11:48M

The map legend tells you which symbol stands for the number of cases in a given zip
code. The n= number tells you the total number of zip codes containing that number
of cases. For example, the first symbol is equal to 1 case of asthma, and there are
eight zip codes with one case of asthma.

You can move the legend by clicking and dragging it. The map graphics may jump a
little during this process. Place the Case-Based Legend on the lower left corner of
your map, and the choropleth Median Income legend on the lower right corner of the
map.

Remember that the case-based information was placed on top of the income
choropleth. Does the map indicate a correlation between income and asthma in the
survey data?
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Add Text to a Map

Create a title for the asthma and income map.

1. From the Epi Map main navigation menu, click View>Title. The Map Title dialog box
opens. It may take a few seconds for the text and title dialog boxes to appear.

Map Title ' X|

IEnter text for a map title

Color Size Font
| | |
- | 12 |S ystem 3

0K I Cancel | Delete |

2. In the Enter Text field, type Asthma Cases by Zip Code and Income.
3. From the Font drop-down, select a Font.
4. Highlight the Size field and type 18.

5. Click OK The title appears on your map in the top center of the page.

6. To add additional text to a map select View>Graphics, or click the

&

in the tool bar. The Graphics option boxes appear:

Al \[OEZ[O] £

Graphics icon

7. Sclect the letter A icon for text insertion. The cursor will turn into a crosshairs symbol.

8. Click anywhere on your map. The Graphic Text dialog box opens.
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Graphic Text LI

IE nter text to add:

I Color I Size I Font
- | 10 |System 3

oK | Cancel | Delete |

9. In the Enter Text field, type Asthma Survey 2004-2005.
10. From the Font drop-down, select a font style.
11. Make the text size 12.

12. Click OK. The text appears on your map.

= To move your text or your title to a new location on the page, click the 1 Arrow
icon from the Graphics Tool Bar. The cursor turns into an upright arrow. Light green
crosshairs appear in the bottom center of your text fields.

* To move text you must line up the arrow with the bottom of the green crosshairs, a
box appears around the cross and the cross hairs turn red. Click, hold, and drag the
box to move your text to a new location. This may take some practice.

= To delete or edit text, double click the green cross hairs. The cross will turn red so
you know it is selected. The Text box appears. Click Delete to remove the text or
edit the text field, size, font, or color of the text, and then click OK.

13. Move the title and the text to a new location on the map.

14. Use Map Tips or the Information icon to find out which zip code contains eight cases on
asthma.

15. Open the Map Manager.
16. Click the General tab.

17. Select a color block to add a background color to your map.
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Your map should look similar to the following:

ase-Based Legend - COUNT
-1Case of Asthma n=8

A- 2 Cases of Asthma n=9

-3 Cases of Asthma

| + 4 Cases of Asthma

| @ 5 Cases of Asthma

- 8 Cases of Asthma

18. Close the Map Manager.
19. Save a new .MAP file with the name CBAsthmalncome.

20. Close Epi Map.

EDIANFAMILY
Missing or Excluded
13,426.00 to 21,905.33
[ 21,905.34 t0 30,384.67
[ 30,384.68 to 38,864.00
38,864.01 to 47,343.33
47,343.34 10 55,822.67
55,822.68 to 64,302.00
64,302.01 to 72,781.33
72,781.34 t0 81,260.67
81,260.68 and Above
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Create a Point Map

Point maps can be made if you have geographic data for the X, Y longitude and latitude
measurements of your map corresponding to the region. X, Y coordinates are developed with
GIS tracking solutions and are not available for every map or location. Most often, they are
used for street maps and locations or to pinpoint specific areas.

For this map, you have X, Y coordinates related to school and hospital locations in the
region. In this lesson, you will add a fill color to a map, add points, and apply a shape polygon
to designate where your county crosses zip codes and boundaries. This map will give you the
location of school and hospitals in the surveyed region.

1. Open Epi Map.

2. Open the Map Manager.

3. Click Add Layer. Locate the ALBCZTA_region.shp file in your EIHA Tutorial folder.

4. Click Properties. The Layer Properties dialog box opens.

Layer properties for ALBZCTA_REGION . 5]

Layer name: [4 BZCT4,_region

The Sinale Symbol classification displays all the features in a layer with the same symbol.

Single T Unique T Choropleth T Std Labels T Adv Labels T Dot Density |

................

Fill Color: | B Outine Color

Stle: [Soid fi =l

Outling width: |1 [V Draw outlines?

NOTE: Applying the Sinale tab will remove
all rendering from the other five tabs.

‘ 0K Cancel Apply

5. Click inside the Fill Color block. The Color dialog box opens.

6. Sclect a Fill color for your map. Try to select a light color.
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Be sure the drop-down Style menu reads Solid Fill.

7. Click Apply.

8. Click OK.

Your map should look similar to the following:

I Map Manager ]

Layers ] Genevall

(B ALBZCTA_region

Add Layer...

=18]x]

Add Layer Partial...

Add Data...

Add Points...

BRemove Layer

Clear all Layers

Picpéities:.

Composition...

Herge Layers,

Buffer Layer...

Case-Based...

B B

Scale 1:0.0803 |

™ MapTips 12:43PM

9. Click Add Points. The Open Data Project window opens.

10. From the EIHA Tutorial foldert, locate and select the file SchoolPoints.mdb.

The file School Points. MDB was created using data from a map .DBF file. The file
was imported into Analysis and written out to a new Epi Info™ project file to be
used in Epi Map. The same process was used to create the project file used for the
Hospital point data.

11. Click Open. The Select Data Table dialog box opens.

12, Select the table pttable.

13. Click OK. The Select X/Y Fields and Properties dialog box opens.
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Select X/¥ Fields and Point Properties from N -0l x]
pttable
X Field [e.g.. Longitude) Y Field [e.g.. Latitude)
XCOORD 0K
YCOORD YCOORD =

Cancel

Point Label (optional)

Point Type I Circle v I
CITY

lzdﬁ:’ME Point Color -

Point Size |1 v ]

[~ Save points as new layer

14. In the X Field Longitude section, select XCOORD.
15. In the Y Field Latitude section, select YCOORD.
16. From the Point Type drop-down, select Circle.

17. Click inside the Point Color block to select a color that will show up on the fill color you
selected for the map.

18. From the Point Size drop-down, select 5.
19. Click OK.

Your map should look similar to the following:
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[ oo — = i
Layers I General|
& ALBZCTA region Add Layer...

Add Layer Partial...

Add Data...

Add Points...

BRemove Layer

Composition...

Merge [Layers

Buffer Layer...

I
I
|
|
|
Clear all Layers |
|
|
|
I
|

Case-Based...

B B

Scale 1:0.0803 | ™ MapTips

| 110PM

* The points added to the map are considered a new layer, but are not editable.

Add the Hospital Points to the Map

1.

2.

9.

10.

Click Add Points. The Open Data Project window opens.

From the EIHA Tutorial folder, locate and select the file HospitalPoints.mdb.
Click Open. The Select Data Table window opens.

Select the table hosppts.

Click OK. The Select X/Y Fields and Point Propetties dialog box opens.
From the X Field section, select XCoordinates.

From the Y Field section, select YCoordinates.

From the Point Type drop-down, select Triangle.

Select a new Point Color.

From the Point Size drop-down, select 5.
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11. Select the checkbox Save Points as New Layer.

= When you save the points as a new layer, they will appear in the Map Manager as an

editable layer.
Select X/¥ Fields and Point Properties from ) = |El|5]
hosppts
X Field [e.g.. Longitude) Y Field [e.g.. Latitude)
XCoordinates ok
YCoordinates YCoordinates =

Point Label (optional)

Point Type ITriangIe 'I
;_:JI;QME Point Color [

Point Size |5 v I

[v Save points as new layer

CITY

[~ ¥ary symbol size for coincident points

12. Click OK. The Save Points as Shapefile window opens.
13. Name the new file Hospitals.
14. Click Save to populate the map.
*  Your map should look similar to the map below:
= Notice that the Map Manager now contains a new layer called Hospitals.

* In the list of layers, Hospitals needs to be the top layer. If it is not, highlight it and
click the Up Arrow inside the Map Manager.
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T | LIS

hospitals Add Layer...
ALBZCTA,
M LBcET A sedion Add Layer Partial...

AddDats

Add Points..

Remove Layer

Properties...

Composition...

Merge Layers

Buffer Layer...

|
I
I
|
I
Clear all Layers I
I
I
I
I
I

Case-Based...

B| 3

<

Scale 1:0.0807 | ™ MapTips [ 1:23pM

= Now select the ALBZCTA layer. Both School and Hospital points should be on the
map.

Edit Shapefile Points

The triangles that represent the hospitals are a little too small. Since the hospital points are on
separate layer and are a separate shape file they can be edited.

1. From the Map Manager, highlight the Hospital layer.
2. Click Properties. The Layer Properties dialog box opens.

= From the Single tab, you can edit the point size and color of the Hospital data points.
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Layer properties for HOSPITALS .4

x|

Layer name: l hospitals

The Single Symbol classification displays all the features in a layer with the same symbol.

| Urigue | Choopleth | Stdlabels | Advlabels | DotDensiy |

Marker Color: | N
Style: ITriangIe :_I
Size: |5
Font: I 3

Character Index: I v I
Rotation: i] )_J

i

NOTE: Applying the Single tab will remove
all rendering from the other five tabs.

oK Cancel Apply

Highlight the number 5 in the size field.
Type in the number 12.

Change the Marker Color, if needed.
Click Apply.

Click OK to close the Layer Properties dialog box.

From the Map Manager, click the ALBZCTA layer to show all the points in your map.
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Apply Standard Labels to a Map

You can use the data associated with the map files to place labels on the map. The Standard
Label classification draws text for a specified field. In this section, you want to add zip code
labels to the map.

1. From the Map Manager, select the layer ALBZCTA.
2. Click Properties. The Layer Properties dialog box opens.

3. Click the tab Std Labels.

Layer properties for ALBZCTA_REGION ) 5]

Layer name: IALBZCTA__region

The Standard Labels classification draws text for a specified field.

Single T Unique T Chorapleth T 5 T Adv Labels T Dot Density |

Text field Fill color: [
[z1P ~|
Horizontal alignment [V Draw features [points, lines or polygons)
Cente L] v Allow duplicates
Yertical alignment I SP"ned text
I _I [~ Flip
v
[~ Owveray
Font
f&rial Black f |
Rotation: 0

NOTE: To turn off Std Labels, apply the

<l i SINGLE tab.

oK Cancel Apply

4. From the Text Field drop-down menu, select Zip.

5. From the Horizontal Alignment drop-down, select Center.

f

6. Click the Font button. The Font dialog box opens.

7. From the Font section, select a new font.

8. From the Font Style section, select Regular.
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9. From the Font Size section, select 8.

10. Click OK from the Font dialog box.

11. Click Apply.

12. Click OK.

Your map should similar to the following:

O

Layers | General |

(=1 hospitals Add Layer...

X — =18]x]

eEEETreion Add Layer Partial...

Add Data...

Add Points...

Remove Layer

Clear all Layers

Froperties...

Composition...

terge Layers,

SN

Buffer Layer...

Case-Based...

el .|

v
@0

H

L

Kl

Scale 1:0.0807 |

™ MapTips | 210PM

13. Remove the zip code labels by opening the Properties dialog box and clicking the Single

tab.
14. Click Apply.

15. Click OK.

229



EPI INFO™ TUTORIAL

Apply Advanced Labels to a Map

The Advanced Labels classification draws text for a specified field and attempts to resolve
overlapping and crowding of labels. In this section, you will add the hospital point names to
the map.

1. From the Map Manager, select the layer Hospitals.

2. Click Properties. The Layer Properties dialog box opens.

3. Click the Adv Labels tab.

Layer properties for HOSPITALS . B ) 5]

Layer name: lhospitals

The Advanced Labels classication draws test for a specified field and attempts to resolve overlapping and
crowding of labels.

Single T Unique T Choropleth T Std Labels T Dot Density ]

Test field: Mask color: [

|FNAME _v_I Fill color: [l

Font: V' Draw features [points, lines or polygons)

| Tahoma f v Allow duplicates
[~ Mask labels
[~ Overlay

— Label Placement Label height in map units
¢ Place on

(" Place above

(" Place below A 1] J L] A

NOTE: To turn off Adv Labels, apply the
SINGLE tab.

oK Cancel Apply

4. From the Text Field drop-down menu, select FINAME.

f

5. Click the Font button. The Font dialog box opens.

6. From the Font section, select a new font.
7. From the Font Style section, select Regular.

8. From the Font Size section, select 8.
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9. Click OK from the Font dialog box.

10. Click Apply.

11. Click OK.

Your map should look similar to the following:

I Map Manager 1

Layers | Genelal'

haspitals Add Layer...

x| N =181 x]

ALBZCTA_region

Add Layer Partial...

Add Data

Add Points...

Remove Layer

Clear all Layers

Properties..

Composition...

Merge Layers...

Buiffer Layer...

Case-Based...

B v

Scale 1:0.0814 1 X:-74.52397 Y:42.86724

[~ MapTips 224 PM

12. Select the ALBZCTA layer to activate it.

13. Close the Map Manager.

o

14. Click the

Zoom button. The cursor turns into a magnifying glass.

15. Use the click and drag method to draw a square around the Albany Memorial Hospital
region. A close-up view of the map appears.
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=8|

File Edit Shape (Boundary) Dzta Map Type View Help

Z| G|n |8 [a a|melalr|E

&BANY_ MEMCRIAL HOSPITAL
o o

° OE_PEFRS HOSPITAL

® e

< B |

Scale 1:0.0107 | X.-73.74682 Y:42.68082 ™ MapTips | 226pPM

16. Click the ) Pan button. The cursor turns into a hand.

17. Use the click and drag method to move around the map. Click inside the map and use the

hand to move the map and locate point areas that fall outside the map region.

18. Use the Zoom Out button, or the Full Extent button, to return the map to the center of

the workspace.

19. Open the Map Manager and select the Hospital layer.

20. Opening the Properties dialog box, and click the Single tab to remove the hospital labels

by

21. Click Apply.

22. Click OK.
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Add a Shape Layer

The data and zip codes contained in the survey information crossed county lines. To see how
this affects the locations of the schools in the survey, you can place the county shape over the
region shape.

1. From the Map Manager, click Add Layer. The Add Layer window opens.

2. Seclect the file called Albany County Boundary_region.SHP.

3. Click Open. The Albany shape appears on top of the region shape.

The map should look similar to the following:

[reorines = mETEy
Layersl Generall
& Albany CountyBoun... | | AddCaver.
=4 hospitals

ALBZCTA_region Add Layer Partial...

Add Data...

Add Points...

Remove Layer

Properties...

Composition...

Herge Layers

Buiffer Layer...

|
|
I
|
|
Clear all Layers |
|
|
I
|
I

Case-Based...

B| 3

Scale 1:0.0814 I X:-74.42455Y:42.86045 II_ MapTips 2:44 PM

4. Click Properties. The Layer Properties dialog box opens to the Single tab.
5. From the Style drop-down, select Transparent Fill.
6. In the Outline Width box, type 2.

7. Click Apply. The outline around the Albany Boundary file will be thicker while the inside
of the shape appears transparent.

8. Click OK

9. From the Map Manager, select the ALBZCTA layer to view all the points.
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10. Close the Map Manager.
11. Turn on Map Tips.

12. Select Zip from the drop-down and hover over the region to see which zip codes cross
county boundaries.

The map should look similar to the following:

Save a Map as a Bitmap File

To save a map to be used in presentations or documents, you can save it as a bitmap file.
1. Select File>Save as Bitmap File. The Save As window opens.

2. Name the file Schoo/PointsMap.

3. Click Save.

4. C(lose Epi Map.
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Skills Review

Create a new map based on the number of children with Bronchitis in the survey. Use the
CountBronchitis table you created in the Lesson 8 Skills Review.

Open Epi Map.
Use the Map Manager to add the layer ALBZCTA _region.shp to the workspace.

Use Add Data to plot the table called CountBronchitis. The table is located in the Asthma
Survey 2005.mdb. This is one of the frequency tables you created in Lesson 8.

In the Select Relate Fields and Render Fields dialog box, select the options Zip, and Zip, and
Count.

Click Continue at the Incomplete Join window. A choropleth map of the bronchitis count
appears.

From the Map Manager, select Properties.

Select the Single tab.

Click Apply, to remove the choropleth settings.

Select the Unique tab. The Unique Values classification displays features by applying a symbol
to each unique value for a specified field. In this example, it will display a unique color for
each value of Count.

From the Field drop-down, select Count.

Click Reset Legend.

Select the Overlay checkbox.

Click Reset Legend.

Click Apply.

Select the Advanced Labels Tab.

From the Text Field drop-down, select Zip.

Use the Font options to make the font size 8.

Click Apply.

Click OK.

Close the Map Manager
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Add the title Student Bronchitis per Zip.

Arrange the title and legend as you prefer.

Save the map as a .MAP file titled BronchitisZips.

Your map will look similar to the following:

File Edit Shape (Boundary) Dats Map Type View Help

2| ala|8| alx|mlelalx

=lB(x]

Student Bronchitis per

'V Legend - COUNT

EECOEEEOEOD
FEEIrSr

=

Scale 1:0.0803 | X:-73.78785 :42.85500

[~ MapTips

9:49 AM
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Lesson Complete!

WHAT YOU LEARNED

How to

= Create a choropleth map.

® Create a case-based map.

= Save maps as .MAP and .BMP file types.

= Create a point map.

» Edit maps using the Properties dialog box.
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Lesson10

Epi Report

SUMMARY

This lesson is an introduction to using the Epi Report module. Use Epi Report to design and
generate reports containing Analysis output. Reports can also contain system variables and
graphics.

In this lesson, you will use data from the survey and output created in Lessons 1-9 to create a
sample report that contains some of your findings. Your report will contain frequencies,
missed days per condition, a line listing of conditions and missed days for a specified age, and
the worst month pie chart created in Lesson 6 Epi Graph.

Using the data tables you created in Lesson 1-9 and the graphs and maps, you could create a
comprehensive report to illustrate the need for asthma initiative funding in the region. For
this lesson; however, you will only use a fraction of the data to learn the Epi Report module
and create a basic report containing some of the findings.

To view a sample of the report you will be creating, you can open the Epi Report module,
select File>Open, and view either My Epi Report2. EPT or WMonth Report. EPT.

Length of time to complete: 1.5 hours Beginner
Getting Started with Epi Report

Overview of basic information to navigate Epi Report. Includes information on Report
Elements that can be added to your reports and/or updated from Analysis output.

Insert a Report Object

Use the Label and Drawing Tools options to insert a title and a line in your report. Learn to
use the Properties dialog box, customize text, and insert a System Variable.

Read Data and Create Elements

Use the output file Frequencies. XML to add frequency tables per condition to your report.
Use the Properties dialog box to change table settings.

Aggregate Data

Add aggregated sum and average of missed days of school data to your report Includes a
Practice Lesson.
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Create a Line Listing Group

Use this element to access the Query Builder, and develop a line listing for children seven
years of age who attended School A and who had asthma.

Insert an Image
Use this element to insert the worst month pie graph you created in Lesson 6 Epi Graph.

Skills Review

Series of five questions designed to reinforce skills learned in the Epi Report lesson.

BEFORE YOU BEGIN

Complete Lesson 6 Analysis: Epi Graph.

Complete Lesson 7 Analysis: Exporting Files

WHAT YOU NEED

Wmonth Pie Graph.BMP or WMONTH GRAPH.bmp
Frequencies. XML

SymptomsByAge.mdb or SymptomsByAgeSample.mdb

FIVE GOALS

® Drag report elements on to the Epi Report workspace and to open the associated
Properties dialog boxes.

= Open an XML file created as Analysis Output and select data tables for inclusion to a
report.

= Insert aggregated and summarized data into a report.
= Use the Query Builder to design a customized line listing for your report.

= Insert a graphic created in another program as part of your report.
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Getting Started with Epi Report

The Epi Report tool is used to design and generate reports. Reports can contain elements
bound to data sources. The Epi Report module uses the . XML files generated by Analysis
when output is created. Report elements can include Analysis . XML files, records lists, cell
replacement, groups, and aggregate data. Data analysis, through pivot tables, is also provided.

Reports are saved in the Epi Reports format with the extension of .EPT. When a report is
generated, the corresponding data source (which is an XML file) is accessed. The latest
information from the XML is displayed to the user during report generation. The user can
select individual data elements to appear in the report. When generating reports, queries are
applied to the specified data sources, and information is extracted and displayed. You can
include multiple tables, apply conditional filters, group data, and apply vatious aggregate
functions on the extracted data.
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The Epi Report Workspace

Click Create Reports or select Programs>Create Reports to open the Epi Report module.

This is an example of the Epi Report Workspace:

LIRS
FoFle Edt View Tools Windows Heb =1®] %]
bF@gd:>ali -~ Usze the Epi Report main navigation bar
I || : =l Zlfer toaccess menuiterns and tool bars.
WG o
% Irwerl Fleport Obgsct H | I1 | 3 I| P | Tocl bar options include font changes, .
:imﬂ e wertical rpacing, table mizing, and —;|
& Fead Dala o Copatn ] Generate.
U

The Element= Command
Tree gives Tou the option to
Inzert 2 Report Object, uze
Drawing Toeols, Inserta
Vanakle, or Bead Diata and
Create.

Oce data is added to the

Elements Tree, Foucan The Designer Window is the main workspare for the
drag and drop it into Four EpiReport module.
teport.

The Designer Window allows routo display Report
Element= and to design and edit vour report a= needed.

z

INS | HUM
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Navigating Epi Report

Elements added to a report are arranged in the Designer Window. Use the Epi Report main
navigation menu and the tool bar to edit text and resize tables. Use the Elements Command
Tree to insert data from Analysis, graphics, and text objects.

Navigation and Tool Bars

Use the File, Edit, View, Tools, Windows, and Help menus to complete standard tasks
associated with creating a report. This includes New, Save, Print Preview, Generate Report,
Undo, Copy, Paste, Zoom, Pagination, and Reload Analysis XML.

Use the Tool Bar to customize text and tables, Generate Reports, Preview the Template,
and Add Vertical Space to your report.

IET.GENOEED

“Normal j r\/—etdana LI |18pt ﬂ ‘:B 7 U | Ty E=EF| ==

|w = H[ =

it

L
k.
L

When text is selected in the report, the text formatting tool bar activates. Use these options to
change font style, size, appearance, color, and location. Numbering and bullet options are also
available. Use the W and H arrow boxes to resize tables and cells to specific sizes rather than
using the corner drag method.

Elements Command Tree

The Elements Command Tree provides you with the menu options to add data elements,
text, and graphics to a report. The tree is divided into four types of elements. Clicking one of
the elements will activate a pop-up option menu where you can select an output type (usually
an .MDB), or will allow you to drag the selected element onto the workspace and customize
its appearance.

Click the plus box next to each command to see all the available options for each heading.
For example, open the Insert Report Object heading by clicking the plus box. Under Insert
Report Object, you have the option to add a Table Shell, Image, Anchor, or Label to your
report. Objects and elements are added to a report using the drag and drop method. Objects
and elements are customized using the Properties dialog box associated with the object.
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8- Insert Report Object
i Table Shell
i Image
i Anchor
i Label
& Drawing Tools
“ Line
- Insert Variable
& Permanent Variables
“ LANGUAGE
8- System Variable
o CurrentDate
o CurrentTime
“ TemplatePath
8- Read Data and Create
#- Read Analysis Output
#- Field Aggregate
#- Line Listing Group
“ Pivat Table

Insert Report Objects includes Table Shell, Image, Anchor, and Label. Use Table Shell to
drag an empty table into the workspace. Image and Label allow you to place text or
graphics in the workspace. Anchor allows you to insert an HTML link.

Drawing Tools includes Line. Use Line to insert a line element as a graphic. Lines can be
resized and customized with new colors, styles, or widths.

Insert Variable includes Permanent or System type. Use these elements to insert the date
or time as a variable in your report.

Read Data and Create includes Read Analysis Output, Field Aggregate, Line Listing
Groups, and Pivot Table. Using these options allows you to select a project (MDB) and
to choose an output or routeout file and to drag and drop data into your report.
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Report Data

Types of output data you can add to reports using the Elements Command Tree.
Read Analysis Output

Use the Read Analysis Output command to include information from Analysis XML files.
Each XML file selected is added under the Read Analysis Output menu in the tree. Multiple
XML files can be opened. Data is added to the Designer window using the drag and drop
method. Each time the report is generated, the output files are updated to reflect changes
made in Analysis.

Field Aggregates

Aggregate functions (count, min, max. etc) can be applied for individual columns in the
database and the corresponding information can be included in the report. Aggregates are
calculated during report generation. Conditional filters can also be applied using the Query
Builder window. All formatting options are available.

Line Listing Group

Users can logically group related data using the grouping concept. A record-list is based on a
database query. Use the Query Builder for Line Listing Groups to select items that will appear
in the listing. If no fields are selected, a simple record list is created. If a group field is selected,
the records displayed appear as part of the selected group.

Once the query is formed, it is added to the Line Listing Group menu inside the Element
Command Tree. The Line Listing can then be selected, dragged, and dropped into the report.
Once added it can be customized with headers and footers by inserting rows at the top and
the bottom of the table listing. Formatting options like color, size, etc. can be selected for the
items in the table. The formatting options are applied during the generation of a report.

Pivot Table

Pivot tables can be embedded into reports for data analysis. Use the Query Builder to select
criteria to include in the pivot table.
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Insert a Label

Use the Insert Report Object menu to create a title for this page of the report. The Label
option can be used to insert any kind of text into a report.

1. From the Epi Info™ main page, select File>Create Repotts or click Create Reports.
Epi Report opens. The workspace opens to a blank template.

2. Click the plus box next to Insert Report Object in the Element Command Tree. The box
expands to show the options available.

3. Left click and hold the option Label.

4. Drag and drop the word Label into the Designer window. This will be the title of your
report.

5. Highlight select the word Label by using your mouse to left click and drag over the word.
6. Use your keyboard to type over the word Label and enter a title Asthma Frequency Report.

7. Highlight the title text and use the Tool Bar to change the font style and size to one of
your choosing,.

IVetdana Ll |18 pt j

8. Click the Bold style button.

Ts

9. Use the Text color button to select a new colot.

10. Deselect the text by clicking anywhere inside the blank workspace area.

Your workspace should look similar to the following:
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5 Epi Report - [Ternplated]

i Fle Edt Wew Tooks Windows Help
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L0 - | -
s Pavot et i ' Page Arez Button
Imuage il
Archur ]
Label -
% Drswing Tocks ]
- Ingart Wasiable 1
# Fiead Diata ard Cresie ™
T
o
.

Asthma Frequency Report

u5 [HUM

» To see the workspace area in relation to the printed page, click the Page Area

i

button. A blue dashed line appears around the workspace showing you where page
breaks for printing will appear. Click Page Area again to turn the option off. You
cannot edit the report while the Page Area feature is active. Use the Page Area option
as you add items to the page to ensure that your report elements are inside the
printable page area and to center items in relation to each other and the printable

page area.

11. Select the title text you added to the page.

»  Use the mouse cursor to hover over the text until it turns into a black cross arrow

EI icon, then click to select the text. Four white box handles will appear around the
text to show that it is selected. Text and tables can be resized by clicking and dragging
any of the white handles that surround them when they are selected.

EAsthma Frequgancy Report -©-

0

m]

12. Move the text to the top center of your workspace by hovering over the text until you see
the black cross arrow icon, left click, hold, and drag the title text to the new position on

the page.
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Insert a Line

Use the Drawing Tools menu to drag and drop a Line into your report. Lines can be resized
and edited to act as dividers between sets of information.

1. Click the plus box next to Drawing Tools in the Element Command Tree. The box
expands to show the options available.

2. Select Line and drag it onto the page. The line should have the white bounding box
selectors surrounding it.

3. Click and drag the line under the title text.

4. Resize the line by hovering over the white selection handles. The cursor changes to a

hotizontal arrow -H line.
5. Click and drag the line to resize it. You may have to do this on each end of the line.

6. While the line is selected, right click on the line to open the pop-up menu and select
Properties. The Properties- Line dialog box opens.

= Notice that the line color is gray.

{55 Properties - Line x|

Style Name | :_I

Alphabetic I Categorizedl

Color 0x808080 ~|
Height 1

LineStyle  Solid

Width 395

Color
Select the background color for the line

7. Click the drop-down box in the Color field. The color palette appears.
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8. Click a color block to select it as the line color.

9. Click OK. The line color changes.

10. Click the Height field.

11. Highlight the number 1 and type a 2 over it. This makes the line 2 pixels in height.
12. Press the Enter key on your keyboard to apply the change.

13. Click the Close X to exit the Properties- Line dialog box.
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Insert a Variable

Use the Insert Variable menu to place a date, time, or file path inside your report.

1. Click the plus box next to Insert Variable in the Element Command Tree. The box
expands to show the options available.

2. Click the plus box next to System Variable to expand the menu.

3. Click and drag the variable CurrentDate to the upper left hand corner of the report page.
The date variable updates each time you generate the report to reflect the current date.

4. From the Tool Bar, click the Generate icon. The generated report appears in a new
window.

The report page should look similar to the following:

nesort N

File

@/ &l 9

6/13/2005

Asthma Frequency Report

5. Click the Back icon to return to the workspace.
6. Sclect File>Save As. The Save Epi Report dialog box opens.
7. In the File Name field, type My Epi Report.

8. C(lick Save.
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Using Analysis Data

You can include output created in Analysis in your report data. Information added to the
report and updated in Analysis also updates when you generate the report with Epi Report.
You want to include frequency data for asthmatic conditions from the survey in the report.

1. Click the plus box next to Read Data and Create in the Element Command Tree. The
box expands to show the options available.

= The Read Data and Create options allow you to add data created in Analysis to your
reports. Data can be updated in your report as changes are made in the Analysis
module.

2. Click Read Analysis Output. The Select an XML File dialog box opens.
3. Locate the EIHA Tutorial folder. Notice the Output. XML files in the EIHA folder.

These files were created when the Output. HTML files were created and contain the same
results.

Look in: | 3 EIHA Tutorial ~| & @& ckE-
. _ ) downloads 2 OUTS90. xml 2] ouUTe01 . xml ©out
"?’a’ ‘:';] Frequencies.xml g OUTS91.xml g] oUTE02, xml ‘iﬂ ouT
Histary ‘_;_éjOUTSSI.me ‘_%:ﬂoms92.xml g]oumos.xml :Eﬂom
- - 99 OUTS82, xml 21 oUTS93. xml @ ouTen4.xml ©out
@ 9] OUITSE3. xml 2 OUTS94. xml 2 OUTE0S, xml @ out
Desktop 2] OUTSS4. Xl 27 OUTS95.Xml 27 OUTE0S. Xl 2out
X 27 ouTsEs. xml 2] 0uTS96. xml 2] ouTen7.xml 2jour
% 2] OUTSSE, xml 2] oUTS97. xml 2] OUTE0S, xmi Jout
My Documents il ELeEERRGY 2 OUTS98. xml 2 OUTED. @ out
2] OUTS88. xml 27 oUTS99.xml 2 ouTE10.xml Jout
— 97 OUTS89. xml 29 oUTE00. xml L OUTE1 1. xml @ out

My Computer
4 >
il |« | ol
— File name: I Ll | Open I
My Network P... IS
Files of type: f (ML) =l Cancel I
7

Select the . XML file called Frequencies. This file was created by using the ROUTEOUT
command in Analysis.

Click Open. The Analysis Tables dialog box opens.

Select the table FREQ Asthmatic Conditions. You may have to scroll through the list to
locate the proper table.

Click the single arrow pointing to the Selected Commands field.
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{55 Analysis tables E =

Commands Selected commands

FREQ SchoolNum FREQ AsthmaticConditions
FREQ Gender

FREQ ‘Whionth

FREQ Bronchitis STRATAVAR = SchoolNum
FREQ Asthma STRATAVAR = Gender >>
FREQ Medication

FREQ Zip

FREQ AsthmaticConditions
FREQ Zip

FREQ SchoolMum

<L

ENENERE

i Cancel |

8. Click OK. The Read Data and Create menu updates to show that the information you
selected from the XML file is available for use in your report.

8- Read Data and Create
E-- Read Analysis Output
- B&-Frequencies.xml
@ FREQ AsthmaticConditions
i Field Agaregate
i Line Listing Group
“ Pivot Table

9. Click the plus box next to the menu item FREQ Asthmatic Conditions. The menu
expands to show all the table results in your . XML file.

&-Read Data and Create
B Read Analysis Output
- &-Frequencies.xml
5 FREQ AsthmaticConditions
- Asthma
- 95% Confidence Intervals : Asthma
.- Reactive Ainway Disease
-~ 95% Confidence Intervals : Reactive Airway Disease
- Asthmatic Bronchitislor Wheezy Bronchitis
- 95% Confidence Intervals : Asthmatic Bronchitislor \Wheezy Bronchitis
- ‘Wheezing
“- 95% Confidence Intervals : Wheezing

*  You are going to drag and drop the table results for the four symptoms onto the
report workspace.

10. Select, drag, and drop Asthma, Asthmatic Bronchitis, Reactive Airway Disease, and
Wheezing onto the report individually.
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* Do not drag the 95% confidence intervals.

The workspace should look similar to the following:

5% File Edit View Tools Windows Help

ly Epi Report.EPT]

JSETEY
=18l x|

o=@ H| s

Q)= = B

J [Nomal =] [Times New Roman

oo =2 2 oo T

-

& Insert Report Object

- Drawing Tools

- Insert Variable
&- Permanent Variables
-5 ystem Variable

&-Read Data and Create
&-Read Analysis Output

8- Frequencies.xml

Asthma
95% Confidence Intervals : Asth
Asthmatic Bronchitislor Wheezy
95% Confidence Intervals : Asth
Reactive Airway Disease
95% Confidence Intervals : Rear
Wheezing
95% Confidence Intervals : Whe
Field Agaregate
Line Listing Group
Pivot Table

&-FREQ Asthma Bronchitis RAD Wh i

| I T T T T mea iy,
{Dateh Asthma Frequency Report

Asthma
AsthmaFrequencyPercentCum Percent

3 (G 11375 11375
E [N 82625 100
E Total 800 100 100
E Asth is or Wheezy
3 Asth is or Wheezy itis Frequency ‘um Percent
- ® 26 1075 1075
3 O 714 8025 100
1 Total 200 100 100
E
3 Reactive Airway Disease
— Reactive Airway DiseaseFrequencyPercentCum Percent
] ® o3 11625 11625
1 6] 707 88375 100
T Total 200 100 100
E Wheezing
] Wheezing FrequencyPercentCum Percent
— ® o9 12375 12375
O] 701 87.625 100
Total 800 100 100

]
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Editing Report Elements

Report elements can be edited using the Properties dialog box for the selected element type.
1. Select the Asthma table.

»  Selecting tables works the same way as selecting lines or text. Hover until you see the
black cross arrows and then click. The table will be surrounded by white bounding
boxes.

= De-select a table by clicking anywhere inside the workspace.

*  Resize a table by click dragging the corners of the boxes.

2. Right click the selected table. The table menu opens.

3. Select Properties. The Properties- Table dialog box opens.

{2 Properties - Table x|

Style Name | LI

Alphabetic | Categorized |

Background Color | | O=FFFFFF _'_I
Border Color Il 0000000

Border Size[Pixels) 1

Borders

Cell Spacing(Pixels) 0
Cell Thickness(Pixels) 0
Height Fis)
Width 310

Background Color
Select the backaround color for the table

= Table elements can also be edited separately. For example, if you place your cursor
inside a cell, you can edit properties for the row, column, or cell where your cursor is
placed. In each case, the title of the Properties dialog box changes to indicate which
part of the table you are editing.

*  When you drag a table into your report, the table borders appear in the workspace,
but not in the print preview or on the printed page. Borders must be applied to
appear as part of the report.
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4. Click inside the Borders field of the Properties-Table dialog box. A Browse button
appears in the field.

5. Click the Browse I button. The Choose Border dialog box opens.

{5\ Choose Border j x|

— Border

ceecesece e pE. .-
|
|
'
'
|
'
'
'
|
'
[
R |
'
'
'
'
|
'
'
'
|
'
'

Cancel Apply

6. Click each of the three horizontal borderlines.

7. Click each of the three vertical borderlines.

Click Apply.

9. Click OK. The selected table should have a visible black outline.

10. Click the Border Color field. A drop-down menu appears in the Border Color field.
11. Use the drop-down color palette to select a new color for the table border.

12. Click OK.

13. Select the Cell Spacing (Pixels) field.

14. Highlight the number 0 and type the number 7. Press the Enter key on your keyboard to
apply the cell spacing to your table.
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# Practice

Select each of the tables in your workspace individually and apply the same edits to each of
them. This gives the tables in your project a consistent look.

Add a Border.

Change the Border Color.

Add Cell Spacing.

Your workspace should look similar to the following:

Epi Report - [C:\Epi_Info\EIHA Tutorial\My Epi Report.EPT]

=l8lx]
4% File Edit View Tools Windows Help =8l x
o @ B & 2|k« B
“ L] ;TimesNewRoman L.' |1Upt ll | B r U | I T ‘ =E== |
|whm o wm A
& Insert Report Object
- Drawing Tools Ill[l1 FIP]PIFIF |7I_|l
Pp——— {Date} -
] Asthma Frequency Report
Style Name -
|
Alphabetic | Categorized
I ategonze I As
Background Color || DsFFFFFF =l P Con
Border Color I 0:cooooo 4 ST Percent
Border Size[Pixels) 1 4 o1 11375 |11.375
Boiders D | B3.625_[100
Cell Spacing(Pizels) 1 Total [200 100 100
Cell Thickness(Pixels) 0
Height 75
‘Width 232 Asthmatic Bronchitis or Wheezy Bronchitis
Asthmatic Bronchitis or Wheezy I Cum
RS quency|Percent
Percent
+) 86 1075  10.75
o) 714 89.25  [100
[Total 800 100 100
Reactive Airway Disease
Reactive Airway Cum
Background Color Disease s "] Percent
Select the background color for the table +) 93 11625 |11625
o) 707 88.375 [100
[Total 800 100 100
—3 u] [a]
Wheezing
W heari Cum
. Wheezing Freq ercent| - ot
+) 99 12375 |12.375
- 701 87.625 |100
=3 [Total 800 100 100
< || . =
CAPS [INS - [NUM
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Change Table Fonts

In this section, you will select the text inside each table and choose a new font.

1. Left click and drag to highlight the text inside the Asthma table.

I

m_m_nm
T o o0 N 0O 0

2. From the Tool Bar, use the Font drop-down to select a new font.
* Verdana, Arial, or Tahoma are good choices for this report.
» Leave the Font size at 10.
» Ifyou need to move a table, select it, and use the click and drag method.

= If you need to add more space at the bottom of your page, click the Vertical Space

EL

button.

3. Change the font in each of your tables to match.
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Resize Tables

Tables and report elements can be resized by click dragging the bounding boxes, using the
Tool Bar options, or by using the Properties dialog box.

1.

2.

10.

11.

Select the Asthmatic Bronchitis table.
Right click and select Properties from the menu. The Properties- Table dialog box opens.

*  You can see the size of the table in the Tool Bar or the Properties-Table dialog box.
wle = Hfs =

Height 75
Width 418

Change the Width of the table to 500.

Press Enter on your keyboard to apply the changes.
Change the Height of the table to §0.

Press Enter on your keyboard to apply the changes.
Change the Width and Height of each table in the report.
Re-position the tables as needed.

Save the report.

Click Generate to view the report.

From the generated view, click Print Preview to see how the printed report will
look.

The report should look similar to the following:
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A Print Preview

T
Frint.. |é]|* - ngeh_oﬂ ~ W |@@ 100% '”ﬂeiplglose

61412005 Asthma Frequency Report

Asthma

Asthma

Frequency

Percent Cum Percent

Yes

91

11.375 11.375

No

709

88.625 100

[Total

500

100 100

Yes

Asthmatic Bronchitis or Wheezy Bronchitis
Asthmatic Bronchitis or Wheezy Bronchitis |[Frequency|Percent| Cum Percent

86 1075 [10.75

No

714 89.25  [100

[Cotal

800 100 100

lfes

Reactive Airway Disease

Reactive Airway Disease Frequency | Percent Cum Percent
93

11.625 11.625

No

707 68.375 100

[Total

800 100 100

Wheezing

Wheezing

Percent Cum Percent

[Yes

Frequency
£}

12.375 12.375

No

701

87.625 100

[Total

800

100 100

Astart| | @ G © D@ || Bimbox-mic.. | Fepitoro

| SepiReport ... | ELesson 10... | @@rulshots....

Page 1of 1

-

QEIGODE  wseem

12. Click Close to return to the generate window.

13. Click Back to return to the workspace.
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Insert a New Page

You want to create a new page that contains data on county absenteeism. In this section, you
will insert a page break after the frequency tables. In order to insert pages, you must have the
Pagination Settings activated in the report.

1. Use the Enter key, Vertical Space button, or mouse to move your cursor underneath the
tables in the current report.

2. Sclect Tools>Pagination. The Pagination Setting dialog box opens.

Pagination Setting L X

Select a pagination setting for the template. Please read the help file to lean
about the benefits of each setting.

" Pagination On " Pagination Off
Set Default
Setting DK Cancel Help

3. Click the Pagination On radio button.

4. Click OK

5. Place the cursor where you want a page break to occur.
6. Right click to activate the pop-up menu.

7. Sclect Insert Page Break. A blue dotted line appears.

8. Move your cursor underneath the blue line. This is the top of page two.
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Insert a Table Shell

In this section, you will add a blank table to your report and format the table so that
aggregated data can be added to cells.

1. Open the Insert Report Object menu.

2. Seclect and drag a Label under the blue page break line.

3. Highlight select the Label and title it County Absenteeisms.

4. Seclect the text and use the Tool Bar to select 2 new Font, Size 18, Bold, and Undetlined.
5. From the Insert Report Object menu, select Table Shell.

6. Click and drag a Table Shell onto the report. Place it under the new title so it appears on
the new page.

7. Click in the first table cell and type the text Sww of Missed Days in the County.
8. Click inside the second cell and type the text_Average of Missed Days per Student.
9. Right click in the third cell/column and from the menu select Delete Col.

10. Right click in the third row and from the menu select Delete Row.

Sum of Missed Days in  Awverage of Missed Days
the County per Student
11. Select the table.

12. Resize the table so that the text appears without the wrap.

= Use the corner drag method, the Properties-Table dialog box, or the Tool Bar
options.

Your table should look similar to the following.

Sum of Missed Days in the County  Awerage of Missed Days per Student
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Insert Aggregate Data

Aggregate or summarized data can be included in reports. Aggregate types available in Epi
Report include count, minimum, maximum, percent, sum, and average. In the asthma report,
you want to include the total and average numbers of missed days in the county due to
breathing problems.

1. From the Elements Command Tree open the Read Data and Create menu.

2. Click Field Aggregate. A pop-up menu appears with the option to select ODBC or
MDB.

3. Select MDB. The Select Access Database window opens.
4. Locate the EIHA Tutorial folder and select Asthma Fina. MDB.

5. Click Open. The Select Tables dialog box opens.

{5, Select Tables i x|

Available T ables Tables to Show

alb_race -
Albany_Age
Albany_Eth
Albany_Gender
Albany_race
Albany_Sex
asthmafreq
asthmazip

brfss

brfss2001
Cntésthma
chttest
Countésthma
Count&sthma2 o
CountBronchitis

days

DaysCntT able

DaysTable

daysvar

dayszip

MissedD ays LI

[~ Show View Tables [~ Show Code Tables

oK | Cancel |

6. From the Available Tables field, scroll through the list to find the table called
PrelnterventionSurvey.

7. Select the table.
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8. Click the single arrow button. The table appears in the Tables to Show field.

9. Click OK

10. Click the plus box next to PrelnterventionSurvey to view the available variables.

8- Read Data and Create
E2 Read Analysis Output
- Field Agaregate

= Tables
&- PrelnterventionSurvey
#-Age
Asthma
Bronchitis
ChildFirst
ChildLast
Cough
Dailymed
DOB
Emergency
Gender
Grade
lIHome
Medication
MissD ays
MissSport

.. m

BB BB BB BB BB BB B

8- C:\Epi_InfoAEIHA Tutorial\Asthma Survey 2005.mdb

11. From the PrelnterventionSurvey list of variables, click the plus sign next to MissDays.

The list of available aggregates appears.

- &-MissDaps
-~ Count
- Minimum
- Maximumn
- Percent
- Sum
- Average

12. Select Sum and drag it to the first cell, under the heading Sum of Missed Days in the

County.

13. Select Average and drag it to the second cell under the heading Average of Missed Days

per Student.

{Prelnterventiond

Sum of Missed Days in the County | Average of Missed Days per Student

{Prelnterventiond
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14. Click Generate to see the results appear in the new table.

15. Click Print Preview from inside the Generate Page to see the report on the two pages.
16. Close the Preview window.

17. Click Back in the Generate window to return to the workspace.

18. Place the cursor inside the heading Sum of Missed Days in the County and right click.
19. From the pop-up menu, select Row Properties. The Properties- Row dialog box opens.
20. Sclect the Background Color field.

21. Use the Color drop-down to select a color.

22. Click OK. The color is applied to the selected Row of your table.

Sum of Missed Days in the County  Awerage of Missed Days per Student

{Prelnterventiond {Prelnterventiond

23. Highlight select the text Sum of Missed Days in the County and Average of Missed Days
per Student.

24, Use the Tool Bar to select a new Font, Size 10, and Bold.

25. De-select the text and select the table.

26. Resize the table if necessary.

27. Right click the table and open the Properties- Table dialog box.

28. Add a border to the table.

29. Sclect and drag the table to the top center of your new report page under the title label.
30. Save your report.

31. Generate the report.

32. Print Preview the report.

Page 2 should look similar to the following:
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=

pint. | &) @ & pagefe o2 = | @ & [100% <] Helo | Ciose

Page 2 of 2
County Absenteeism

Sum of Missed Days in the | Average of Missed Days
County per Student
3014 3.7675

-
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33. Close the Print Preview window.

34. Click Back from the Generate window to return to the workspace.
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# Practice

From the Insert Report Object menu, select and drag a new table shell onto the report.

In the first cell of the table shell, right click and select Insert Row. Add rows to the table until
you have 5 rows.

In the first cell of your table, type Syzptoms.

Fill in the first column of the table with the Symptoms from the survey. Your table should
look like the following,

Symptoms
Asthma
Bronchitis
Reactive Airway
Disease
Wheezing

In the first row of the second column, type Tozal Missed Days per Symptom.
In the first cell of the third column, type Average Missed Days per Sympton.

Under Field Aggregate, right click on Tables under the Asthma Survey Final project.

&- Field Agagregate
8- CAEpi_Info\EIHA Tutorial\dsthma Final. mdb
& T ables

Select Edit Tables. The Select Tables dialog box opens.

From the Select Tables dialog box, use the single arrow to add the individual tables
MDAsthma, MDBronchitis, MDRad, and MDWheeze to the Tables to Show section.

Click OK. The list of available tables under the Field Aggregate menu updates.

From the Field Aggregate menu, click the plus box next to each MD table to open the

selections.
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EE -Read Analysis Output
8- Field Agaregate
EE C:AEpi_Info\EIHA Tutorial\Symptoms by Age.mdb
8- CAEpi_Infor\EIHA Tutorial\Asthma Survey 2005.mdb
: =-Tables
Hi PrelnterventionSurvey
=-MDAsthma
: a:a-vCDUNT
- & MissDays
. B VARNAME
=-MDBronchitis
: a:a-vCDUNT
- & MissDays
. B VARNAME
=-MDRad
: a:a-vCDUNT
- & MissDays
. B VARNAME
=-MDWheeze
& COUNT
& MissDays
& VARNAME

LESSON 10

Open the variable MissDays under each table. The list of aggregate values appears.

Drag the word Sum into the Total of Missed Days per Symptom column next to the

corresponding symptom.

Be sure you are dragging the Sum onto the cell that matches the symptom.

Your table should look like the following:

Sumotoms Total Missed Days per Average Missed Days
yp Symptom pet Symptom
Asthma {MDAsthma.sMis
Bronchitis {MDEronchitis.s
Re acti.ve Aitway {MDRad.sMissDa
Disease ~
Wheezing {MDWheeze.sMi

Drag the word Average into the Average of Missed Days per Symptom column next to the

corresponding symptom.

Your table should look like the following:
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LGS Total Missed Days per Average Missed Days
yHp Symptom per Symptom
Asthma { MDA sthma.shis {MDA sthma. alis
Bronchitis {MDEronchitis.s {MDEronchitis.a
Reactive Aitway | I7\DRad.sMissDa = {MDRad.aMissDa
Disease A o
Wheezing {MDWheeze.sMi {MDWheeze.alli

Edit the table to make it look like the Sum of Missed Days table you created eatlier in this

lesson.

Add a cell color to the headings.

Add a border to the table.

Change the font size and style to match the Missed Days table.
Resize the table.

Center the table under the Missed Days table.

Save your report.

Generate the report and then Preview the report.

The report should look similar to the following:
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2} Print Preview N

L) % Pl oe 2 | & @ [100% ~]| Help | Ciose

County Absenteeism

Sum of Missed Days in t v Average of Missed Days per Student
3014 3.7675
Symptoms Total Missed Days per Symptom |Average Missed Days per Symptom
Asthma 99 11
Bronchitis 110 10
Reactive Airway Disease 105 10.5
Wheezing 112 9.3333333333
< |
Hstart||| 1] @ 51 © T B || Blinbox - Micros... | Fepinfo | &)Lesson 10€pi ... | Fhepireport-[C...| @Brushots.01 ... | [GEBIGHEEA  z42em
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Create a Line Listing Group

Line listings are record lists based on queries. Use Epi Report to create the query and then
drag and drop the listing into your report. For the report, you will be creating a line listing of
children with asthma by age group and school.

1.

2.

Insert a page break under the last table on the page.

Drag a Label to the new page.

In the Label area, type the page name Absenteeisn: for School A- Age 7.
Change the Font Style, Size 18, Bold.

From the Element Command Tree under Read Data and Create, select Line Listing
Group.

From the pop-up selector, click Select an MDB File. The Select Access Database window

opens.
Locate and select the SymptomsByAge.mdb. The Query Builder window opens.

= This project is the one you created in Analysis to hold the line graph data for
symptoms by age.

= If you do not have the Epi Graph project, use the SymptomsByAgeSample.mdb
provided.
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fafo Query Builder
Query Name

Bead I Hejalel Sglectl groupl Sort I

Available ltems Available Fields Fields to Show

|

IW] ageandsymptom
] AllSymptoms
] Programs

>>

[E N EE=E

<<

KN I |
[~ Show'View Tables [~ Show Code Tables

Top N Value: I_- ﬁ
Top Percent o

€ 1=

|

View Duery | Clear Query | OK

Cancel |

8. TFrom the Available Items field, click the checkbox next to AllSymptoms. The Available

Fields section populates.

9. Select the SchoolNum field, and click the single area to move it to the Fields to Show

section.
10. Add the following to the Fields to Show section:

= Age, Gender, MissDays, Asthma, Bronchitis, RAD, and Wheezing.
11. In the Query Name field at the top of the window, type SyzptomsList.

Your Query Builder dialog box should look like the following:
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Query Name

Bead ' Flejatel S_e_lectl _G_roupl Sort I

info Query Builder »

Available ltems Available Fields Fields to Show
["] ageandsymptom [AlSymptoms].[DOB] AlISymptoms]. [S choolNurn]
i AllSymptoms]. [Medication] [AlIS ymptoms]. [Age]
[] Programs AlISymptoms].[StudentiD] &lISymptoms].[Gender]
[AllSymptoms]. [Asthma]
[AlISymptoms] [Bronchitis]
[AllSymptoms].[MissDays]
AllSymptoms).[RAD]
[AllISymptoms]).[wheezing)
KN I |
[~ Show'View Tables [~ Show Code Tables
KN I a| K — i
; = |
Top N Value: [—' =
Top Percent H [~ Treat as Yes/No
View Duery | Clear Query | oK I LCancel |
12. Click the Select tab. The Select Criteria options appear.
x
Query Name
ISymptomsLisl
Eeadl Relat §roup| Sort ]
Field Name Operator Yalue
| [alisymptoms] [Age] =l |- =] || ~|
ADD Ciiteria | List Possible Values |
Criteria
View Query Clear Query oK LCancel |
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* To narrow down the listing in this example, you are going to create a line listing of
students from School A who answered Yes to Asthma and equal seven years of age.

13. From the Field Name drop-down, select [AllSymptoms].[SchoolNum]
14. From the Operator drop-down, select =.

15. Click List Possible Values.

16. From the Value drop-down, select A.

17. Click ADD Ciriteria. The Criteria field populates.

= Use the same series of steps to select students who answered Yes to Asthma, and add
their criteria. Hint: Yes, appears as True in the Query Builder.

»  Use the same series of steps to select the students who are seven years of age, and add
their criteria. Hint: Remember to change the Operator drop-down selection.

= If you make a mistake and add the wrong criteria, highlight select it in the Criteria
field and press Delete on the keyboard.

The Select Criteria options should look like the following:

eni

info Select Criteria x|

Query Name

Eeadl Relate Select ' group] Sort I

Field Name Operator Value

| [8ISymptoms] [4sthma] N x| [T =]
AND into Criteria OR into Criteria | List PossibleV/alies |

Criteria

[8lISymptoms].[SchoolNum]= ‘&' _A_]

And [AllSymptoms]. [Asthma)= True
And [AllISymptoms]. [4ge]= 7

.2
View Query | Clear Query | oK I Cancel |

18. Click OK. The Line Listing Group menu now contains the SymptomsList Query you
created.
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19. Click and drag SymptomsList to the work area on page three.

* Resize the table using the bounding boxes.

= Use the Properties- Table box to add borders. When you add a border to a Line
Listing there will be an extra drop-down menu in the Choose Border dialog box. Use

the drop-down to add borders to the Header and the Body of the table.

= Use the Tool Bar to change the font style.

= Use the Tool Bar to change the Heading Fonts to Bold.

The report workspace should look similar to the following:

fato Epi Report - [C:\Epi_Info\EIHA Tutorial\My Epi Report2.EPT]
% Fle Edit View Tools Windows Help

R |
JRETEY

loFad B sme ke~ B

J | Zl lTimes New Roman

he e 2 oo =

[}
1]
11
{1
T
|
5
(]|

e N

- VARNAME Al
MDBronchitis
&-COUNT
=-MissDays
Count
Minimum
Maimum
Percent
Sum
Average
&-VARNAME
MDRad
&-COUNT
=-MissDays
Count
Minimum
Maimum
Percent
Sum
Average
- VARNAME
MDWheeze
&-COUNT
=-MissDays
Count
Minimurm
Maimum
Percent
Sum
Average
- VARNAME
& Line Listing Group
8- CAEpi_Info\EIHA Tutorial\Symptor
SymptomsList
Pivot Table

|

-

ILI

.

1
a
a
a
A

Absenteeism for School A- Age 7

iSchoolNum |Age |Asthma |[Bronchitis |[Gender [MissDays |[RAD

‘Wheezing

l<SchoolNum> |<Age> [<Asthmas [<Bronchitis> [<Gender> [<MissDays> |[<RAD>

<Wheezing>

Ll

20. Generate and Print Preview the report to see page breaks and tables.

21. Close the Print Preview window.

22. Click Back in the Generate window to return to the workspace.

23.

Save the report.
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Insert an Image

For this report, you want to insert the worst month for asthmatic conditions pie graph you
created in Analysis into a new template page. The graph will look best printed in a landscape
style, so before inserting the image, you will use the Page Setup options.

O

1. Click the New Blank Template icon to create a new report.

2. Seclect File>Page Setup. The Page Setup dialog box opens.

3. From the Orientation section, select the Landscape radio button.

ioc Page Setup i x|

— Paper Size

Available Sizes [{RRE]

— Page Header and Footer

Test to be displayed in the Header
[tbPage &p of &P

Test to be displayed in the Footer

[tutbtd

— Drientation — Marains (Inches)
{+ Potrait Left |U~5" ﬁ Right IU‘SH ::.I‘
" Landscape Top |U~5" ﬁ Bottom {0.5" _:_J

0K Cancel '

= Notice the text inside the Page Header and Footer Section. Keeping this text will add
page, date, and file location to your printed page.

* To remove this pre-set information, select the text in the Text to be displayed in the
Header and Text to be displayed in the Footer fields and press Delete on the
keyboard.

4. Click OK
5. Open the Insert Report Object menu.

6. Sclect Image.
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7. Drag Image onto the new report workspace. The Select an Image window opens.

8. From the Files of type drop-down menu, select .BMP Files. All the bitmap files in your
EIHA folder appear in the file section.

9. Seclect the WMonthPieGraph.bmp you created in the Epi Graph Lesson or select the
sample graph WMonthPie2. BMP from the download folder.

10. Click Open. The Worst Month for Asthma pie graph appears in the report.

11. Click the Page Area icon.

12. Scroll to the right and notice the page breaks in the middle of your graph.

13. Turn off the Page Area icon.

14. Select the graph. Bounding boxes appear around the graph.

15. Click and drag the image to the top left of the page.

16. Right click and select Properties. The Properties- Image dialog box opens.

17. In the Width field, type a number to resize the image to fit your computer window.

18. Press Enter on the keyboard. This resizes your graph slightly so that it fits into the Page
Area.

From the Generate>Print Preview window, the report will look similar to the following:
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/2 Print Preview

[Aprintprevien
i |Gl %« pagefi o1 = | @ R[75% ~|| Help | ciose

Worst Month for Asthmatic Gonditions

November 6.7%
Decemboer 3.68%

i
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March 5.7%\
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Augus 6.7%
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e
b

_A8% Jannsary
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19. Select File>Save As. The Save Epi Report window opens.

20. In the File Name field, type WMonth Report.
21. Click Save.

22. Close Epi Report.
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Skills Review

Place a checkmark next to the correct answer for each of the following questions. Refer to
Appendisc D Skills Reviews Answer Key for further details.

1. Which Analysis Output files are accessible by Epi Report?
[ JHTML
[ XML
[ JASP
2. To view a report with complete data included, click what button?
[]Add Vertical Space
[ ]Generate Reports
[ |Preview the Template

3. Aggregate data can be added to reports from the Read Data and Create menu.

[ JTrue
[ JFalse
4. Line Listing groups can be customized from which dialog box?
[ ]Query Builder
[ |Print Preview
[ |Properties
5. What Report Object element is used to insert a graphic into a report?
Dlmage
|:|Object

[ ]Generate
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Lesson Complete!

WHAT YOU LEARNED

How to
= Insert textand line elements into a report template.
=  Use the Properties dialog box to customize inserted elements.

= Insert Analysis XML output into a report.

= Insert Aggregate Data from an Epi Info™ project into a Table Shell.

* Inserta Line Listing Group based on data tables created in Analysis.

* Insert an Image you created in Epi Graph.
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Intermediate Analysis

SUMMARY

This lesson pulls together many of the skills you learned in Lessons 1-10 while adding more
advanced data management concepts. Many skills learned in the Basic tutorial will be
reinforced through the Intermediate Analysis Lesson including, DEFINE, ASSIGN, LIST,
DISPLAY, READ, WRITE, SELECT, GRAPH, and MAP. You will also be introduced to a
new command called RELATE.

This lesson introduces you to ways you can use Epi Info™ to create everyday statistics
needed in epidemiologic work. Use the Tear Out Answer Sheet and To Do List to record
your results as you progress through the lesson. Many of the sections heavily emphasize data
management skills needed to combine a variety of data sources for analysis.

Length of time to complete: 3 hours Intermediate/ Advanced
Scenario

Presentation of the scenario that drives the tasks learned in the Intermediate Analysis Lesson.
In this lesson, you will be preparing and analyzing data that could be used to write a proposal
requesting legislative funds for an asthma initiative. Introduction to Advanced Statistics and
the RELATE command.

Use BRFSS Data

Focus on using data downloaded from the BRESS website to compute lifetime and current
prevalence rates. Introduction to Complex Sample Frequencies.

Use Primary Data

Use the primary data source (800 survey records) to complete a Frequency stratified by
school.

Use Census Data

Focus on using data downloaded from the United States Census website in conjunction with
the original 800 record dataset to compute the county child asthma prevalence.

Mortality Rates

Create a RELATE between a denominator and numerator table to compute the asthma
mortality rate for the county and the state. You will also Graph the rate.

10-Year Trends

Create a graphic representation of 10-year hospitalization discharge rates based on age groups.
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3-Year Rates

Create comparison graphs for 3-year hospital discharge rates for state and county by age.
Mapping Rates

Map asthma hospitalization rates by zip code to determine high risk areas.

Create a Scatter Plot

Create a scatter plot to determine if income affects the rate of asthma hospitalization.
Risk Ratios

Create a program ((PGM) and routeout file to compute asthma risk ratios for a seties of zip
codes. Use the DIALOG command to create a prompt for users.

Use StatCalc

Use the Utility program StatCalc to create an estimate of sample size.

BEFORE YOU BEGIN

Complete all Ten Beginner and Intermediate Lessons.

WHAT YOU NEED

Asthma Final MDB

Tear Out Answer Sheet and To Do List
Appendix F Intermediate Analysis Answer Key
BRFESS2003 Data Table
CensusAge. HTM

Population Data Table

Numerators Data Table
NYDisAgel0Yr Data Table

Age Proxy Data Table

DisCtyAge Data Table

NY3Yr Data Table

Dis0103byZip Data Table
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IncomeData Data Table
RatebyZip Data Table
ALBZCTA_region.SHP
ALBZCTA_region. DBF
ALBZCTA_region.SHX
ALBZCTA_region.PR]

DischargesbyZip Data Table

FIVE GOALS

* Understand data management fundamentals involved in using Epi Info™ with a variety
of data sources.

* Understand the use of the RELATE command and the ways tables can be linked to
create rates.

® Be able to use the DEFINE and ASSIGN commands to create new variables and assign
values to them.

®  Be able to locate prevalence rates and confidence limits from table results.

* Be able to use the SELECT and IF/THEN commands to specify subsets of data that
needs to be managed or analyzed.
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Scenario

The local health department (LHD) director of County X gets notice from the county
administrator/executive that there are discretionary legislative funds for a health initative.
There is a good chance of getting the funding for asthma as the LHD has already done some
work in the area, and will be able to show some results with added funds. The director sits
down with the health education coordinator/planner to identify data that will be needed to
write a strong proposal.

A series of questions and datasets have been developed to aid in the creation of the proposal.
Answers to the questions in the form of data tables, graphs, and maps can be used to illustrate
the need for asthma funding and for writing the proposal. This lesson focuses on preparing
the data for the proposal, but does not cover creating the actual report as Lessons 1-10 did.

Datasets used in this lesson come from a range of sources and will help to show you the
many ways Epi Info™ can be used to manage data sources. Questions deal with the
prevalence of asthma across subgroups and regions as well as hospital discharge and mortality
rates. For this lesson, you will use data downloaded from the BRESS website, the United
States Census website, CDC WONDER, and SPARCS.

See Appendix G: Preparing Data for Use in the Epi Info™ Tutorial for more information on
gathering data and preparing to work with Epi Info™ and Epi Map.

See Appendix I: Data Sources for more information on the provided data sources and web
links to guide you.
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To Do List for Intermediate Analysis Lesson
Expected results and sample .PGMs are listed in _Appendix ' Intermediate Analysis Answer Key.

O

Familiarize yourself with the scenario. You are developing data to aid in the writing of a
proposal to request asthma funding.

Read through the Advanced Statistics section and the information on using the RELATE
command.

Read the What is BRESS information.
Read the How to Get BRESS information.
Use BRESS data to compute lifetime and current asthma prevalence for the state.

Use the 800 records in your primary data source to compute prevalence rates for each of
the schools in the survey.

Familiarize yourself with the Sampling Scheme.

Use data downloaded from the US Census Bureau to create a table with the total
population per age for the county (denominator table).

Use the primary data source to create a table that contains information about the survey
respondents age and sex (numerator table).

Create a weight variable for the county child data.
Create a PSU variable for the county child data.

Compute the county child asthma prevalence using the Complex Sample Frequencies
command.

Relate data from CDC WONDER, the primary data source, and New York hospital
discharge data from SPARCS

Use DEFINE and ASSIGN to calculate the asthma Mortality Rate.
Create a bar graph of the mortality rates.

Use GRAPH to create a line graph that illustrates the 10-year trends in hospitalization for
asthma by age group.

Use GRAPH to create a line graph for the state and a line graph for the county to
illustrate 3-three asthma hospitalization discharge rates.

Use MAP to plot hospitalization rates by zip code.
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O Use GRAPH to create a scatter plot that illustrates how income affects the rate of asthma
hospitalization.

O Use the TABLES command to create asthma hospitalization risk ratios between zip
codes in the state.

O Use the StatCalc program to estimate a sample size for the number of records needed
from a hospital sample to achieve a 95% confidence interval for your statistics.
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Tear Out Answer Sheet

Use this sheet to record your answers in the Answers column as you progtess through the
Intermediate Analysis Lesson. Answers are listed in _Appendix F Intermediate Analysis Answer Key.

A. Questions in the lesson are marked with a letter

Computing Prevalence- Using BRFSS Data Results
A. What s the lifetime asthma prevalence among adults in the
state?
B. What s the current asthma prevalence among adults in the
state?
C. Is the state adult asthma prevalence rate higher in the subgroup Males-
gender? Females-
D. s the state adult asthma prevalence rate higher in the subgroup | Hispanics-
ethnicity?
Primary Data- 800 Records Results
E. From the school asthma survey data, what is the difference in | School A-
prevalence rates? School B-
School C-
School D-
Census Data Results
F. Whatis the county childhood asthma prevalence?
G. What is the county childhood asthma prevalence for the Males-
subgroup gender? Females-
Mortality Data Results
State 2000-

H. Is the asthma mortality rate for the state and county
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Mortality Data Results
significantly different? State 2001-
State 2002-
County 2000-
County 2001-
County 2002-
10 Year Trends- Hospital Discharge Data Results
I. s the rate of hospital discharge for asthma increasing or
decreasing in any age groups?
3 Year Rates- Hospital Discharge Data Results
J.  Are there significant differences in the 3-year asthma discharge
rates for the state versus the county by age?
Mapping Rates Results
K. Based on the map with hospitalization rates by zip code, which
areas have the highest hospitalization rates for asthma?
Scatter Plots Results
L. Does income appear to affect the rate of hospitalization for
asthma?
Risk Ratios- Hospitalization Data Results
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Risk Ratios- Hospitalization Data Results
M. What is the risk ratio of being hospitalized for asthma if you

live in the zip code 12202 versus if you lives in the zip code

122117
StatCalc Results

N. From the New York hospital discharge data, how many
records do you need to sample to get a 95% confidence
interval from a sample size of 389987
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Advanced Statistics

The Complex Sample Frequencies (FREQ), Complex Sample Tables (TABLES), and
Complex Sample Means (MEANS) commands in the Analysis program perform statistical
calculations that assume data comes from simple random (or unbiased systematic) samples. In
many survey applications, more complicated sampling strategies are used. These may involve
sampling features like stratification, cluster sampling, and the use of unequal sampling
fractions. Surveys that include some form of complex sampling include the coverage surveys
of the WHO Expanded Program on Immunization (EPI) (Lemeshow and Robinson, 1985)
and CDC’s Behavioral Risk Factor Surveillance System (Marks et al., 1985).

The CSAMPLE functions compute proportions or means with standard errors and
confidence limits for studies in which the data did not come from a simple random sample. If
tables with two dimensions are requested, the odds ratio, risk ratio, and risk difference are also
calculated. Data from complex sample designs should be analyzed with methods that account
for the sampling design.

The following sections rely heavily on a new command called RELATE. The RELATE
command allows you to link one or more tables to the current dataset using a common
identifier (key) to find matching records. The key can include several matching fields. The
linked tables remain separate.
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RELATE Command

To use RELATE, at least one table must have been made active with the READ command.
The table to be linked must have a key field that has identified related records in the two
tables. The keys in the main and related tables or files do not have to have the same name.

After issuing the RELATE command, the variables in the related table may be used as though
they were part of the main table. Where variable names are duplicated in the related tables, the
variable names will be suffixed with a sequence number.

Frequencies, cross-tabulations, and other operations involving data in both the main and
related tables can be performed. You can also use the WRITE command to create a new
table. More than one table can be related to the main table by using a series of RELATE

commands.

Creating a Related Table in Analysis
Creating a One-to-Many Relationship

TABLE 1 TABLE 2

Parent or Main Table Child or Dependent Table
Variable1 Variable2 Variable3 VariableA VariableB VariableC
The RELATE command creates

a temporary relationship
between the two tables.

Build Key Variable1 Build Key VariableA
You can have multiple Build Keys.
Parent Tables must contain a unique

The tables remain separate, but
value.

the data can be used together.

To create a permanent
relationship, you could use the
WRITE command to create a
new data table.

RELATED TABLE

Data is related in one table
based on Variable1 from Table
1 and VariableA from Table 2.
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What is BRFSS?

The Behavioral Risk Factor Surveillance System (BRESS) is a state-based system of health
surveys that generates information about health risk behaviors, clinical preventive practices,
and health care access and use primarily related to chronic diseases and injury. The BREFSS is a
cross-sectional telephone survey conducted by state health departments with technical and
methodological assistance provided by the CDC. Every year, states conduct monthly
telephone surveillance using a standardized questionnaire to determine the distribution of risk
behaviors and health practices among non-institutionalized adults. The states forward the
responses to the CDC, where the monthly data are aggregated for each state. The data are
returned to the states, and then published on the BRFSS Web site. BRESS interviewers ask
questions related to behaviors that are associated with preventable chronic diseases, injuries,
and infectious diseases. States use standard procedures to collect data through monthly
telephone interviews. (National Center for Chronic Disease Prevention and Health
Promotion http://www.cdc.gov/brfss/fags.htm#1)

How to Get BRFSS Data

BRISS data is readily available and can be downloaded from the BRESS website at
http://www.cdc.gov/brfss/index.htm.

This section of the tutorial deals with year 2003 data downloaded from the BRFSS website.
Data can be downloaded into a variety of formats. For this lesson, you will be working with
data derived from a .DBF file. The original .DBF was extracted to a folder on the local drive.

The file was Read into Analysis. Analysis accepted the first 255 variables included in the
dataset. The .DBF file contained over 264,000 records. This encompasses all the records for
surveyed areas.

For this example, you are working with records from New York State. You would select only
the records for New York and then write those records to a new file.

To obtain only the information dealing with a specific topic, in this case asthma, you would
visit the BRESS website and obtain detailed information on which variables pertain to asthma
and also the codes used to signify race, gender, ethnicity, etc. Once you know the variable
names, you can select only the questions/vatiables related to asthma and write those to a new
table. This brings the record count down to 5,544.

Because of how the BRESS is conducted (multi-stage sample process) with variables that are
not equally weighted you will use the C-Sample (complex sample routines) instead of normal
tables and means commands. The BRESS dataset contains variables for Weight, Primary
Sampling Unit (PSU), and Stratification, already computed as part of the table.

For this example, due to the large size of the dataset, the BRESS data has already been
downloaded and written out to a new file specifically dealing with asthma data. You can use
the data table contained in the Asthma Final project to compute the prevalence of lifetime
and current asthma in the state of New York. The Asthma Final project contains a table
called BRESS2003 for use in the following lesson.
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Read/Import the BRFSS Data

To compute the prevalence using BRESS data, you can use the Analysis command Complex
Sample Frequencies. Complex Sample Frequencies can be used to determine the following
prevalence rates needed for your proposal.

A. What s the lifetime asthma prevalence among adults in the state?

To get the prevalence for the county, you could use Expanded Behavioral Risk Factor
Surveillance System (EBRFSS) data, if it is available to you. You can determine increase or
decrease by following the same steps outlined below, but use prior year or later year data. You
would need to download, select, and format data for the requested year from the BREFSS
website.

1. Click Analyze Data. The Analysis module opens.

2. From Command Tree Options folder, click Set. The SET dialog box opens.

SET ' X
Representation of Special Values
YES as NO as MISSING as
I@ ~| |No ~| | Missing ~|
[v Show Complete Prompt [v Show Selection Criteria
[v Show Graphics [v Show Percents
[v Show Hyperlinks [v Show Tables in Output
Statistics (" None " Minimal
" Intermediate {« Advanced

[~ Include Missing

Process Records (« Normal (undeleted) { Deleted
" Both
Save all Save Only OK
Reset Help Cancel

3. From the Statistics section, select the Advanced radio button.
4. Click OK

5. From the Command Tree Data folder, click Read/Import. The READ dialog box
opens.
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6. Click Change Project.
7. Locate the EIHA_Tutorial folder and select the project file called Asthma Final. MDB.
8. Click Open.

9. Click the Show All radio button. The All field populates with all the tables in the project.
ReaD x|

Current Project
|C:'lEpi_Inf01EIHA Tutoriall/Asthma Final.mdb

Data Formats
| Epi 2000

=
Data Source
[C:lEpi_lnfolElHn Tutorial'Asthma Final.mdb __l

—Show
" \Views t« All

All
AlbSchSum 4|
=l

albtotal

asthmafreq

AsthmaTable

asthmazip

censusiyr

census515 _'_]

Change Project Save Only OK

Clear Help Cancel

10. Select the BRFSS2003 table.

11. Click OK. You should have a record count of 5,544. This is the number of records for
the state of NY.

12. From the Command Tree Variables folder, click Display. The DISPLAY dialog box
opens.

13. Click OK to see all the variables in the table.

* These variables were selected out of the larger dataset and written to this new table
called BRFSS2003. Information in this table pertains only to New York for the year
2003.

* By consulting the BRESS website, you know that the calculated variable that contains
information on the lifetime prevalence of asthma is called _LTASTHM. Since you
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imported the file as a .DBF, the variable name contains a prefix of A to compensate
for the space field. The variable you need to figure the prevalence is called
A_LTASTHM. This is a calculated variable based on the BRFSS question, "Have you
ever been told by a doctor, nurse, or other health professional that you had asthma?"

* By using the DISPLAY command, you can also see that the majority of variables

have been coded as Numbers.

14. Create a Frequency of the A_ LTASTHM.

[A_LTASTI{[VI lFrequency IPercent |Cum Percent ,

1 | 4875| 87.9%| 87.9% |
2 [ 660 11.9% 99.8% |
9 | 9 02%  100.0%
Total | 5544/1000% 100.0% |

= Notice the frequency produces results for NO answers (the number 1) and YES
answers (the number 2). There is also a number 9 that indicates missing values. To
enhance your statistics, you want to remove the missing values from the calculations.
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Create an If/Then Statement

In Lesson 2 Check Code, you created an IF/THEN statement to create a skip pattern. Now
you will use Analysis to create an IF/THEN statement that removes missing values from
your statistics. The IF dialog box in Make View and Analysis are the same; however, the
navigation from the THEN is slightly different, rather than selecting from the tabs as you do
in the Make View Program Editor, you will select from the Command Tree.

You are making the statement that IF the value of A_LTASTHM is 9 THEN it will be
considered Missing. Missing values will not be included in the statistics because you did not
select to include them when you opened the SET dialog box in the previous section.

1.

From the Command Ttee Select/If folder, click IF. The IF dialog box opens.

G X
If Condition
|

Ly .
Available Variables Ll . | = | I = | <| > | &I " | (J U
I —‘| AND OR "Yes" “"No" "Missing"
Then | Else l
Functions | saeony | oK |
Clear | Help | Cancel |

From the Available Variables drop-down, select A_LTASTHM. The If Condition field
populates.

Click =.
Type the number 9.

Click Then. The Command Tree window activates.
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THEN Block

&+ Analysis Commands
i Data
Read (Import)
Relate
Write (Export)
Merge
Delete File/Table
Delete Records
Undelete Records
i Variables

Define
S Rezodd

)

Display
i Select/If
Select
Cancel Select
If
Sort
Cancel Sort

6. From the Command Tree Variables folder, click Assign. The ASSIGN dialog box opens.
7. From the Assign Variable drop-down, select A_LTASTHM.
8. Place your cursor in the =Expression field.

9. Click Missing.

x

Assign Variable
IA_LTASTHM _vj
= Expression

3]

{ 2
Available Variables -] =]<|>|&]"]| (])
I El AND | OR | "Yes® | "No" |"Missing"

Functions | |
clear | Help | cancel |

10. Click Add. The IF dialog box opens.
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=
If Condition
A_LTASTHM=9
f o
Available Variables ...J _I* { |=|< >|&|"| (J )
I A-LIASIIS ‘:J AND OR "Yes" “No" "Missing"
i Else I
ASSIGN A_LTASTHM=(.)
Functions | saveony | oK |
Clear | Help | Cancel I

11. Click OK. Your code appears in the Program Editor:

IF A_LTASTHM=9 THEN

ASSIGN A_LTASTHM= ()
END
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Complex Sample Frequency

Now that the Missing values have been excluded, you can compute the prevalence.

1. From the Command Tree Advanced Statistics folder, click Complex Sample
Frequencies. The Complex Sample Frequencies dialog box opens.

ILL | Freq|%
+ |20 |[35%
— | 37 |esm

Total| 57 |100%

Weight

I =
PSU

I =
Output to Table

Complex Sample Frequencies R.

X
Frequency of Stratify by
| BN 3
[~ Al (*) Except
saveony || oK |
Clear Help | Cancel l

2. From the Frequency Of drop-down menu, select A_ LTASTHM.

3. From the Weight drop-down, select A_ FINALWT. The Weight variable has been
computed for you, and is part of the BRESS data. To find out how this variables is
calculated refer to the BRESS website.

When variables are not weighted, each record counts as the same, one record
represents one person. Weighting attempts to compensate for circumstances where
variables must represent more than one individual due to the sampling process, one
record may count as 100 people, depending on the sample size. Weighting may also
be needed when you do not have the original data, but only summarized data
showing frequency of particular responses.

. From the PSU drop-down menu, select A_PSU. The PSU is the Primary Sampling Unit.

The PSU variable has been computed for you and is part of the BRESS data. To find out
how this variables is calculated refer to the BRESS website.

In cluster sampling, the PSU represents the clusters from which the samples were
drawn randomly; the clusters themselves are selected from a set of similar clusters,
which together include all of the population to be sampled. The random sample of
the population from the random sample of clusters is taken as a proxy for a random
sample from the population as a whole. Complex sample analysis attempts to adjust
for the reduction of variance due to the fact that each member of the population did
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not have a uniform probability of selection. Clusters are rarely chosen on the basis
of variables such as age, gender, or race.

5. Click OK Results appear in the Output window.
The code in the Program Editor looks like this:
FREQ A_LTASTHM WEIGHTVAR=A_FINALWT PSUVAR=A_PSU

Your Output looks like the following.

A LTASTHM TOTAL
1 4875
Row % |100.000
Col % | 88.306
SE% | 0.507
LCL% | 87.313
UCL % | 89.300
2 660
Row % 100.000
Col @ Prevalence

SE% | 0.507
LCL 10.700

oL 1 2.5 Confidence Intervals
TOTAL 5535
Design Effect| 1.378

* The confidence intervals give you the range of values where the prevalence can fall
based on the existing variables and conditions. For this example, the lifetime
prevalence is 11.7; however, the confidence intervals tell you it could be as low as 10.7
or as high as 12.7.

* If you wished to determine if the prevalence is increasing or decreasing, you would
need to download several years of data from the BRESS website and complete similar
steps to determine the variable names and values. Using the WRITE command, you
could create a table to hold data for each year in one location.
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# Practice

B. Whatis the current asthma prevalence among adults in the state?
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Compute the current adult asthma prevalence, using the same series of steps for the
A_CASTHMA variable.

By consulting the BRESS website, you know that the calculated variable that contains
information on the current prevalence of asthma is called _CASTHMA. Since you imported
the file as a .DBF, the variable name contains a prefix of A to compensate for the space field.
The variable you need to figure for prevalence is called A_ CASTHMA. This is a calculated
variable based on the BRFSS question, "Do you still have asthma?"

First, exclude the missing variables using the If/Then statement.
IF A CASTHMA=9 THEN

ASSIGN A CASTHMA= (.)

END

Click Complex Sample Frequencies.

Create a Frequency of A_CASTHMA using the Weight of A_FINALWT and the PSU of
A_PSU.

Results appear in the Output Window:
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A_CASTHMA TOTAL

5079

100.000

92.362

0413

91.553

93.170

439

100.000

INTERMEDIATE ANALYSIS

Prevalence

Confidence Intervals

TOTAL

Design Effect
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Selecting Subgroups

To strengthen your proposal, you would like to compare asthma prevalence rates among
subgroups in the state and see if there are differences.

C. Is the state adult asthma prevalence rate higher in the subgroup gender?

Subgroups available in the BRESS data include age, sex, ethnicity, and race. Gender in the
BRESS dataset is coded as the number 1 for males, and the number 2 for females. To
compute the prevalence for each group, you will use the SELECT command.

1. From the Command Ttree Select/If folder, click Select. The SELECT dialog box opens.
2. From the Available Variables drop-down, select Sex.
3. Click =.

4. Typel.

N lq

Select Criteria
SEX=1

‘ I
Available Variables Ll - | |1 I = | <| > I &I " | { I )
| SEx =l o [ or [ s | Nor [missing®

Functions I Save Only I | OK I

Clear I Help I Cancel |

5. Click OK There are 2,172 males in the survey.

6. Click Complex Sample Frequencies. The Complex Sample Frequencies dialog box

opens.
7. Select A_LTASTHM from the Frequency of drop-down box.
8. Seclect a Weight of A_FinalWT.
9. Selecta PSU of A_PSU.
10. Click OK.

11. Click Cancel Select.
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# Practice

Compute the prevalence for the subgroup women.
Select Sex=2. You should have 3,372 recotds.

Click Complex Sample Frequencies. Use the BRESS Weight and PSU variables to
compute the prevalence of the variable A_LTASTHM. Record the results on your answer
sheet.

Click Cancel Select.
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Complex Sample Tables

To strengthen your proposal, you would like to compare asthma prevalence rates among
subgroups in the state and see if there are differences.

D. Is the state adult asthma prevalence rate higher in the subgroup ethnicity?

Use the BRFESS data to compute the lifetime prevalence rate for the subgroup ethnicity. You
will use the Complex Sample Tables command to compute for prevalence and the odds ratio.

In the BRESS data table, Ethnicity is categorized in the variable HISPANIC2 with Yes
answers coded as 1 and No answers coded as 2. The lifetime prevalence of asthma is
categorized in the variable A_LTASTHM with No answers coded as 1 and Yes answers
coded as 2. To compute with accuracy using Complex Sample Tables the first value in order
must represent YES and the second value in order must represent NO. You will need to do
some data management to set up your tables in the proper sequence.

Your current data table looks like this:

Variable Answers and Codes
A_LTASTHM 1=NO, 2= YES
HISPANC2 1=YES, 2=NO

You want it to look like this:

Variable Answers and Codes
A_LTASTHM 1=YES, 2= NO
HISPANC2 1=YES, 2=NO

In order to get the YES/NO values to match in the proper order, you will create an IF
/THEN to statement to ASSIGN newly defined vatiables. The IF statement will remove the
Missing variables and reverse the order of the coded 1s and 2s using a mathematical
statement.

DEFINE a new lifetime asthma prevalence variable and ASSIGN it using an
IF/THEN statement.

1. Read in the data table BRFSS2003.
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From the Command Tree Variables folder, click Define. The DEFINE dialog
box opens.

In the Variable Field Name field, type YNAsthma.

Click OK.

Click IF. The IF dialog box opens.

From the Available Variables drop-down, select A_LTASTHM.
Click the greater than > operator.

Type in the number 2.

= The IF Condition dialog box should read A_LTASTHM>2.

Click THEN. The Command Tree highlights.

10. Click Assign. The ASSIGN dialog box opens.

11. From the Assign Variable drop-down, select YN Asthma.

12. Move the cursor to the =Expression field and click Missing.

ASSIGN x|
Assign Variable
| YNasthma ~]
= Expression
)
y >
Available Variables Ll . I = |y I = I <| > I &I u | ( I U
I j AND OR "Yes" "No" "Missing"
Functions | Add I
Clear | Help Cancel |

13. Click Add. The IF dialog box opens.

*  You have removed the values of 7 and 9 by stating that IF the value of
A_LTASTHM is greater than 2, THEN the values are assigned as Missing.

14. Click ELSE. The Command Tree highlights.

15. Click Assign. The ASSIGN dialog box opens.
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16. From the Available Variable drop-down, select YNAsthma.
17. Move your cursor to the =Expression field and type, 3-4_LTASTHM.

* You are assigning the variable a mathematical statement that says
YNAsthma=3-A_LTASTHM, in other words, the variable YN Ashtma=3-2
ot 3-1. This reformats the Yes/No values into the proper order with 1 now
being Yes and 2 being No and also places them in the proper sequence with
the Yes value coming first in the series.

AssIGN x|
Assign Variable
|YNn.sthma |
= Expression
3-A_LTASTHM
y |
Available Variables +J_|* !J=|< >|&|..|(J)
IA'LmSTHM —VJ AND OR "Yes" "No" "Missing"
Functions | Add |
Clear | Help Cancel I

18. Click Add. The IF dialog box opens.

If Condition

X

e S Lol L] 8l o)

A_LTASTHM>2
« 2

AND OR “Yes" "No" | “Missing"

Then

ASSIGN YNAsthma= (.) ASSIGN YNAsthma=3-A_LTASTHM

Functions | Save Only | oK

Clear | Help | Cancel
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19. Click OK. Now you need to define and assign values for a new HISPANC2
variable.

DEFINE a new Ethnicity variable and ASSIGN it using an IF/THEN statement.

1. Click Define and create a new variable called Hisp.

2. Click OK.

3. Click IF. The IF dialog box opens.

4. From the Available Variables drop-down, select HISPANC2.

5. In the IF Condition field, type >2.

6. Click THEN. The Command Tree highlights.

7. Click Assign. The ASSIGN dialog box opens.

8. From the Assign Variable drop-down, select Hisp.

9. Move your cursor to the =Expression field and click Missing.

10. Click Add. The IF dialog box opens.

11. Click ELSE. The Command Tree highlights.

12. Click Assign. The ASSIGN dialog box opens.

13. From the Assign Variable drop-down, select Hisp.

14. Move the cursor to the =Expression field and type HISPANC2.

= Since the coded values for the variable Yes and No are in the correct order

inside the variable HISPANC2, you do not have to create the mathematical
functions that changes their values.

15. Click Add. The IF dialog box opens.

16. Click OK.

View the results of your IF/THEN statements and create a Complex Sample Table.

1. From the Command Tree Statistics folder, click Frequencies. The FREQ dialog
box opens.
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2. From the Frequency Of drop-down, select Hisp, HISPANC2, YNAsthma, and
A_LTASTHM.

3. Click OK. View the results and how the IF/THEN statements you created
altered the results and the table structure.

4. From the Command Tree Advanced Statistics folder, click Complex Sample
Tables. The TABLES dialog box opens.

5. From the Exposure Variable drop-down, select Hisp.

6. From the Outcome Variable drop-down, select YNAsthma.
7. From the Weight drop-down select A_ FINALWT.

8. From the PSU drop-down, select A_PSU.

9. C(lick OK. View the results.

| YNAsthma
S | 1 2 TOTAL
1 2|  494| 576

|[ Row @[ 11.197| 38 The Lfetime prevalence of
| Col % rﬁﬁ;ﬂ 18] asﬂ?ma among Hispanics.
| SE%| 1393 1.393]
|
|
|
|

LCL%| 8468| 86.073|
UCL%| 13.927| 91,532
Design Effect| 1.124| 1.124
6 '

9 The Efetime prevalence of
asthma among non-Hizpames.

| Col % | 84 459 B3561
| SE%| 0545 0545
| LCL% | 10.784| 87.079|
| UCL%)| 12921 89.216|
|
|

Design Effect|  1.399 1399
TOTAL | 658 4838| 5496

Row¥ | 1 1.745 | o The lifetime prevalence of
Colv _ 100 asthma for the state population.

l
|
| SE%| 0510] 0510
|
l
|

LCL% | 10.745| 87.256 |
UCL%| 12744 89.255|
Design Effect|  1.379| 1379
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Scroll down to view the Odds and Risk Ratios and the Standard Error and
Confidence Limits.

CTABLES COMPLEX SAMPLE DESIGIN ANALYSIS OF2 X 2 TABELE

Cdds Batio (OF) 0.938
Standard Error (SE) 0,147
95% Cont’ Lareats (0.70, 1.257)

Risk Fatio (RE) 0.945
standard Error (5E) 0,125

939 ~Tarmnts (0.73, 1.223)
= (Bisk of TIAsthma=1 if Hisp=1) / (Bisk of T Asthma=1 i Hisp=

Eisk Difference (ED%0)- 0,655
standard Error (5E) 1,426

5% TS 0, 2.2/ )
= (Risk of Y Asthma=1 if Hisp=1) - (Eisk of Y Asthma=1 of Hisp=¥)

Notice that your tables are set up in the proper order and sequence with Yes to Asthma
and Yes to Hispanic over Yes to Asthma and No to Hispanic.

You could use county data from the Expanded BRESS to answer other questions in the same
manner. To answer questions and comparisons related to county or EBRFSS data you would
follow the same process as above. You could use this process to answer these types of
questions:

= Is the county adult asthma prevalence higher or lower than the state?
= Is the county adult asthma prevalence higher in some population subgroups?

* How do county population subgroup patterns relate to the state sub-group patterns for
asthma prevalence?
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Create a Frequency

You can use the 800 records used as your primary data source to find prevalence rates for the
individual schools in the survey. For your proposal, this data represents the child population
in the county.

E. From the school asthma sutvey data, what is the difference in prevalence
rates?
To find the difference in prevalence rates between the four schools in the survey, you will

create a frequency of asthma and stratify by School Number.

1.

2.

Click Read/Import. The READ dialog box opens.

From the project Asthma Final, select viewPrelnterventionSurvey.
Click OK. You should have the 800 records from the survey.
Click Frequencies. The FREQ dialog box opens.

From the Frequency Of drop-down menu, select Asthma.

From the Stratify By drop-down menu, select SchoolNum.

Click OK. The Output window populates with one table for each school.
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Sampling Scheme

The dataset Asthma Fina.MDB contains the 800 records you worked with throughout the
Basic tutorial. You are going to use this data to represent all the schools for the county and all
the children surveyed for the county in order to compute the county childhood asthma
prevalence.

To do this, you need to think in terms of the sampling scheme of the schools in relation to
the county. For this example, you will be following the sampling scheme below, and use it to
make your assumptions about the results you find, and how your data is selected and
organized:

= All four elementary schools were chosen.

= A number of classrooms for each school were chosen at random until the number of
students in the chosen classes was about 400 at each school.

= Half of the kids from each of the classrooms were chosen at random to be surveyed.

= The cluster is the classroom within each school; however, classroom information was not
recorded, so age was used as a proxy for classroom.

®  The Primary Sampling Unit (PSU) is SchoolNum and Age (Use cut-off for school year
September 1, 2005).

You need to create a Weight for the schools to the county population by age and sex in order
to get a county estimate of prevalence and be able to compute for a subgroup. In the
following lesson, you will create a table that contains the sex and age data for the 800 records.

You will use the RELATE command to join the sex and age table created from the 800
records to the population table you are going to create, based on data from the United States
Census. The Weight Variable will be the county population divided by the survey population
first for males, and then for females. In this data, there is a number in the general population,
which each respondent of a particular age and sex represents, so you will compute a Complex
Sample Frequency where the PSU is SchoolNum and Age (this is a grouping field, not a
numeric field).

From this data, you will a get a county estimate of prevalence by sex for the selected age
group (based on the survey age groups).

In the following sections you will use your data management skills to
®  Import and format HTML data

= Create a numerator table using the HTML data

* Relate tables

®  Create a Weight Variable
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®  Create a PSU Variable
= Compute the prevalence

The ultimate goal is to obtain the asthma prevalence for children in the county. The formula
used will be the number of cases of asthma in the survey divided by the population of the age
group for the county (from the HTML Census data).
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Import Census Data/HTML Format

You want to include some information on childhood asthma in your proposal. Use the 800
records from your primary data source and data from the Census Bureau to compute the
childhood asthma prevalence rate for the county.

F. Whatis the county childhood asthma prevalence?

G. What is the county childhood asthma prevalence for children in the subgroup Gender?

To compute the prevalence rate, you need population data for the age group in the survey.
Population data for this example was downloaded from the Census website. www.census.gov.
Data was downloaded for Albany County by single years for age and sex.

For this lesson, you will be importing an .HTML file that was downloaded from the United
States Census Bureau website. You will then format the data to use as your county child
population. The prevalence will be determined by dividing the number of cases of asthma in
the survey by the population of the age group for the county.

1. Click Read/Import. The READ dialog box opens.

= Be sure your current project is Asthma Final. If it is not, click Change Project and
select Asthma Final.

2. From the Data Format drop-down, select HTML.

3. Click the Browse button in the Data Source field. The READ window opens.
4. Locate and select the HTML file called censusage.htm.

5. Click Open.

6. Sclect TABLE 284:1. The HTML window appears so you can see how the information
looks.

7. Close the HTML window.

8. Click OK. The READ Temp Link dialog box opens.
9. Type the link name CensusLink.

10. Click OK. You should have 42 records.

11. From the Command Tree Variables folder, click Display. Notice that numeric fields
were imported as text and that the variable names reverted to the column number.
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12. Click List to view the data. Notice that there are commas in the records.

*  You will need to reformat the fields containing commas, use the text to number
format command, and define/assign new vatiable names to use this data.

13. From the Command Tree Data folder, click Write/Export. The WRITE dialog box
opens.

14. From the Output Mode section, click the Replace radio button.
15. Click the Browse button from the File Name field.

16. Locate and select the Asthma Final project.

17. Click Save.

18. In the Data Table field, type Censustormat.

]
Output Mode

v All(* [~ All{*y Except lr(“ Append (+ Replace
Variables Output Formats
Age | Epi 2000 |
2::222; File Name
Males_per femal IC:Epi_IMOEIHA TutorialAsthma Final.mdb J
Col5 Data Table
ol | v
Col7 —I
Col8

Browse | Save Only | OK |

Clear I Help | Cancel |
19. Click OK.

*  You now have a new data table called CensusFormat that contains all the information
imported from the Census HTML file.
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Formatting with List Update

The following formatting instructions can be used when working with any files imported into
Analysis, including HTML or MS Excel files.

1.

2.

Click Read/Import. The READ dialog box opens.

Click the Show All radio button.

Select the CensusFormat table you created in the previous lesson.

Click OK. You should have the same 42 records.

Click List. The LIST dialog box opens.

From the Display Mode section, select the Allow Updates radio button.

VYariahles

LIST i

*

[~ All{*) Except

El

x|

Display Mode

Clear

" Wieh (HTML)

Save Onhy OK

Help Cancel

7. Click OK A grid table appears with all your variables listed.

* From this grid table, you can make changes to the data in your records. Keep in mind

that changes made in this mode are saved and cannot be undone.
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8. Place your cursor in the Age column on the record for 5 years.

For this example, you are interested in the 5-12 year age groups that correspond to
the survey ages. You are going to alter only those records, then select them, and place

them in a new table.

_oix
Age Number Percent tales per fema| Cal5 Col6
» Male Female Both sexes Male Female
Total  population | 294,565 140,885 153,680 100.0 100.0
Under 5 years 16,649 8610 8,033 5.7 6.1
Under 1 year 3192 1,661 1,631 1.1 152
1 year 331 1,738 1573 1.1 1.2
2 years 3.303 1,696 1,607 1.1 1.2
3 years 3.392 1,727 1,665 1.2 1.2
4 years 3.451 1,788 1,663 1.2 1.3
5to 9 years 18,944 9,768 9,176 6.4 6.9
5 years 3537 1,821 1716 1.2 1.3
6 years 3638 1,838 1,800 1.2 1.3
7 years 3.777 1,930 1,847 1.3 1.4
8 years 3,948 2,076 1,872 1.3 15
9 years 4,044 2,103 1.941 1.4 15
10to 14 years 19,432 9,967 9,465 E6 71
10 years 3,958 2,051 1,907 1.3 15
11 years 3,825 1,964 1,961 1.3 1.4
12 years 3,929 2,033 1.896 1.3 1.4
13 years 3.837 1,937 1,900 1.3 1.4
14 years 3,883 1,982 1,901 1.3 1.4
15to 19 years 22,227 11,143 11,078 75 79
15 years 3,893 1,979 1,914 1.3 1.4
16 years 3.836 2,01 1,825 1.3 1.4
17 years 3.723 1,893 1,830 1.3 1.3
18 years 5116 2,506 2,610 17 1.8
19 years 5,659 2,760 2,893 19 20
20to 24 years 22,609 11,123 11,486 7.7 79
20 years 5,460 2,710 2,750 19 19
21 years 5,146 2,547 2,599 1.7 1.8

9. Highlight the text and type the number 5.

10. Repeat this process for the years 6, 7, 8, 9, 10, 11, and 72. Do not alter the total fields.
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ol
Age Number Percent Males_per fema| Cal5 Col6
Both sexes Male Female Both sexes Male Female
Total  population | 294,565 140,885 153,680 100.0 100.0
Under 5 years 16,649 8,610 8,039 5.7 6.1
Under 1 year 3192 1,661 1,531 1.1 1.2
1 year 331 1,738 1573 1.1 1.2
2 years 3.303 1,696 1,607 1.1 1.2
3 years 3,392 1,727 1,665 1.2 1.2
4 years 3,451 1,788 1,663 1.2 1.3
5to 9 years 18,944 9,768 9,176 6.4 69
5 3537 1,821 1,716 1.2 13
5 3638 1,838 1,800 1.2 1.3
7 3,777 1,930 1,847 1.3 1.4
g 3.948 2,076 1.872 1.3 15
9 4,044 2,103 1,941 1.4 15
10to 14 years 19,432 9,967 9,465 B6 71
10 3,958 2,051 1,907 1.3 15
1 3.825 1,964 1,861 1.3 1.4
12 3.929 2,033 1,896 1.3 1.4

» |13 years 3.837 1,937 1,900 1.3 1.4
14 years 3.883 1,982 1,901 1.3 1.4
15to 19 years 22,227 11,143 11,078 75 79
15 years 3.893 1,979 1,914 13 1.4
16 years 3.836 2,01 1,825 1.3 1.4
17 years 3.723 1,893 1,830 1.3 1.3
18 years 5116 2,508 2,610 1.7 1.8
19 years 5,659 2,760 2,899 19 20
20to 24 years 22,609 11,123 11,486 77 79
20 years 5,460 2,710 2,750 19 19
21 years 5,146 2,547 2,599 17 1.8

11. Place your cursor in the Number column next to the Age field 5.

12. Retype the number in the field without the commas. For example, replace the number
3,537 with 3537.

13. Do this for each of the age fields 5-12 that you updated in the previous steps.
14. Repeat this step for the age fields in the Percent column.

15. Repeat this step for the age fields in the Males per female column.
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| [Age Number Percent Males_per fema| Cal5 Cole

Both sexes Male Female Both sexes Male Female
Total  population | 294,565 140,885 153,680 100.0 100.0
Under 5 years 16,649 8,610 8,039 5.7 6.1
Under 1 year 3192 1,661 1,531 1.1 1.2
1 year 331 1,738 1573 1.1 1.2
2 years 3.303 1,696 1,607 1.1 1.2
3 years 3,392 1,727 1,665 1.2 1.2
4 years 3.451 1,788 1,663 152 1.3
5to 9 years 18,944 9,768 9,176 6.4 69
5 3537 1821 1716 1.2 13
5 3638 1838 1800 1.2 1.3
7 3777 1930 1847 1.3 1.4
g 3948 2076 1872 1.3 15
9 4044 2103 1941 1.4 15
10to 14 years 19,432 9,967 9,465 B6 71
10 3958 2051 1907 1.3 15
1 3825 1964 1861 1.3 1.4
12 3929 2033 1896 1.3 1.4
13 years 3.837 1,937 1,900 1.3 1.4
14 years 3,883 1,982 1,901 1.3 1.4
15to 19 years 22,227 11,143 11,078 75 79
15 years 3.893 1,979 1,914 13 1.4
16 years 3.836 2,01 1,825 1.3 1.4
17 years 3.723 1.893 1,830 1.3 1.3
18 years 5116 2,506 2610 1.7 1.8
19 years 5,659 2,760 2,899 19 20
20to 24 years 22,609 11,123 11,486 77 79

» |20 years 5,460 2,710 2,750 19 19
21 years 5,146 2547 2,599 17 1.8

16. Click the Close X to exit the List Update window and return to the Output window.

* Do not close Analysis.
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Selecting with String Length

Now you have a set of Age variables that differ from the series. You can use this difference to
select only those age groups you have edited.

You are going to use a format option called String Length to specify the length of the variable
you are selecting.

1. Click Select. The SELECT dialog box opens.

2. In the Select Criteria field, use your keyboard and the Operator buttons to create the
following code:

strlen(age) <=2

» This states that you want to see only the records from the Age field that have a length
less than or equal to 2 characters.

R 5

Select Criteria
strlen(age)<=2|

¥ ,

Available Variables +I_l*l;|=|< >|&I"I(I)

I 3 AND OR "Yes" “No" "Missing"

Functions I Save Only | | OK I

Clear | Help | Cancel |

3. Click OK. You should have 8 records.

4. Click List. The selected list appears.

Age [Number |Percent |Males_per | Col5 | Col6 |Col7

5 13537 1821 1716 1.2 1.3 1.1 5

6 13638 1838 11800 [1.2 1.3 1.2 102.1
7 (3777 13930 1847 1.3 1.4 1.2 104.5
8 13948 2076 1872 1.3 15 1.2 1109
9 4044 2103 1941 1.4 15 1.3 108.3
10 13958 2051 1907 [1.3 15 1.2 107.6
1 13825 1964 1861 1.3 1.4 1.2 105.5

3929 2033 1896 1.3 1.4 1.2
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Define and Assign New Variables

The headings brought in from the HTML file do not match up with the data in the columns.
This can happen with . HTML or MS Excel files. The column titled Number is the Total. The
column titled Percent is the number of Males, and the column titled Males per Female is the
number of Females. You are going to use the DEFINE command to create new variables,
and use the ASSIGN command to give them current table values.

1. Click Define and create a new variable called Toza.
2. (lick OK

3. Click Define and create a new variable called Males.
4. C(lick Define and create a new vatiable called Femzales.
5. Click Assign. The ASSIGN dialog box opens.

6. From the Assign Variable drop-down, select Total.
7. Move your cursor to the =Expression field.

8. From the Available Variables drop-down, select Number.

assion x|

Assign Variable

|total |
= Expression
Number

< H

Available Variables + | .| = il=l<|>|&|"
posm Ll L=< [sle] ]
AND OR "Yes" "No" "Missing"
Functions | saveony | oK |
Clear | Help ] Cancel |

9. Click OK.

10. Use the ASSIGN command to assign the variable Males=Percent.

11. Use the ASSIGN command to assign the variable Females=Males_per: femal.

12. Click List to view the records and verify that the values were copied to the new variables.

13. Click Write/Export. The WRITE dialog box opens. You need to write only the new
variables to a new table for use in computing the prevalence.

322



INTERMEDIATE ANALYSIS

14. From the Variables list, select Age, Total, Males, and Females.
15. From the Output Mode, select the Replace radio button.

16. From the File Name field, click the Browse button.

17. Locate and select the Asthma Fina. MDB.

18. From the Data Table drop-down, select CensusFormat.

E2

Browse I Save Only

OK

E2

were
~ Output Mode
[~ Al(Y [~ All{*) Except ‘ " Append (+ Replace
Variables Output Formats
Number | |Epi2000
:ﬂzrlggm er femal Fic Name
Cols P IC:Epi_InfoElHA TutorialAsthma Final.mdb _I
Col6 Data Table
20U, kcensusformat
Col8
Total
Males
Females

Clear Help

Cancel

19. Click OK.

20. Click Read/Import.

21. Click the Show All radio button.

22. Sclect the CensusFormat table.

23. Click OK. You should have eight records.

24. Click List to see the records.

*  You have created a table with the total population per age for the county. This table
will be used as your denominator table when you compute the rates for the county.
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Age [ Total [ Males Females
5 3537 1821 1716
B 3638 1838 1800
7 3777 1330 1847
g 3948 2076 1872
9 4044 2103 1941
10 3958 2051 1907
1 3825 1964 1861
12 3929 2033 1896
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Create a Numerator Table

The CensusFormat table is now your denominator table. You need to create the numerator
table that contains information about the survey respondents age and sex, and then use the
RELATE command to join the two tables.

1.

2.

Click Read/Import.

Open the view prelnterventionSurvey. You should have 800 records.
Click Assign. The ASSIGN dialog box opens.

Create the following code Age=Years(DOB,10/25/2005).

Click OK.

List the Age variable to make sure it calculated propetly.

Click Define and create a new variable called T-Age.

Click Assign. The ASSIGN dialog box opens.

Create the following code TAge=format(age). Age is a number and TAge is Text.

AssIGN x|
Assign Variable

| TAge Ll

= Expression
format(Age)|
y >
Available Variables ﬂ ) I = | ¢ ] = I <|s I &l " | { | )
I age LI AND OR "Yes" "No" "Missing"
Functions | saveonty || oK |
Clear | Help l Cancel |

10. From the Command Ttree Statistics folder, click Tables. The TABLES dialog box opens.

11. From the Exposure Variable drop-down, select TAge.

12. From the Outcome Variable drop-down, select Gender.

13. In the Output to Table field, type Survep.AgeSex.
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x|
Outcome Variable Stratify by
| Gender | |
Exposure Variable [~ Matched Analysis
|Ege = ™
Weight LN ILL
I :J HEIGHT | + |—
620 | 20|40
625 | 37| 59 %
Optional Page Settings
Output to Table [ columns per Page
ﬁnleyagesex [ No Line Wrap
Settings | Save Only | | OK |
Clear | Help I Cancel |

14. Click OK. The Output window shows the results. Now you have the number of males

and the number of females per age.
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Create a Relate

Now you are going to use the RELATE command to connect the two tables for the
calculations.

To create a Weight variable, you need to relate the census population numbers to the survey
count numbers, then you can divide the total numbers by the survey count to get the weight.
By relating the CensusFormat table and the SurveyAgeSex table, you can define and format
new vatiables and then WRITE a new table containing data from the two original sources.

SurveyAgeSex Table
Build Key TAge

T Gender | COUNT
Census Format Table '166” IFemde ‘ao
Build Key Age 10 Male 73
n Femals 66
Age | total |males | females N Male 7
5 3537 1821 1716 :g_ ;2* ﬁ
6 3638 1838 1800 : Fomde 8
7 3777 1930 1847 5 Male 4
8 3948 2076 1872 <: > g Fende 4
9 4044 2103 1941 7 e ®
10 3958 2051 1907 7 Male 64
n 3825 1964 1861 8 Female 59
12 3929 2033 1836 g il =
9 Female 75
9 57

WWwoo~N~SNOTOTOOC

MNYEBIALBBRRRE® ™

Related Table

Data in the new related table can be used to create the new Weight Variables.
You can use the WRITE command to create a new permanent table that holds these
values.

1. Click Read/Import. The READ dialog box opens.

2. Click the Show All radio button.
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3. Select the table called CensusFormat.
4. C(Click OK. You should have 8 records.

5. From the Command Tree Data folder, click Relate. The RELATE dialog box opens.

]
Current Project
|C:1Epi_lnfo'lElHA Tutorial'Asthma Survey 2005.mdb
Data Formats
| Epi 2000 |
Data Source
|-C:1Epi_lnfolElHA Tutorial'Asthma Survey 2005.mdb __J
—Show
{* \iews Al
Views
fiewPrelnterventionSurvey
Key [~ Use Unmatched (ALL)
< 4|
Build Key Save Only OK
Clear Help Cancel

6. Click the Show All radio button.
7. Select the SurveyAgeSex table.
8. Click Build Key. The RELATE-BUILD KEY dialog box opens.

* Both the tables contain variables for age so you can relate the tables on that variable.
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]
Key Component
l
Ly .
Available Variables .,.J _|= ,J=|< >|&|..| (J )
I :J AND OR "Yes" "No" "Missing"
{* Current Table(s) " Related Table
Functions | OK I
Clear | Help Cancel |

9. Seclect the Current Table radio button.

10. From the Available Variables drop-down, select Age.
11. Select the Related Table radio button.

12. From the Available Variables drop-down, select TAge.

13. Click OK. The Related Tables field populates.
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RELATE - BUILD KEY . 5‘

Key Component

L 5
Available Variables +|-I*IJI=I< >I&|"I(I)

|tage 5 AND | OR | "ves" "No" | “Missing"

" Current Table(s)

Age tage

Functions | | OK I

Clear | Help | Cancel l

12. Click OK. The RELATE dialog box opens.
13. Click OK. You should have 16 records.
14. Click Display. Notice that the fields TAge and Age are Text.

15. Click Define and create a new variable called N.Age. This new variable will hold the age

value in a numeric form.

16. Click Assign. You are going to format the new age field as a number and assign a value
to the variable.

17. From the Assign Variable drop-down, select NAge.

18. In the =Expression field type, TXTTONUM (Age).
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AssIGN x|
Assign Variable
Inage El
= Expression
txttonum(age)|
‘ |
Available VYariables +|_|a|‘|=|< >|&I--|(I)
I ;I AND OR "Yes" "No" | “"Missing"
Functions I Save Only | | OK I
Clear | Help | Cancel I
19. Click OK.
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Create a Weight Variable

Now you will create a Weight variable to use in your calculations. First, select the males in the
dataset, create the Weight calculation, and write the variables out to a new table. Repeat the
process for the females in the dataset.

1.

2.

Click Select. The SELECT dialog box opens.

Select Gender="Male".

Click OK. You should have 8 records.

Click Define and create a new variable called W'T.

Click Assign. The ASSIGN dialog box opens.

From the Assign Variable drop-down, select WT.

In the =Exptession field create the code: TXTTONUM Mates)/ Connt.

* You are changing the variable Male to a number and you are dividing it by the
variable Count, which is the number of students in the survey who are male.

AssiGN x|
Assign Variable
|wr #
= Expression
txttonum{Males)/COUNT

‘ i
Available Variables |- =]<[>]&]"] (]|

COUNT
I :l AND OR "Yes" "No" "Missing"

Functions | Save Only | oK |

Clear | Help ] Cancel |

8. Click OK

9. Click Write/Export. The WRITE dialog box opens.

10. Sclect the Variables Gender, NAge, and WT.

11. From the Output Mode section, select Replace.

12. From the File Name Browse window, select the Asthma Final project.

13. In the Data Table field, type GenderlV'T.
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x|
Output Mode
[ Al(Y [~ All{*) Except IV(‘ Append (+ Replace
Variables Output Formats
Age | Epi 2000 |
‘r::::! File Name
female |C:1Epi_lnfo\ElHA TutorialAsthma Survey 200 __J
tage Data Table
[ GenderwT =]
VARNAME
COUNT
hage
wit
Browse I Save Only | OK |
Clear I Help | Cancel |
14. Click OK.
15. Click Cancel Select.

< Practice

Repeat steps 1-15 above for the Females in the sutvey.

Instead of Replacing the file GenderWT, however, you will APPEND the female

information.
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Create a PSU Variable

To create the PSU wvariable, you are going to open the 800 records from the
viewPrelnterventionSurvey table and relate them to the GenderWT table you created in the
previous section. There are some formatting and data management steps you must follow
prior to completing the RELATE.

viewPrelnterventionSurvey GenderWT Table

Build Key Age and Gender Build Key Nage and Gender
[Age  JGender |
1 M [Gender | NAge FWT
3 Fomall Male 10 28.0958904109583
10 Male Male 1 25.5064935064935
9 Male Male 12 10165
n Male Male 5 455.25
10 Male Male 6 37.469387755102
; ;‘i Male 7 3015625
5 e < :> Male 8 30.5294117647053
9 Male Male 3 36,8947368421053
10 Female Female 10 23.8375
9 Female Female 1 28,1969696969697
8 Male Female 12 948
10 Mele Female 5 2145
2 nak Female 6 52,9411764705882
% S Female 7 225243902433024
10 Female Female 8 31.728813559322
8 Male Female 3 25.88

[Age [Gender |Genderl |NAge  |W1

10 Male Male 10 28.0958304109583
10 Male Mae 10 28.0958304109589
10 Male Male 10 28.0958904109589
10 Male Male 10 28,0958904109583
10 Male Mate 10 28.0958304109589
10 Male Male 10 28.0958304109589
10 Male Make 10 23.0958304109583
10 Male Made 10 28.0958304109589
10 Male Maie 10 23.0958904109583
10 Male Male 10 28.0958304109583
10 Male Male 10 28.0958304109583
10 Male Male 10 28.0958904109583
10 Male Male 10 28.0958304109583
10 Mae Male 10 28.0358904109589
10 Male Make 10 28.0958904103583
10 Male Male 10 28.0958304109583
10 Male Male 10 28.0958904109583
10 Male Male 10 28.0958304109583
10 Male Male 10 28.03958304109589
10 Male Male 10 28.0958304109589
10 Male Maie 10 28.0958904109583
10 Male Male 10 28.0958904109583
10 Male Male 10 28,0958304109583
10 Male Male 10 28.0958904109583

Related Table
1. Click Read/Import.

2. C(lick the Show All radio button.
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9.

10.

11.

12.

Select the new table GenderWT.

Click List to see the computed weight values.

* In the Gender column, make sure the words Male and Female are written with
capitol letters. If not, modify the records using the List Update command. Complex
Sample routines are case-sensitive.

Click Display to see your format changes.

Click Read/Import.

Read in the Asthma Final project with your 800 records.

» Click List to verify that the words Male and Female are written with capitol letters. If
not, modify the records using the List Update command. Complex Sample routines
are case-sensitive.

Click Assign and compute the Age variable Hint: Age=YEARS(DOB, 10/25/2005).

From the Command Tree Statistics folder, click Tables. The TABLES dialog box opens.

For the Exposure Variable drop-down, select Age.

From the Outcome Variable drop-down, select Gender.

Click OK.

* Look at the table and see that all the ages and genders of the data are represented.

* Now you know that you can use the RELATE command to relate your GenderW'T
table to the survey records.
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GENDER
| Age Female Male TOTAL
5 gl 4 12
Row% 667 333 1000
Col%| 20| 10| 15
6| 34| 49 83
Row% 410|590/ 1000
Col%| 84| 124 104
7| 82 64| 146
Row%| 562|438 1000
Col%| 202| 162| 183
8 59 68 127
Row% | 465|535 100.0
Col%| 145| 17.3| 159
9| 75| 57| 132
Row%| 568|432| 1000
Col%| 185| 145 165
10| 80 73 153
Row%| 523 47.7| 1000
Col%| 197|185 191
11| 66 77| 143
Row%| 462|538 100.0
Col%| 163|195 179
12 ARE 4
Row% | 500/ 500/ 100.0
Col%| 05| 05/ 05
TOTAL| 406 3%4| 800
Row% 508|493 1000
Col% | 100.0/100.0| 100.0

INTERMEDIATE ANALYSIS

13. Click Relate. The RELATE dialog box opens.

14. Select the table GenderWT. For this Relate, you will type the code into the Key field.
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K

Current Project
|C:1Epi_lnf01EIHA Tutorial'Asthma Final.mdb

Data Formats
| Epi 2000

=
Data Source
|-C:1Epi_lnf01ElHA Tutorial'Asthma Final.mdb _J

—Show
" \Views t« All

All

DisCtyAge2 4|
DisNYSex
DisNYTtIFemale
DisNYTtIMale
disrt2001_03
EPMYR_1
EPMWR_2

Key [~ Use Unmatched (ALL)
Age:NAge AND Gender::Gender]

LF I

Build Key Save Only OK

Clear Help Cancel

15. Move the cursor into the Key field.
16. Type the following Relate: Age::N.Age AND Gender::Gender.

= Relates for redefined or new variables must be typed into the Program Editor, or the
Key field.

17. Click OK.

* Code will appear in the Program Editor as RELATE GenderWT Age:Nage AND
Gender:Gender.

= Now you need to define a primary sampling unit or PSU. In this example, PSU will
be the SchoolNum and Age.

18. Click Define and create a new variable called PSU.
19. Click Assign. The ASSIGN dialog box opens.

20. From the Assign Variable drop-down, select PSU.
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21.In the =Expression field type with the keyboard or use the drop-down menus and
operator buttons to create the following expression:

SchoolNum & format(nage,"00")

AsSIGN x|
Assign Variable
[bsu -]
= Expression
SchoolNum & format{Nage,"00")

« 2

Available Variables +| .|* ! ]=|< >|&|"| (| )
| Nage K AND | OR | "Yes" "No" | "Missing"
Functions | saveonty || oK |
Clear | Help | Cancel l
22. Click OK.

Compute the County Child Prevalence

You now have all the variables and data needed to compute the prevalence for the children in
the county.

1. From the Command Tree Advanced Statistics folder, click Complex Sample
Frequencies.

2. From the Frequency Of drop-down, select Asthma.
3. TFrom the Weight drop-down, select WT.

4. From the PSU drop-down, select PSU.
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X
Frequency of Stratify by
ILL | Freq |% | [ | =
+ |20 3% [~ &ll (*) Except

o= |37 .J65% fAsthma
Total| 57 | 100%

Weight
|wt =
PSU
[bsu 7]

Output to Table

Save Only l | oK |

Clear | Help | Cancel |

5. Click OK. Results appear in the Output window:

| Asthma | TOTAL
Yes !
| Row% 100.000

Col%( 9.97‘@ Prevalence
| SE%| 1611
- Lorw(ess
- verw{uszos

No 708
' Row% 100,000
| Col % | 90.022
|
|
|

Confidence Interval

SE%| 1611
LCL% | 86.736
UCL % | 93.308

TOTAL | 800
 Design Effect|  2.312

Compute for the Subgroup Gender

1. From the Command Tree Advanced Statistics folder, click Complex Sample Tables.
The TABLES dialog box opens.
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TABLES N

Outcome Variable Stratify by

| N

Exposure Variable

N = AN

Weight N ILL
HEIGHT | + |—

I ‘:J 620 | 20|40

Fs L _'J 625 | 37| 89

Output to Table

Save Only | |

OK

Clear l Help I

Cancel

. From the Exposure Variable drop-down, select Gender.
. From the Outcome Variable drop-down, select Asthma.
. From the Weight drop-down, select WT.

. From the PSU Variable drop-down, select PSU.

. Click OK. The results appear in the Output window.
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for Males

Statistical Table Results for Child County Prevalence by Gender
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CTABLES COMPLEX SAMPLE DESIGN ANALYSIS OF 2 X2 TABLE

Odds Ratio (OR) 1.143
Standard Error (SE) 0.400
95% Conf Limits (0.53, 2.467 )

Risk Ratio (RR) 1.128

Standard Error (SE) 0.382

95% Conf Limits (0.57, 2.249 )

RR = (Risk of Asthma=-1 if Gender=Female) / (Risk of Asthma=-1 if Gender=Ifale)

Risk Difference (RD%) 1.203

Standard Error (SE) 3.489

95% Conf Limits (-5.91, 8.318)

RD = (Risk of Asthma=-1 if Gender=Female) - (Risk of Asthma=-1 if Gender=ale)

Other questions you could answer using Analysis with similar steps and data:
= What is the current asthma prevalence among children in the state?
» Is the state childhood asthma prevalence higher in any population subgroups?

» How is the county childhood asthma prevalence different from the state?
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Mortality Rates

As an illustration to provide with your proposal, you would like to graph the mortality rates
for the county and the state.

H. Are the asthma mortality rates for the state and county significantly
different?

There are two pre-made tables inside the Asthma Final project. One is a table called
Population and the other is called Numerators. Each table was created using the Summarize
and Write commands with information from CDC WONDER and MS Excel tables with NY
specific data. New variables were defined to hold data and reformat it for use in this lesson.

The Wide-ranging OnLine Data for Epidemiologic Research or WONDER, is an easy-to-
use internet system that makes the information resources of the CDC available to public
health professionals and the public at large. It provides access to a wide array of public health
information. (Source: http://wonder.cdc.gov/wonder/help/faq.html#1)

You want to create a bar graph of the mortality rates for the county and state. To compute
the results you need to use the RELATE command and join two tables so you can divide the
total asthma deaths in the county and the state by the total population of the county and the
state. You will create a related table to join the population data from WONDER to the data
table that contains the number of deaths in the county and state. Once the rates are
computed, you can easily plot them onto a graph.

1. Click Read/Import. The READ dialog box opens.
2. C(lick the Show All radio button.

3. Select the Population table.

4. C(lick OK You should have 233 records.

5. Click List to view the contents.

= Now you will use the RELATE command to link the information in the population
(denominator) to the numerators in order to compute a rate.
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Population Table Numerators Table
Build Keys GeoType, GeoName, Subgroup, Subvalue Build Keys GeoType, GeoName, Subgroup, Subvalue

Year Goolype | GeoAbbr | GeoName Subgroup | Subvakue | Population| 960 Y
2000 Zo 1212 MIDDLEBURGH Ted Tos 48 BTG Swe W Toal Tad 200 dtmaDeste
2000 Zo 12463 PRESTONHOLLOW Tetd Tots 783 Courly [? 4 Tod Tod 200 ‘dtmaDests
2, % 920 MEouss fod lod 59 ol Tes A0 fohmDests
2000 Zo 12147 RENSSELAERVILLE  Tos Tos 528
2000 Zp 12185 VOORHEESWLLE  Tad Tos 6451 Corty  Abay  Comy 2 Ted Tod 201 AshesDeshs
2000 Zo 12023 BERNE Tod Tors an [Siate N State kci} Totd Tow 202 Asthma Deste
2000 Z0 12008 ALTAMONT Tod Tos %28 Courty  Abary Couty 4 Tod Tod 2 Aathma Desta
oz e werme s tas  wa [ e e i e e
2000 12205 SCHENECTADY Tou Tasl 2581 Zpbon (2 txGoplutop’ [Yeh 14 iipidtachagy
m X me oo a  Te D e O e
2000 Zp 12007 ALCOVE Totst Toal 0 2 >
2000 Zo 1200 CLARKSVILLE Tod Tod " A A Zokes 1Y Aploplatioy  Yosh A0 Hosptal Dechage
2000 Zp 12067 FEURA BUSH Totd Tos 1854 8 8 Zphes W A Gxplr o Youlh 2 Hosptal Dcharge
2000 Zo 12083 GREENVILLE Totd Tord N C C Zokea 16 AgeGoplrHosp  Youh 0 Hosptal Dscharge
2000 Zp 12193 WESTEALO Totad Total m7 o Y Zokes |2 ipGoplaton Yo AR HomplaDechug
= = ey [ e e T ok i —3e e

[Year  [GeoType [GeoAbbr [GeoName [Subgroup [Subvalue [Population]geoabbrl [geonamel [geotypel [ncases |

2000 State State NY Total Total 18339760  State NY State 34

2000 County County Abary Total Total 294532 County Albany County 4

2000 State State NY Total Total 18939760  State NY State 344

2000 County County Abary Total Total 234532 County Albany County 2

2000 State State NY Total Total 18933760  State NY State 330

2000 County  County  Abany Total Total 204532  County  Abany County 4

2000 Zp buea A A Age Group f¢ Youth 85318 A A Zip Area 152

2000 Zp Area B B Age Group fe Youth 35682 B B Zip Area 20

2000 Zp brea C c Age Group fc Youth 11038 C C Zip Area 14

2000 ZpAtea D D Age Group fe Youth 4026 D D Zip Area 2

2000 Zp biea A A Age Group fc Youth 85318 A A Zip Area 144

2000 Zp Area B B Age Group fc Youth 35682 B B Zip Area 14

2000 Zp Area C c Age Group fc Youth 11038 [ C Zip Area 16

2000 Zp hsea D 2] Age Group fc Youth 4026 2] D Zip Area 2

2000 Zp Auea A A Age Growp fe Youth 85318 A A Zip Area 184

2000 Zp Area B B Age Group fe Youth 35682 B B Zip Area 2

Related Table

6. Click Relate. The RELATE dialog box opens.

7. Click the Show All radio button.

8. Sclect the Numerators table.

9. Click Build Key. The RELATE-BUILD KEY dialog box opens.

10. Relate the two tables on the following fields: Geotype, Geoname, Subgroup, and
Subvalue.

* The Population table contains the total numbers for the population by each of the
subgroups selected. The Numerators table contains the Number of Cases by series

for each of the subgroups selected.

=  Geotype contains information on how the information is divided. Most of the values
in this field are Zip.

* Geoname contains information on the specific breakdown of data by counties or
state.

*  Subgroup contains information on how the information is divided, for example Age.

»  Subvalue contains the specific subgroup information, for example age 5-14.
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]
Key Component
« i
Available Variables +|_I*I;I=|< >I&|"|(|)
|subualue LI —
AND OR "Yes" "No" "Missing"
" Current Table(s) @ Related Table
GeoType geotype
GeoName geohame
Subgroup subgroup
Subvalue subvalue
Functions I | OK |
Clear | Help | Cancel l
11. Click OK.

12. From the READ dialog box, click OK. You should have 42 records.

13. Click Select. The SELECT dialog box opens.

14. From the Available Variables drop-down, select Series.

15. In the =Expression field, type "Asthma Deaths".

16. Click OK. You should have 6 records.

17. Click Define and create a new variable called Rate.

18. Click Assign. The ASSIGN dialog box opens.

19. From the Assign Variable drop-down, select Rate.

20. In the =Expression field, type ncases/ population*10000.

You are creating a rate by dividing the number of cases by the population and
multiplying by 10,000.

You will have one rate that when listed will appear with an E-02 value. Analysis
avoids listing values that begin with 0.0. You can reformat the values to Text to view
it the 0.0 format. The value will appear as 0.0 in the graph.

21. Click OK.
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22. From the Command Tree Statistics folder, click Graph. The GRAPH dialog box opens.

23. From the Graphtype drop-down, select Bar.
24. From the Main Variable drop-down, select Year].

25. From the Weight Variable drop-down, select Rate.

26. 'rom the Bar for Each Value of drop-down, select GeoName.

27. Click OK. The graph appears in the Epi Graph window.

28. Right click the graph and select Customization Dialog from the pop-up menu.

29. From the General tab in the Display section, select the Both radio button.

30. Click Apply.

31. Select the Axis tab.
32. From the Y Axis section, click the Min radio button.

33. Highlight the Min field text, and enter the number 0.

C Ao & MinC Max © Min/Max

Min |0

Max ||;|_1 86713

x
Style I
Genetsl | Plot | Subssts | Points | Axis | Font | Color |

| 0K I Cancell Spply |

Export... l Maximize...l

34. Click Apply.

35. Click OK.
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Notice the Y Axis on the graph has been reset to start at 0.

36. Close Epi Graph to return to the Analysis module.

Notice the rates for each year are visible at the bottom of the graph.

File Edit Yiew Help

=10l x|

= [
Albany NY
0.175
0.150
0.125
o 0-100 1
s ]
0.075
0.050 |
0.025
0.000 -
Year1 2000 2001 2002
Albany 0.136 0.068 0.136
NY 0.179 0.181 0.174
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10 Year Trends- Hospital Discharge Data

As an illustration to provide with your proposal, you would like to graph the hospitalization
rates for ten years and across age groups.

I.  Is the rate of hospital discharge for asthma increasing or decreasing in any
age groups?

You have a table in your Asthma Final project that contains ten years of asthma discharge
data by age group. You can use this table to plot statistics and look for trends in asthma
discharges.

Hospital discharge data was obtained from the Statewide Planning and Research Cooperative
System (SPARCS) and was imported into Analysis as an MS Excel file and formatted.

Population information for this exercise was downloaded from the CDC WONDER system.
Ages in the population denominator table were not divided into the same groups as the
hospital data. To match the two groups, a third table was created to hold the age data and to
match the values into three groups. The age table is called AgeProxy. Information from the
AgeProxy table was selected from the population table and written out for use with the
discharge data to create the ten-year trend graph.

1. Click Read/Import.

2. C(lick the Show All radio button.

3. Select the file NYDisAge1Oyr.

4. Click OK. You should have 30 records.

5. Click List to see the contents of the file. Notice the Series name is NY Discharges by
Age.

6. Click Relate. The RELATE dialog box opens.
7. Locate and select the file called AgeProxy.
8. Click Build Key. The RELATE- BUILD KEY dialog box opens.

9. Relate the NYDisAgelOyr table and the AgeProxy table on the following variables:
Geotype, Geoname, Subgroup, and Subvalue.

»  Geotype is State.

=  Geonameis NY.
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= Subgroup is Age.
= Subvalue is the breakdown by Age Groups 0-17, 18-64, and 65+.
10. Click OK.
11. From the RELATE dialog box, click OK. You should have 30 records.
12. Click Define and create a new variable called Discharge.
13. Click Assign.
14. From the Assign Variable drop-down, select Discharge.
15. In the =Expression, type #cases/ poputation*10000.
16. Click OK.
17. Click Graph. The GRAPH dialog box appears.
18. F'rom the Graph Type drop-down, select Line.
19. From the Main Variable drop-down, select Year.
20. From the Weight Variable drop-down, select Discharge.
21. From the Line for Each Value Of drop-down, select Subvalue.

22. Click OK. Epi Graph opens with the results.
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3 Year Rates- Hospital Discharge Data

As an illustration to provide with your proposal, you would like to graph the hospital
discharge rates for three years and across age groups.

J. Are there significant differences in the three-year asthma discharge rates for the state,
versus the county, by age?

Being able to Read, Write, and Relate tables is an important and useful concept in using
Analysis. For this exercise, you will read in two tables, one containing state discharge
information, and one containing county discharge information. You will then use the Write
command to combine the two tables in order to relate them to the AgeProxy table from the
carlier lesson. The Age Proxy table contains the population numbers divided into age groups
that you need to compute the rates.

1. Click Read/Import.

2. C(lick the Show All radio button.

3. Select the table DisCtyAge.

4. Click List, if you want to see how the table is arranged.

5. Click Write/Export.

6. Irom the Output Mode section, click Replace.

7. From the File Name Browse window, select Asthma Final.

8. In the Data Table field, type Dis3Y7s.

9. Click OK.

10. Read/Import the table NY3Yr.

11. Click List, if you want to see how the table is arranged.

12. Click Write/Export.

13. From the Output Mode section, click Append.

14. From the File Name Browse window, select Asthma Final.

15. From the Data Table drop-down, select Dis3Ys.

16. Click Ok.
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17. Click Read/Import.

18. Click the Show All radio button.

19. Select the Dis3Yrs table.

20. Click OK. You should have 18 records.
21. Click Relate.

22. Select the AgeProxy table.

23. Click Build Key and join on the following fields: Geotype, Geoname, Subgroup, and
Subvalue.

= Geotype is County or State.
=  Geoname is Albany or NY.
= Subgroup is Age.
»  Subvalue is the age group breakdowns 0-17, 18-64, and 65+.
24, Click OK.
25. From the RELATE dialog box, click OK.
26. Click Define and create a new variable called Discharge.
27. Click Assign to create the following code: discharge=ncases/ Population*10000.
28. Click Graph. The GRAPH dialog box opens.
29. Select the Graph Type of Line.
30. From the Main Variable drop-down, select Year.
31. From the Weight Variable drop-down, select Discharge.
32. From the Line for Each Value of, select Subvalue.
33. From the One Graph for Each Value of drop-down, select GeoName.

34. Click OK. Epi Graph opens and contains two graphs: one for NY, and one for Albany.

353



EPI INFO™ TUTORIAL

= Use the Page drop-down menu at the top right of the page to go between the two
graphs.

*  Use the Customization dialog box to change the graph types to Bar, and see the
difference between the two graphs.

*  Use the Customization dialog box to change the Axis Min to 0 and see the difference.

Your graph should look like the following:

354



INTERMEDIATE ANALYSIS

I
File Edit Yiew Help
geoname=NY [Pagez ]
| | [ |
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Mapping Rates

As an illustration to provide with your proposal, you would like to map the hospitalization
rates by zip code for your state.

K. Based on the map with asthma hospitalization rates by zip code, where are
the high risk areas?

In order to map high-risk areas, you will join discharge data arranged by zip code with a map
.DBF file.

1. Click Read/Import.

2. C(lick the Show All radio button.
3. Select the Dis0103byZip table.
4. C(lick List to view the variables.

= Notice the table is arranged by county zip code for three years. Also, notice that the
age groups have been recoded as Youth, Adult, and Senior. This is another way to
work with age groups.

5. Click Define and create a new variable called TDs.
6. Click Assign and create the following code: TDis=(youth+adult+senior)*10000/ 3.

*  You are adding the number of discharges for each age group, multiplying by the
population factor, and dividing by the three years in the table. You are going to map
this data and get your population denominator from the map data (census
information for the year 2000).

7. From the Command Tree Statistics folder, click Map. The MAP dialog box opens.
8. Sclect the 1 Record per Geographic Entity checkbox.

9. From the Geographic Variable drop-down, select Zip.

10. From the Data Variable drop-down, select TDis.

11. From the Shapefile Browse window, select the ALBZCTA shapefile.

12. From the Geographic Variable drop-down, select Zip.

13. From the Denominator drop-down, select POP2000.
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Map x|
v 1record per geographic entity Title
Aggregate Function I..‘_l _LJ
Sum | Shapefiie
Geographic Variable IC:\Documems and Settings\dnn2\Desktopitraining plans'tutorial data __|
I_zip ﬂ Geographic Variable Denominator
Data Variable | P | | POP2000 |
[ ais MR <| [a067 -
Weight 12469 888
| j 12120 492
= 12147 518
_I 12023 2306
Output to Table 12009 ~| |6315 |
[~ Run Silent
Browse I Save Only I | OK |
Clear I Help l Cancel I
14. Click OK.

15. Click Continue at the Incomplete Join screen. Epi Map opens with the rates mapped in a

choropleth.

File Edit Shape(Boundary) Dats Map Type View Help
2| g|s| 8| x(x|omelalr

=18(x]

30.37 to 45.48

Legend - SUM_tdis_POP2000
Missing or Excluded
0.12to0 15.24
15.25 to 30.36
45.49 and Above

Scale 1:0.0803 ’X: -73.67980 Y:42.86583

328 PM
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Customize the Map

1.

2.

9.

Open the Map Manager.

Click Properties. The Choropleth tab opens.

Layer properties for ALBZCTA_REGION

Layer name: IALBZCTA_fegion

The Choropleth [color/pattern)] classification applies symbols to a set of discrete values.

single | Unique | i€

Numeric field: Number of classes:
[sUM_tdis_POP2000 ~ [ ~] I
~ALBZCTA_REGION - SUM_tdis_POP2000 Start: [
Solid fill =] [Missing pr [Excluded End: Il
Salid fill ~| {012 - |15.24
— _l I— Reset Legendl
[Slid fil ~||15.25 [ [30.3
Solid fill x| Ja037 |_ 45.48 [V Draw outiines?
Solid fill ~| |§' [45.43 [~ Quantiles
[~ Overlay
NOTE: To turh off
Choropleth, apply the
SINGLE tab.

0K Cancel Soply

From the Number of Classes drop-down, select 8.
Select the Quantiles checkbox.

Select the Overlay checkbox.

Click Reset Legend.

Change the Color Ramp, if you would like.

Click Reset Legend.

Click Apply.

10. Click the Standard Labels tab.

11. From the Text field drop-down, select Zip.
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13. Close the Properties dialog box.

14. Close the Map Manager

- & x|
File Edit Shape(Boundary) Dats Map Type View Help
| g|s |8 x(x|omelalr

Legend - SUM_tdis_POP2000
Missing or Excluded
[ 0.12t0 3.56

|| 357t05.81

[ |s82to7.02

[ 7.03t08.95

|| 8.96t0 11.88

1 26.71 and Above

Scale 1:0.0803 ,><: -74.11786 Y:42.85752

12:22PM
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Income and Zip Code Scatter Plot

As an illustration to provide with your proposal, you would like to graph the hospitalization
rates across median income brackets and see if thete is a correlation.

L. Does income affect the rate of hospitalization for asthma?

Look at median family income and per capita income by zip code. You can create a scatter
plot of income by zip as a comparison with discharges by zip.

1. Click Read/Import. You should still be in the project Asthma Final. MDB.
2. C(lick the Show All radio button.
3. Select the IncomeData table. You should have 38 records.
4. C(lick List to view the data.
5. Click Read/Import.
6. Click the Show All radio button.
7. Select the RatebyZip table. You should have 95 records.
8. Click List to view the Data.
9. Click Select. The SELECT dialog box opens.
10. In the Select Criteria field, type Year=2001. You should have 35 records.
11. Click Relate.
12. Select the IncomeData table.
13. Click Build Key. The BUILD KEY dialog box opens.
14. Join the tables on the variables Zip and Zip2.
= Zip and Zip2 are the zip code fields in the RatebyZip and IncomeData tables.
15. Click OK. You should have 25 records.
16. Click Relate. The RELATE dialog box opens.
17. From the Data Formats drop-down, select dBase IV.

*  You are going to create a relate using the map file .DBF.
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18. Click the Data Source Browse =<4 button.

19. From the Relate window, select the ALBZCTA_region. DBF.
20. Click Open. A data format message appears.
21. Click OK. You need to manually assign the Build Key for this Relate.
22. Move your cursor to the Key field located in the RELATE dialog box.
23. In the Key field, type zzp::z2p.
*  You are relating a third table on the Zip Code field.
24, Click OK. The temporary link window opens.
25. Click OK to make a temporary link. You should have a record count of 25.
26. Click Define and create a new variable called NZzp.
27. Click Assign. The ASSIGN dialog box opens.
28. 'rom the Assign Variable drop-down, select NZip.
29. In the =Exptession field type, #is/ pop2000.
30. Click OK.
31. Click Graph.
32. From the Graph Type drop-down menu, select Scatter XY.
33. From the Variables drop-down, select Median Family and NZip.

34. Click OK. Epi Graph opens.
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r"|Epi Graph ’ _L_l- O .)Sl

File Edit Yiew Help
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Risk Ratio

To focus on certain areas of the state for your proposal, you would like to know if there are
any locations by zip code that have a higher risk for developing asthma than other areas. You
would also like to develop a .PGM that you can run on each zip code separately.

M. What is the risk ratio of being hospitalized for asthma if you live in the zip code 12202
versus if you lives in the zip code 122117
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In order to compute the risk ratios you need to create a relationship between the number of
discharges in each zip code and total population for the zip code and the county. The Tables
command gives you the ability to create a 2x2 table and gives you risk ratio results for
dichotomous questions. To get the risk ratio we need to compute the differences between the

discharge numbers in and out of the requested zip codes.

For this example, you will be using the Routeout command to save your results, and you will
also need to save your PGM. Saving the PGM will allow you to run the program for each
individual zip code without rewriting any code.

INHOSP
YES NO
INZIP
YES YES NO/YES
NO YESINO NO

1. From the Command Tree Output folder, click Routeout. The ROUTEOUT dialog box

opens.

2. In the Output Filename field, type ZjpRzskRatio.

Output Filename

ROUTEOUT 3

|zipRiskRatio

Browse

[~ Replace any existing file

Save Only

OK

X

Clear

Help

Cancel

3. Click the Replace Any Existing File checkbox.

4. Click OK
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5. Click Read/Import.
6. Sclect and open the table DischargesbyZip. You should have 91 records.

* Use LIST to view how the table is organized and the type of data it contains. This
table contains the hospital discharges per zip code for Albany County. The zip code
field is called Zip.

7. Click Read/Import.

8. Seclect and open the Population table.

9. Click Relate. The RELATE dialog box opens.
10. Sclect the file DischargesbyZip.

11. Click Build Key. The RELATE dialog box opens.
12. Relate the tables on the GeoAbbr and Zip fields.

*  GeoAbbr is the zip code field in the Population table.

= Zipis the zip code field in the DischargesbyZip table.
13. Click OK.

14. From the RELATE dialog box, click OK. You should have 185 records that are related.

= In order to select zip codes repeatedly you need to define a new variable, which can
be updated for each individual zip as needed.

15. Click Define and create a new standard variable called TheZsp.

16. Click Assign. The ASSIGN dialog box opens.

17. From the Assign Variable drop-down, select TheZip.

18. In the =Expression field type, "72202".

19. Click OK.

20. Click Define and create a new variable called I#Zsp.

21. From the Command Tree Select/If folder, click If. The IF dialog box opens.

*  You want to create a statement that says IF the value of zip is 12202, then the value is
Yes, else the value is No. You need Yes/No fields to create the 2x2 table.

22. In the If Condition field, type the code: Zip=TheZip.
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23. Click THEN. The Command Ttree activates.

24, Click Assign. The ASSIGN dialog box opens.

25. From the Assign Variable drop-down, select InZip.
26. In the = Expression field, click Yes.

27. Click Add. The IF dialog box opens.

28. Click ELSE.

29. Click Assign. The ASSIGN dialog box opens.

30. From the Assign Variable drop-down, select InZip.
31. In the = Expression field, click No.

32. Click Add. The IF dialog box opens.

Functions | Save Only | oK

F x|
If Condition
Zip=thezip
: 2|
— g el Ll =l<|>] 8[| ()
v
= AND OR “Yes" “"No* "Missing"
Then i
ASSIGN inzip= (+) ASSIGN inzip= (-)

Clear | Help | Cancel
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33. Click OK. The Program Editor code will read
IF zip=thezip THEN
ASSIGN inzip= (+)
ELSE
ASSIGN inzip= (-)
END
34. Click Select. The SELECT dialog box opens.
35. In the SELECT CRITERIA field type, subgroup="total".
36. Click OK. You should have 37 records.

= Now you need to summarize the records to get the population totals for the hospital
data, and the population data in one table.

37. From the Command Tree Statistics folder, click Summarize. The SUMMARIZE dialog
box opens.

38. From the Aggregate drop-down select, Sum.

39. From the Variable drop-down, select Population.
40. In the Into Variable field, type Pop.

41. Click Apply.

42. From the Aggregate drop-down, select Sum.

43. From the Variable drop-down, select Y2000.

= This is the number of discharges per zip for the year 2000. You are summarizing
them to get the total number of discharges for the year 2000 in Albany County.

44. In the Into Variable field, type Hosp.
45. Click Apply.
46. 'rom the Group By drop-down, select InZip and TheZip.

47. In the Output to Table field, type ZipSums.
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Aggregate Variable

summarize x|

Group By

=l

Into Variable

I

- ] -

inzip
Apply | [thezip

hosp :: Sum(Y2000)
pop :: Sum(Population)

Clear

Weight

| H
Output to Table
Iz_ipsums

Save Only OK

Help Cancel

48. Click OK.

49. Click Read/Import and select the ZipSums table.

50. Click List. The table should look like the following:

E hosp !

inzip I thezip | pop
No 12202 349987
Yes 12202 10021

51. Click Define and create a new variable called Nuzz.

52. Click Define and create a new variable called IzHosp.

53. Click Assign and create the code: InHosp=Yes.

54. Click Assign and create the code: Num=Hosp.

55. Click Write/Export.

56. In the Variables field, select InZip, TheZip, Num, and InHosp.

57. Select the Output Mode REPLACE.

58. In the Data Table field, type ZipSums2.
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59. Click OK.
=  Now create the negative values.
60. Click Assign and create the code: InHosp=No.
61. Click Assign and create the code: Num=Pop.
62. Click Write/Export.
63. In the Variables field, select InZip, TheZip, Num, and InHosp.
64. Sclect the Output Mode APPEND.
65. I'rom the Data Table drop-down, select ZipSums2.
66. Click OK.
67. Click Read/Import.
68. Locate and select the table ZipSums2.

69. Click List to see the values. The table should look like the following:

inzip | thezip [ Num tinHosp
Nao 12202 369 Yes
Yes 12202 48 Yes

No 12202 349987 No

Yes 12202 10021 No

70. From the Command Tree Statistics folder, click Tables. The TABLE dialog box opens.
71. From the Exposure Variable drop-down, select InZip.

72. From the Outcome Variable drop-down, select InHosp.

73. From the Weight drop-down, select Num.

74. From the Stratify By drop-down, select TheZip.

368



INTERMEDIATE ANALYSIS

E
Outcome Variable Stratify by
|InHosp ;I | _v_l
IEii;I];l::ul'e Variable :I /l\ l- M-atched Analysis
Weight IS o M frezn
|Num :] = e
e B Optional Page Settings
Output to Table l— Columns per Page
" No Line Wrap
settings | saveony || oK |
Clear | Help | Cancel |
75. Click OK.
inzip : InHosp, thezip=12202
Forward
INHOSP
| inzip |Yes | No |[TOTAL
Yes| 48 10021 10069
Row% | 05 895 1000
Col% | 11.5 2.8 2.8
No | 369 349987 | 350356
Row% | 0.1 999 100.0
Col% | 88.5 97.2 97.2
TOTAL | 417360008 | 360425
Row% | 0.1 99.9| 100.0
Col% 100.0, 100.0, 100.0

= The Risk Ratios appear as follows.
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"""" Four times more likely to be
hospitalized for asthma if you are
this zip code.

= The PGM you created can be re-used to analyze the risk ratio for each zip code in the

table. You can also create a dialog box within the .PGM that will prompt you for a zip
code each time you run the program.

* Do not close the current program.
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Use the Dialog Command

1. From the Program Editor, click Save. The Save Program dialog box opens.
2. In the Program field, type ZzpRatios.

3. Click OK.

4. Scroll up the .PGM to the code where you assigned thezip="12202".

5. Place the cursor in front of the Assign command.

6. Type an asterisk *.

= This is the command to comment out a specific line of code. You want to keep the
code, but you do not want it to run automatically each time you run the program.

7. Place the cursor next to the text TheZip and add a space.
8. Type the word glbal to change the variable type from standard to global.
9. Click Run This Command from the Program Editor to run the new DEFINE code.

10. From the Command Tree User Interaction folder, click Dialog. The DIALOG box
opens.

11. From the Dialog Type section, select the Get Variable radio button.
12. In the Title field, type Hospitalization by Zip.

13. In the Prompt field, type Enter a 2ip code to create the Risk Ratios.

14. From the Input Variable drop-down, select TheZip.

15. From the Dialog Format drop-down, select Text.
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zl

Dialog Type
‘V(“ Simple {+ Get Variable {" List of Values
Title Input Variable
|Hospitalization by Zip |thezip j
Prompt Dialog Format
IE_n;er a zip code to create the Risk Ratios LI
‘ »

Save Only | oK |

Clear Help I Cancel |

16. Click OK. When the dialog test box opens, click Cancel. The code appears at the end of
the program.

17. Highlight and select the code DIALOG "Enter a zip code to create the Risk Ratios"
thezip TEXTINPUT TITLETEXT="Hospitalization by Zip"

18. Select Edit>Cut.
19. Paste the code under the *Assign code.

*  Your code should look like the following example.

lefine thezip global

*assign thezip="12202"

DIALOG "Enter a zip code to create the Risk Ratios"™ thezip TEXTINPUT
TITLETEXT="Hospitalization by Zip"

20. Save the Program.
21. Click Run in the Program Editor. The code runs in the Program Editor.
22. In the Hospitalization by Zip dialog box, type 12211.

23. Click OK. Results appear in the Output window.
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Hospitalization by Zip !

Enter a zip code to create the Risk Ratios

|12211|

OK Cancel

= Notice that the new results were also written to the RouteOut file RiskRatio. HTM.

* You can use the RiskRatio. XML to create reports in Epi Report.
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StatCalc- Estimate Sample Size

You are interested in further study of the hospitalization rates to be included in your proposal.
You need to determine how many records to sample to get the most accurate statistics for the
study.

N. From the New York hospital discharge data, how many records do you need to sample
in order to get a 95% confidence interval from a sample size of 38,9987

StatCalc is an epidemiologic calculator that produces statistics from summary data. You can
use StatCalc to estimate how large a sample needs to be to achieve a 95% confidence interval.
Population Survey samples to be taken are simple random or otherwise representative
samples. The question being asked must have a yes/no, or other two-choice answer leading to
a proportion of the population as the final result.

StatCalc is a DOS-based utility. You will use the keyboard rather than the mouse for
navigation.

1. From the Epi Info™ main page, select Utilities>Statcalc. StatCalc opens.

Epi_Info\STATCALC.EXE , =0f x|
pilnfo Uersion 6 Statcalc November 1993

Tables (2 x 2, 2 x n)

Sample size & power
Chi square for trend

Fi-Help F6—0Open File F1i8-Done

2. Use the arrow keys on your keyboard to select Sample Size and Power.
3. Press Enter.
4. From the pop-up, select Population Survey.

5. Press Enter.
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"Epi_Info\STATCALC.EXE _ =0l x|
pilnfo Uersion 6 Statcalc November 1993

Population Survey or Descriptive Study Using Random (Not Cluster) Sampling

Size of population from which
the sample will be selected : 999999

Expected frequency of the factor
under study (err toward 506x)> : 58.00 z«

If 50.00 z is the true rate in the population, what is the result
farthest from the rate that you would accept in your sample C¢higher
or lowerd?

Worst acceptable result : 8.08

Fi-Help F6—0Open File F1i8-Done

6. In the Size of Population field, type the number of NY discharges for Asthma, 38998.
This number came from the summarized hospital discharge records.

7. Press Enter.

8. In the Expected Frequency field, type 77.7. This is the lifetime prevalence rate for NY
from the BRI'SS data.

9. Press Enter.

10. In the Worst Acceptable field, type 72.7.

_Info\STATCALC.EXE ] -0l x|
pilnfo Uersion 6 Statcalc Novembher 1993

Population Survey or Descriptive Study Using Random (Not Cluster) Sampling

Size of population from which
the sample will bhe selected = 38998

Expected frequency of the factor
under study (err toward 506x)> : 11.78 «

If 50.80 % is the true rate in the population, what is the result
farthest from the rate that you would accept in your sample ¢higher
or lowerd?

Worst acceptabhle result : 12.78

Fi-Help F6—0Open File F1iB8-Done

11. Press the F4 key to calculate.
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pi_Info\STATCALC.EXE , | =
pilnfo Uersion 6 Statcalc November 1993

Population Survey or Descriptive Study Using Random (Not Cluster) Sampling

Population Size 38,998

Expected Frequency 11.78 =z
Worst Acceptable 12 . 7083

Confidence Level Sample Size

2,608
3.602
5.838

Fi-Help F6—0Open File F1i8-Done

12. Look under the Confidence Level row and across to the Sample Size row to get the size
of the sample for a 95% confidence interval.

Recalculate for any sample size by entering new data and pressing 4.

13. Exit StatCalc by pressing FF10 until the window closes.
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Lesson Complete!

WHAT YOU LEARNED

How to

Use the RELATE command to link a variety of data tables.

Create a rate in Epi Info™ using the ASSIGN command.
Create a graph or a map to illustrate rates.
Use LIST UPDATE to edit recotds.

Use WRITE/APPEND to create new data tables.
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This page intentionally blank.
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Appendix A- Code Sheet

APPENDIX A

Prompt/Question Field Variable Type | Font Pattern, Table, or
Name for Option Selection
Prompt
Parent School Asthma Pre- PreSurvey Label/Title 14, Bold
Intervention Survey
Please answer all the questions | Instruction | Label/Title 12
below, whether or not your
child has asthma.
School Number SchoolNum | Text Code Table link to
PSNumber:
Ato123
B to 234
Cto 345
D to 456
Student ID Number StudentID | Text Required
Zip Code Zip Text
Child's Last Name ChildLast Text
Child's First Name ChildFirst Text
Male/Female Gender Text Legal value:
Male
Female
Child's Date of Birth DOB Date Required
MM/DD/YYYY
Age Age Number Read Only
H
Your Last Name YourLast Text
Your First Name YourFirst Text
Your relationship to Child Relation Text
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Prompt/Question Field Variable Type | Font Pattern, Table, or
Name for Option Selection
Prompt
Home Phone Number Phone PhoneNumber -
PS School Number PSNumber | Text Read Only
Code Table link to
SchoolNum
Grade Grade Number H#H
Today's Date TDate Date MM/DD/YYYY
Has a health professional ever | Condition Label/Title
told you that your child has any
of the following conditions?
Asthma Asthma Checkbox
Reactive Airway Disease RAD Checkbox
Asthmatic Bronchitis or Bronchitis Checkbox
Wheezy Bronchitis
Wheezing Wheezing Checkbox
Has a health professional Medication | Yes/No
prescribed any medication to
your child?
How many times did your Emergency | Number H#
child have an emergency visit
for breathing problems?
How many times did your Overnight | Number H#
child have to stay overnight in
the hospital for breathing
problems?
Does your child take medicine | DailyMed Yes/No
every day for breathing
difficulties?
Select the month when your WMonth Text Comment Legal

child's breathing was the worst.

1- January
2- February
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Prompt/Question

Field
Name

Variable Type

Font
for
Prompt

Pattern, Table, or
Option Selection

3- March

4- April

5- May

6- June

7- July

8- August

9- September
10- October
11- November
12- December

During their worst breathing
month, select how often the
following symptoms occurred.

Symptoms

Label/Title

Wheeze or whistling in the
chest?

Whistle

Text

Legal Values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
day

Have a cough?

Cough

Text

Legal Values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
day

Have a tight chest or shortness
of breath?

ShortB

Text

Legal values are:

Never
2 times each week
or less
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Prompt/Question

Field
Name

Variable Type

Font
for
Prompt

Pattern, Table, or
Option Selection

3 to 6 times each
week

Every day but not
all day

Every day and all
day

Wake up at night from
wheezing, coughing, or trouble
breathing?

WakeUp

Text

Legal Values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
day

How many days of school has
your child missed due to
asthma?

MissDays

Number

EReRes

Have breathing problems
stopped your child from
participating in sports?

MissSport

Yes/No

If Yes, how many times in the
past month?

SpTimes

Text

Legal Value

2 times a2 month or
fewer

3 to 4 times a
month

1 to 3 times each
week

4 times each week
or more

How many people living in
your home, including this
child, have asthma?

[IHome

Number

Hit
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Appendix B- Parent School Asthma Pre-
Intervention Survey

Please answer all the questions below, whether or not your child has asthma. If you receive more than one
questionnaire, please complete a separate questionnaire for each of your children who attend this school. Your
answers will help the school nurse provide information and medical assistance to children and their families who have
asthma.

School Number Student ID Number Zip Code

Child's Name (Last, First) Male/Female Child's Date of Birth and Age
(Citcle One)

Your Name (Last, First) Your Relationship  to | Home Phone Number
Child

PS School Number Grade Today's Date

School Number Student ID Number

1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?

(Please check “Yes” or “No”.)

a. Asthma O Yes O No
b. Reactive Airway Disease O Yes O No
c. Asthmatic Bronchitis or Wheezy Bronchitis O Yes O No
d. Wheezing O Yes O No

2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?

(This could include pills, syrups, inbalers or breathing machines.) O Yes O No

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,
or other breathing problems? (Enter the number. If none, enter “0” or “None”’)
(Number of times)
4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Enter the number. If none, enter “0” or “None”.
(Number of times)

5. Does your child take any medication every day for asthma or other breathing O Yes O No
difficulties, even when he or she is feeling well?

6. Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

O Sept. O Oct. O Nov. O Dec. dJan. O Feb. O Mar. O April O May O June

O Not applicable, my child did not have breathing difficulties in the past
school year (September 1, 2002 — June 30, 2003).
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7. When thinking about your child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:

wheeze or whistling O Never 0O 2 times each week O 3 to6tmes O  Every day but O Every day
in the chest? or less each week not all day and all day
have a cough? O Never 0O 2 times each week O 3 to6tmes O  Every day but O Every day
or less each week not all day and all day

have a tight chestor [0  Never O 2 times each week O 3 to6tmes O  Every day but O Every day
shortness of breath? or less each week not all day and all day
wake up at night O Never 0O 2 times each week O 3to6times O Every day but O Every day
from wheezing, or less each week not all day and all day
coughing or trouble
breathing?
8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your

child missed due to asthma or other breathing difficulties?

(Enter the number. 1f none, enter “0” or “None”.)

(Number of days)

9.  During the past month, has asthma or other breathing problems ever stopped your child O Yes O No

from participating in sports or other physical activities?

If “YES”, how many times in the past month? (Please check only one box.)
O 2 times a month or fewer 0O 3 to 4 times a month O 1 to 3 times each week O 4 times each week or more
10. How many people living in your home, including this child, have asthma?

(Enter the number. If none, enter “0” or “None”.)

(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Appendix C- Data Entry Surveys

Please answer all the questions below, whether or not your child has asthma. If you receive more than one
questionnaire, please complete a separate questionnaire for each of your children who attend this school. Your
answers will help the school nurse provide information and medical assistance to children and their families who have
asthma.

School Number A Student ID Number 11 | Zip Code 1220%

Child's Name (Last, First) Gender Child's Date of Birth and Age
Evans, Katle Female 11/20/1994, 10
Your Name (Last, First) Relationship to Child Home Phone Number
Evans, Rebecen Mother 555-555-5555
PS School Number Grade Today's Date

12z 5t 10/25/2005

School Number Student ID Number

1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?

(Please check “Yes” or “No”.)

a. Asthma B Yes O No
b. Reactive Airway Disease B9 Yes ONo
c. Asthmatic Bronchitis or Wheezy Bronchitis BYes ONo
d. Wheezing Bd Yes O No

2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?

(This could include pills, syrups, inbalers or breathing machines.) BYes O No

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,
or other breathing problems? (Enter the number. If none, enter “0” or “None”, 2
(Number of times)
4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Enter the number. If none, enter “0” or “None”. 1
(Number of times)

5. Does your child take any medication every day for asthma or other breathing Yes ONo
difficulties, even when he or she is feeling well?

6. Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

BSept. O Oct. ONov. ODec.OJan. OFeb. OMar. O April OMay O June

O Not applicable, my child did not have breathing difficulties in the past
school year (September 1, 2002 — June 30, 2003).
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When thinking about yout child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:

wheeze or whistling O Never & 2 times each week O 3 to6tmes O  Every day but O Every day
in the chest? or less each week not all day and all day
Have a cough? O Never & 2 times each week O 3 to6tmes O  Every day but O Every day
or less each week not all day and all day

have a tight chestor [0  Never [ 2 times each week O 3 to6tmes O  Every day but O Every day
shortness of breath? or less each week not all day and all day
wake up at night O Never H 2 times each week O 3to6times O Every day but O Every day
from wheezing, or less each week not all day and all day
coughing or trouble
breathing?
8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your

child missed due to asthma or other breathing difficulties?

(Enter the number. 1f none, enter “0” or “None”.) 12

(Number of days)

9.  During the past month, has asthma or other breathing problems ever stopped your child BYes O No

from participating in sports or other physical activities?

If “YES”, how many times in the past month? (Please check only one box.)
O 2 times a month or fewer 0O 3 to 4 times a month O 1 to 3 times each week O 4 times each week or more
10. How many people living in your home, including this child, have asthma?

(Enter the number. If none, enter “0” or “None”.) 0

(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Please answer all the questions below, whether or not your child has asthma. If you receive more than one questionnaire, please
complete a separate questionnaire for each of your children who attend this school. Your answers will help the school nurse
provide information and medical assistance to children and  their families who  have asthma.

School Number A Student ID Number 12 | Zip Code 122203

Child's Name (Last, First) Gender Child's Date of Birth and Age

WiLLLams, Beth Fevwale 11/0£/1995, 9

Your Name (Last, First) Relationship to Child Home Phone Number
Willlamms, Susan Mother 323-233-3333
PS School Number Grade Today's Date

123 il 10/25/2005
School Number Student ID Number

1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?

(Please check “Yes” or “No”.)

a. Asthma BYes ONo
b. Reactive Airway Disease BYes ONo
c. Asthmatic Bronchitis or Wheezy Bronchitis O Yes ONo
d. Wheezing BdYes ONo

2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?
(This conld include pills, syrups, inhalers or breathing machines.) B Yes ONo

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,
or other breathing problems? (Enter the number. If none, enter “0” or “None”., 0
(Number of times)
4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Enter the number. If none, enter “0” or “None”.) 0
(Number of times)

5. Does your child take any medication every day for asthma or other breathing O Yes BENo
difficulties, even when he or she is feeling well?

6. Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

O Sept. O Oct. ONov. ODec. OJan. OFeb. O Mar. O April 00 May Bd June

OANoz applicable, ny child did not have breathing difficulties in the past
school year (September 1, 2002 — June 30, 2003).
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When thinking about yout child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:

wheeze or whistling O Never 0O 2 times each week Bl 3 to 6 times O  Every day but O Every day
in the chest? or less each week not all day and all day
have a cough? O Never & 2 times each week O 3 to6tmes O  Every day but O Every day
or less each week not all day and all day

have a tight chestor Bl Never [O 2 times each week O 3 to6tmes O  Every day but O Every day
shortness of breath? or less each week not all day and all day
wake up at night O Never H 2 times each week O 3to6times O Every day but O Every day
from wheezing, or less each week not all day and all day
coughing or trouble
breathing?
8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your

child missed due to asthma or other breathing difficulties?

(Enter the number. 1f none, enter “0” or “None”.) 14

(Number of days)

9.  During the past month, has asthma or other breathing problems ever stopped your child O Yes BEINo

from participating in sports or other physical activities?

If “YES”, how many times in the past month? (Please check only one box.)
O 2 times a month or fewer 0O 3 to 4 times a month O 1 to 3 times each week O 4 times each week or more
10. How many people living in your home, including this child, have asthma?

(Enter the number. 1If none, enter “0” or “None”, 0

(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Appendix D Skills Reviews Answer Key

Lesson 2 Check Code

Check Code can run Before or After values
are entered in a variable.

True

From the Program Editor, you assign when
Check Code will run by using the Before or
After radio buttons in the Check Commands
window.

Using the Program Editor, you can create
Check Code that will run across pages or
records.

True

From the Program Editor, Check Code can
be added to pages and records using the

Choose Field Where Action Will Occur
drop-down menu.

In the Check Command window, variables
tagged with an X have Check Code
associated with them.

False

Variables with Check Code are tagged with
an *asterisk.

Which Function is used to create an age
variable.

YEARS

The YEARS function returns the number of
years from variable 1 to variable 2 in a
numetic format.

For example, Age=YEARS(DOB, Today's
Date)

How does the answer Yes appear in the
Program Editor?

S

The symbol (+) is equal to Yes or True
values. The symbol (-) is equal to No or False
values.

Lesson 3 Enter Data

Once you create a you cannot
change field names or types in your view.

Data Table

Once you begin entering records into the
data table, you cannot change field names or
types without deleting data that has been
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Lesson 2 Check Code

entered.

What are the two ways you can enter a new
record?

Clicking New or tabbing through to the last
record will allow you to begin a new record.

If you are entering data and have a required
field, you must enter information into that
field before proceeding to the next page.

True

Enter will not allow you to leave a page until
all Required fields are completed.

What expression could you enter in the Find | Age>6
feature to locate children who are greater

than 6 in age?

From the Find feature, what button do you | Reset

click to clear the page and begin a new
search?

The Reset button will clear all search options
without leaving the Find feature window.

Lesson 4 Analysis Basics

After you run a command, the code appears
in which window?

Program Editor

Codes appear in the Program Editor and can
be saved as programs.

What command allows you to open a project
for analysis?

READ

You must READ a project into Analysis
before creating any statistics or data
management.

What command would you use to see
variables and records in the current data
table?

LIST

The LIST command creates a listing of the
current data table and records.

What command would you use to specify a
sequence for records to appear?

SORT

The SORT command organizes listed data in
and ascending or descending order based on
selected variables.

What are the two Display Modes you can use
with the LIST command?

Web (HTML) and Grid

The LIST command allows you to view
information embedded in the Output
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Lesson 2 Check Code
window as HTML or in a grid table format.
There is a third Display Mode called List
Allow Updates, which allows you to edit
recotds. This is covered in the Intermediate
Analysis lesson.

Lesson 6 Epi Graph

You can use a Line Graph to determine
trends and cyclic variation.

True

Line Graphs can display data that varies
along an accepted sequence such as time,
temperature, etc.

Which type of graph presents a circular
proportional assessment by comparing data
elements such as percentages or counts
against the sum of the data elements?

Pie Graph

Pie Graphs are used for proportional
assessment by comparing data elements such
as percentage or count against the sum of
data elements.

From Epi Graph, select the 2 ways you can
open the Customization dialog box.

Right click and select Customization or select
View>Customization

Graphs can be exported for use in other
programs such as MS Word, PowerPoint, or
Epi Report.

True

Select File>Export from Epi Graph and
choose your export options.

You can plot a new graph type from an
existing graph using the Customization dialog
box.

True

Open the Customization dialog box and
select the Plot tab. Select a new Plot Style and
click Apply.

Lesson 7 Analysis: Exporting Files

Which command allows you to designate a
new Output file?

ROUTEOUT

The ROUTEOUT command directs output
to a named file until the process is terminated
by the CLOSEOUT command or by exiting
Analysis.

Which command allows you to create a new
variable?

DEFINE

The DEFINE command allows you to create
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new variables. The most common type being
Standard.

Which command allows you to store the
value of a variable or assigns the result of a
mathematical expression.

ASSIGN

This command assigns the value of an
expression to a variable. It is commonly used
after a new variable is created with the
DEFINE command.

When changing, assigning, or selecting text
fields, the value must be enclosed in what?

"Quotes"

Quotes are used to enclose text strings.

In the Program Editor, the value of Missing
appears how?

)

This symbol denotes a missing value in your
data table.

To change a number variable to a date, which
function would you use?

NUMTODATE

This function transforms three numbers into
a date format.

Which command allows you to create a new
data table?

WRITE

WRITE will send records to an output table
or file in the format that you specify. You
can specify what variables will be written, the
order in which they will appear, and the type
of file to be written.

Which command allows you to open a new
data table?

READ

The READ command makes a view active. It
also removes any previously active data tables
and associated defined variables, and data
table-specific commands such as RELATE,
SORT or SELECT.

From the WRITE dialog box, what Output
Mode would you select to add data to an
existing table?

APPEND

Records will be added to the existing file or
data table if you select the APPEND option.

The WRITE command can be used to

True
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export a data table to MS Excel.

The WRITE command will send records to
an output table or file in the format that you
specify. You can specify what variables will
be written, the order in which they will
appear, and the type of file to be written.

Lesson 10 Epi Report

Which Analysis Output files are accessible by
Epi Report?

Output. XML

Analysis creates two types of files HTML and
XML. The XML file can be used in Epi
Report.

To view a report with complete data
included, click which button?

Generate Reports

Click the Generate Report button or select
File>Generate Report to view a report with
all statistics computed.

Aggregate data can be added to reports from
the Read Data and Create menu.

True

From the Read Data and Create menu, you
can also Read Analysis Output, insert a Line
Listing Group, or create a Pivot Table.

Line Listing groups can be customized from
what dialog box?

Query Builder

The Query Builder allows you to customize
the data that appears in a line listing.

What element is used to insert a graphic into
a report?

Image

Open the Insert Report Object menu in the
Report Elements Tree and drag the word
Image onto the report.
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Appendix E- Lesson 5 Answer Key

Frequency Sections Answers

A. Are there more males or females in the survey population? Females 406

B. Which condition has the highest frequency? Wheezing 12.4%

C. Which month had the highest number of students with 9-September
breathing difficulties?

D. Which school had the highest frequency of students with School A- 13.8%

bronchitis?

E. Which gender has the highest frequency of Asthma?

Males 12.2%

asthmatic conditions?

F. How many students answered Yes to Reactive Airway Disease 93
(RAD)?

G. What is the percentage of students with RAD that have been 49.5%
prescribed medication?

H. Which zip code has the highest number of students living in it? | 12046

I.  Of that zip code, which condition had the highest frequency? Asthma

J. How many students answered Yes to all four conditions: 16
Asthma, Reactive Airway Disease, Bronchitis, and Wheezing?

K. Based on all four conditions and zip code, are the conditions Yes
evenly distributed among the survey population?

L. Does one school have more students in the affected zip codes Yes- School A
and with all fours conditions than the others do?

Means Sections Answers

M. What was the most frequent number of missed days? 1

N. What is the mean (average) number of missed days due to 3.76

O. Which school had the highest average of missed days?

School A- 4.15 days

Was the school with the highest average of missed days for
males the same as the school with the highest average of missed
days for females?

No, School A for
Males (4.36) and
School B for Females

4.17)
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Frequency Sections

Answers

Q.

Is the average number of missed days higher among those who
answered Yes to asthma than the overall average? Refer to
Question N.

Yes, 11.8 versus 3.76

R.

What is the average age of the student population?

8.66

T'ables Section

Answers

S.  Does one school have a higher number of students with Yes- School A
asthma?

T. Which school has the highest number of students with School A
wheezing?

U. How many students had both asthma and wheezing? 63

V. What are the odds that you have the condition wheezing, if you | Odds Ratio 42%
have the condition asthma? Risk Ratio 13.6%

W. Is the Odds Ratio for Bronchitis and Reactive Airway Disease Lower 7.25%
lower or higher than Asthma and Wheezing? Refer to Question
V for the Odds Ratio for Asthma and Wheezing.

X. How many children with the condition wheezing were Children 44
prescribed medication? From those results, what is the Risk Risk Ratio 9.2%
Ratio?

Y. Is the Risk Ratio for being prescribed medication for the Higher. Risk Ratio
condition asthma higher or lower than being prescribed 22.2%
medication for wheezing? Compare the results to Question X.

Z. Are the risk ratios for Asthma and Wheezing higher for Higher. Odds 61.7%

children under 10 than they are for the survey population as a
whole? Compare the results to Question Y.

and Risk Ratio 15.9%
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Appendix F- Intermediate Analysis Answer
Key

The sample .PGMs listed are available in the project Asthma Final. MDB. The codes listed will
show you an example of how the question could be run using Analysis. Some of the codes
require intermediate steps to create results. Sample programs follow the steps listed in the
lesson. For example, LISTS that require updates must be done manually as they are not saved
as part of the program editor.

Computing Prevalence- Using BRFSS Data BRFSS2003.PGM
A. What s the lifetime asthma prevalence among adults in the 11.7%
state?

. . 0
B. What is the current asthma prevalence among adults in the 7.6%
state?

C. Is the state adult asthma prevalence rate higher in the subgroup | Males- 10%
gender? Females- 13.2%

D. Is the state adult asthma prevalence rate higher in the subgroup | Hispanics- 11.2%
ethnicity?

Primary Data- 800 Records Freq4Schools. PGM
E. From the school asthma data, what is the difference in School A-14.8%
prevalence rates? School B- 12.2%

School C- 10.1%
School D- 8.4%

Census Data CountyPrev.PGM
F. Whatis the county childhood asthma prevalence? 9.978%
G. What is the county prevalence for the subgroup gender? Males- 9.396%

Females- 10.599%
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Mortality Data

MortalityRate. PGM

H. Is the asthma mortality rate for the state and county
significantly different?

State 2000-.179
State 2001- .181
State 2002- .174
County 2000- .136
County 2001- .068
County 2002- .136

10 Year Trends- Hospital Discharge Data

10YReraph.PGM

I. s the rate of hospital dischatge increasing or decteasing in any
age groups?

It appears that the
discharge rate is
cyclical with 1996,
1999, and 2003 being
up years in all age

groups.

3 Year Rates- Hospital Discharge Data

3YRgraph.PGM

J.  Are there significant differences in the 3-year discharge rates
for the state versus the county by age?

Rates in all the age
groups appear to go up
in 2003. In NY, the 0-
17 year old age group
has higher rates, while
in Albany the 65+ age
group has the highest
rates.

Mapping Rates

MapRates. PGM

K. Based on the map with hospitalization rates by zip code, which
areas have the highest rates for asthma?

12202, 12207, 12200,
12209, 12041, 12007
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Scatter Plots

ScatterPlot. PGM

L. Does income appear to affect the rate of hospitalization?

Yes. The number of
discharges appears
much higher in the
lower income brackets.

Risk Ratios- Hospitalization Data

RiskRatioZip.PGM

M. What is the risk ratio of being hospitalized for asthma if you
live in the zip code 12202 versus if you live in the zip code
122117

12202- Risk Ratio 4.5
12211- Risk Ratio .39
Persons living in 12202
are 4 times as likely to

have asthma as those
in 12211 are.

StatCalc

N. From the New York hospital dischatge data, how many
records do you need to sample to get a 95% confidence
interval from a sample size of 389987

3602
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Appendix G- Preparing Data for Use in the
Epi Info™ Tutorial

The preparation and data management phase is critical for any project involving multiple data
sources. Data management in Epi Info™ requires some forethought into the types of results
needed. The steps used in this tutorial for accessing and formatting data are explained briefly
below. The purpose of this appendix is to provide you with an estimate of the preparation
time and scope of data management used in this project, which you can apply to different
projects in the future.

PREPARATION QUESTIONS

-

. Once it was decided to use asthma data, how did you decide what data was needed?
2. Where did you find the data?

3. In what format was the data? HTML, DBF, MS Excel, etc.

4. Did you reformat any of the data? If yes, what did you need to do, and how long did it
take?

5. Where did you get shape files and zip code level maps used in the lessons?

6. How did you format the data so it could be used for mapping?

ANSWERS

1. Once it was decided to use asthma data, how did you decide what data was
needed?

The first step was to understand the context of why asthma information was needed. It
was decided that the scenario would involve applying for an asthma grant. Secondly,
questions were developed and data sources located. The initial questions are included

below.
* The asthma prevalence among adults in the state is ___, and is increasing/decreasing.
(BRESS)

* The prevalence rate of adult asthma is higher in certain subgroups (age, gender,
race/ethnicity. (BRFSS)

* The county adult asthma prevalence rate is higher/lower than the state.
(BRFSS/EBRESS)

* The county adult asthma prevalence is higher in some population subgroups (age,
gender, race/ethnicity). (BRFSS/EBRESS)
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How do the county population sub-group patterns related to the state sub-groups for
adult asthma prevalence? (BRFSS/EBRFSS)

The current asthma prevalence among children in the state in ___. (National Asthma
surveillance — NY)

Is the state childhood asthma prevalence higher in any population subgroup?
(National Asthma surveillance — NY)

The county childhood asthma prevalence is __ (primary data collection)
How is the county childhood asthma prevalence different from the state?

Is the asthma mortality rate for the state and county significantly different? (Vital
Records — 3 years)

The rate of hospital discharge from asthma is increasing in __ age group, and
decreasing in __ age group. (10 year trends, 3 years for map; age group- total, 0-17,
18-64, 65+)

Compare the three-year rates for state vs. county by age. Which are significantly
different?

Hospitalization rate by zip code for 3 years; where are the high risk areas
Look at median family income/ per capita income by zip code.

Look at emergency room data — one-year cross-sectional. What percentage is asthma-
related? Look at age, gendet, race/ethnicity, payment source distributions.

The risk ratio for someone who lives in the __ zip code being hospitalized/seen in
the emergency room for asthma is____ than the other zip codes in the county.

Estimation of sample size for sampling school asthma survey.

From school asthma data of 4 schools (2 high-risk areas, one moderate risk and one
low risk) with 800 records totally, what is the difference in prevalence rates?

2. Where did you find the data?

Data

Source

Hospital Discharge Data — 10
years for trends, 3 years for
maps, payment source, age,
race/ethnicity, gender

(aggregate data)

NYSDOH SPARCS database

https://commerce.health.state.ny.us/hin/dataque/data
quer.html
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Data

Source

Hospital asthma discharge
numbers by zip code (data
available as an MS Excel file)

NYSDOH SPARCS database

https://commerce.health.state.ny.us/hin/dataque/data
quer.html

Mortality data - 3 years
(aggregate data)

Bureau of Biometrics, NYSDOH

BRESS — 4 years (aggregate
data)

BRESS Program, NYSDOH

https://commerce.health.state.ny.us/hpn/brfss/default
htm

E-BRFSS — 1 year (excel file)

BRESS Program, NYSDOH

https://commerce.health.state.ny.us/hpn/brfss/default
htm

Parent school asthma survey

Sample questionnaire used with permission from the
New York City Department of Health and Mental
Hygiene

Parent School Asthma Survey
(4 schools/200 records each)

hypothetical data was created

Census - zip code level,
county boundary and shape
files, median family and per
capital income, racial/ethnic
distribution,
hospital/emergency rooms,
schools — (aggregate data and
map files)

http://www.census.gov/geo /www/tiger/index.html

National asthma surveillance
Childhood asthma prevalence

(aggregate data)

Asthma Program, Public Health Information Group,
NYSDOH

3. In what format was the data? HTML, DBF, .XLS, etc.

Data used in this tutorial were in HTMIL, MDB, XIS, DBF, and TXT formats.

The process for merging an .MDB and an .XLS file is explained in Lesson 5. Analysis can
READ in 24 different file formats. You can READ in an .XLS file and then WRITE it to
a table inside Analysis for use with the Analysis features. The process of reading and
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4.

5,

writing HTML and .DBF files is covered in the Intermediate Analysis Lesson of this
tutorial. The steps outlined in Intermediate Analysis Lesson for reading in and writing out
an .HTML file can be applied to any format imported into Epi Info™.

Did you reformat any of the data? If yes, what did you need to do, and how long
did it take?

Yes. The data management steps involved in creating the lessons varied in time taken and
complexity of steps. Here is an example of the kinds of behind-the-scenes steps that were
taken.

If you READ the Numerators table in Analysis, you will see a set of values listed under
the variable Series>Asthma Deaths. The plan was to place the mortality numbers into the
Numerator table to compute rates.

The mortality data came from an .XLS file. The mortality spreadsheet contained a list of
counties and 3 columns with mortality numbers for 3 years in those columns. The .XLS
file was opened in Analysis and written out to a new data table so it could be manipulated.

Once the new table was read into Analysis a set of matching variables to the Numerator
table were defined. For example, SERIES was DEFINED and then ASSIGNED the
value Asthma Deaths. Each year was SELECTed and to get the number of NY deaths
the SUMMARIZE command was used. This new information could then be WRITE
APPENDed to the Numerator table.

Completing the steps for this one section of the final table took about one hour.

Where did you get shape files and zip code level maps used in the lessons?

The US Census Buteau's Cartographic Boundary Files library
(http://www.census.gov/geo/www/cob/bdy files.html) contains 5-Digit ZIP Code
Tabulation Areas (ZCTAs): 2000 files for download. The site contains files for both ESRI
and Maplnfo for every state in the country. The Maplnfo boundary file data set was
selected due to the accessibility of Maplnfo software by the staff. County specific zip
codes were carved out by creating a query that selected all zip codes from the ESRI zip
code shape file map that were within or partially within a MaplInfo county shape file map.
This county shape file with zip codes carved out was exported into an ESRI shape file
that can be used by Epi Info™.

When downloading files for use in Epi Map select the .SHP download versions. To select
zip code specific information from a downloaded state file, use the Add Partial Layer
feature in the Map Manager and then save the new shape. Shape files are also available
from the Epi Info™ website (http://www.cdc.gov/epiinfo).
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6. How did you format the data so it could be used for mapping?
Review Lessons 8 and 9 for all the rules for mapping.

There was data management involved in preparing files for mapping. To map data, it
needs to be in an .MDB format and the zip code field needs to be text. The original
.MDB prepared for the tutorial had to re-worked for use in Ept Map. Once the .MDB
was READ into Analysis, the DISPLAY command was used to ensure the zip code field
was text. Since it was not, a new zip code variable was DEFINEd, ASSIGNed, and the
FORMAT command was used so that it would appear as text. Two of the variable titles
also contained underscores, which were removed with, DEFINE and ASSIGN. The new
variables were then WRITE REPLACEA to a new data table for use in mapping.
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Appendix H- Glossary

Terms listed in the Glossary are located in the Epi Info™ online help system and as part of
the online Glossaries listed in Appendix I: Data Sources and the References page.

Analytic Epidemiology

The aspect of epidemiology concerned with the search for health-related causes and effects.
Uses comparison groups, which provide baseline data, to quantify the association between
exposures and outcomes, and test hypotheses about causal relationships.

Chi Square

A test of statistical significance that is used to determine how likely it is that an observed
association between an exposure and a disease could have occurred due to chance alone, if
the exposure was not actually related to the disease. The Chi-Square Test is the test of choice
when the expected values for each cell in a two-by-two table are at least 5.

Confidence Interval (CI)
A range of values for a variable that indicates the likely location of the true value of a measure.
Denominator

The lower portion of a fraction used to calculate a rate or ratio. In a rate, the denominator is
usually the population (or population experience, as in person-years, etc.) at risk.

Descriptive Epidemiology

The aspect of epidemiology concerned with organizing and summarizing health-related data
according to time, place, and person.

Distribution

In epidemiology, the frequency and pattern of health-related characteristics and events in a
population. In statistics, the observed or theoretical frequency of values of a variable.

Epidemiology

The study of the distribution and determinants of health-related states or events in specified
populations, and the application of this study to the control of health problems.

Expressions

Expressions are combinations of literal values, variables, functions, and operators that can be
evaluated to a single result. Within an expression, the values of variables can be modified by a
number of functions and operators. An Expression consists of one or more Operands
(variables or literal values) and one or more Operators (like +, -, *, and /). Exptessions, no
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matter how complex, can eventually be evaluated to produce a single value, like 1.323, or
“True” or “False.” Functions modify the value of one or more variables to produce a result.
For example, ROUND (2.33333) produces the value 2. Operators are used to combine two
items. For example, the “+” operator combines Varl and Var2 to produce a sum, as in
Var3=Varl+Var2. Almost all functions require arguments enclosed in parentheses and
separated by commas. Where arguments are required, there may not be any spaces between
the function name and the left parenthesis.

Fisher Exact Test

A test of statistical significance that is used to determine how likely it is that an observed
association between an exposure and a disease could have occurred due to chance alone, if
the exposure was not actually related to the disease. The Fisher Exact Test is the test of choice
when the expected values in a two-by-two table are less than 5.

Incidence Rate

A measure of the frequency with which an event, such as a new case of illness, occurs in a
population over a period of time. The denominator is the population at risk; the numerator is
the number of new cases occurring during a given time period.

Mean

The measure of central location commonly called the average. It is calculated by adding
together all the individual values in a group of measurements and dividing by the number of
values in the group.

Median

The measure of central location that divides a set of data into two equal parts.
Numerator

The upper portion of a fraction.

Odds Ratio

A measure of association, which quantifies the relationship between an exposure and health
outcome from a comparative study; also known as the cross-product ratio.

P-Value

The probability that an observed association between an exposure and a disease could have
occurred due to chance alone, if the exposure was not actually related to the disease.

Percentage

The number of patients with a characteristic divided by the total number of patients with the
characteristic.
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Prevalence

Measure of all cases of disease at a point of time. Computed by dividing the number of cases
by the total population.

Proportion

A type of ratio in which the numerator is included in the denominator. The ratio of a part to
the whole, expressed as a "decimal fraction" (e.g., 0.2), as a fraction (1/5), or, loosely, as a
percentage (20%).

Protective Factor

An aspect of personal behavior or lifestyle, an environmental exposure, or an inborn or
inherited characteristic that is associated with a decreased occurrence of disease or other
health-related event or condition.

Rate

An expression of the frequency with which an event occurs in a defined population.
Ratio

The value obtained by dividing one quantity by another.

Risk

The probability that an event will occur, e.g. that an individual will become ill or die within a
stated period of time or age.

Risk Ratio
A compatison of the risk of some health-related event such as disease or death in two groups.
Standard Deviation

The standard deviation is a mathematical measure of the spread or dispersion of the data
around the mean value for normally distributed data.

Standard Error (of the Mean)

The standard deviation of a theoretical distribution of sample means of a variable around the
true population mean of that variable.

Statistical significance

The measure of how likely it is that a set of study results could have occurred by chance alone.
The level of statistical significance is usually expressed by the P value.

Trend
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A long-term movement or change in frequency, usually upwards or downwards.
Variable

Any characteristic or attribute that can be measured.

Variance

A measure of the dispersion shown by a set of observations.
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Appendix I- Data Sources

Assessment in Public Health

Centers for Disease Control and Prevention (CDC), Division of Public Health Surveillance
and Informatics (DPHSI). Assessment in Public Health. CDC Web site. 2005.

http://www.cdc.gov/epo/dphsi/Al/resources.htm
BREFSS Survey Data

Centers for Disease Control and Prevention (CDC). Bebavioral Risk Factor Surveillance System
Survey Data. Atlanta, Georgia: U.S. Department of Health and Human Services, Centers for
Disease Control and Prevention, 2003.

http://www.cdc.gov/brfss /index.htm

CDC Asthma and Allergies

Centers for Disease Control and Prevention (CDC). CDC Health Topic: Asthma and
Allergies. CDC Web site. 2005.

http:/ /www.cdc.gov/health/asthma.htm
CDC WONDER

United States Department of Health and Human Services (US DHHS), Centers for Disease
Control and Prevention (CDC), National Center for Health Statistics (NCHS), "Bridged-Race
Population Estimates, United States, 1990 - 2002, By Age Groups". Compiled from the April
1, 2000 resident population developed by the Bureau of the Census in collaboration with the
NCHS on CDC WONDER On-line Database.

United States Department of Commerce, U.S. Census Bureau, Population Division; Census
Data for Public Health Research, CDC WONDER On-line Database, March 2003.

http://wonder.cde.gov

Community Health Assessment Clearinghouse

New York State, Department of Health (NYSDOH). Community Health Assessment
Clearinghonse. NYSDOH Web site. 2005.

http://www.health.state.ny.us/nysdoh/chac/index.htm
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Epi Info™

Centers for Disease Control and Prevention (CDC), Division of Public Health Surveillance
and Informatics (DPHSI). What Is Epi Info™¢ CDC Web site. 2005.

http:/ /www.cdc.gov/epiinfo

The National Center for Health Statistics

Centers for Disease Control and Prevention (CDC), National Center for Health Statistics
(NCHS). CDC Web site. 2005.

http://www.cdc.gov/nchs/

Statewide Planning and Research Cooperative System (SPARCS)

New York State Department of Health. "Asthma Hospitalization Rates by County, New
York State Residents 2000-2002." Claritas Corporation. 2005.

United States Census Bureau

U.S. Census Bureau; "Single Years of Age Under 30 Years and Sex 2000, for Albany
County, New York: 2000;" published 2000.

http://www.census.gov/census2000/states/ny.html
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